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PREFACE 
 
This manual explains how to use the XL15+ OCS. 
 
Copyright© 2017 Horner APG, LLC, 59 South State Avenue, Indianapolis, Indiana 46201. All rights 
reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language or computer language, in any form by any means, electronic, 
mechanical, magnetic, optical, chemical, manual or otherwise, without the prior agreement and written 
permission of Horner APG, Inc. 
 
All software described in this document or media is also copyrighted material subject to the terms and 
conditions of the Horner Software License Agreement. 
 
Information in this document is subject to change without notice and does not represent a commitment 
on the part of Horner APG. 
 
Ethernet™ is a trademark of Xerox Corporation. 
microSD™ and CompactFlash are registered trademarks of SanDisk Corporation. 
 
 
For user manual updates, contact Technical Support:  
 
North America:   
Tel:  (+) (317) 916-4274 
Fax: (+) (317) 639-4279 
Web:    http://www.hornerautomation.com 
Email:  techsppt@heapg.com 
 
 
Europe:  
Tel:  (+) 353-21-4321-266 
Fax: (+) 353-21-4321-826 
Web:   http://www.hornerautomation.eu 
Email: technical.support@horner-apg.com 
  

http://www.hornerautomation.com/
mailto:techsppt@heapg.com
http://www.hornerautomation.eu/
mailto:technical.support@horner-apg.com
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LIMITED WARRANTY AND LIMITATION OF LIABILITY 
 

Horner APG, LLC, ("HE-APG") warrants to the original purchaser that the XL15+ (HE-XP) OCS module 
manufactured by HE-APG is free from defects in material and workmanship under normal use and service. 
The obligation of HE-APG under this warranty shall be limited to the repair or exchange of any part or 
parts which may prove defective under normal use and service within two (2) years from the date of 
manufacture or eighteen (18) months from the date of installation by the original purchaser whichever 
occurs first, such defect to be disclosed to the satisfaction of HE-APG after examination by HE-APG of the 
allegedly defective part or parts. THIS WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES 
EXPRESSED OR IMPLIED INCLUDING THE WARRANTIES OF MERCHANTABILITY AND FITNESS FOR USE AND 
OF ALL OTHER OBLIGATIONS OR LIABILITIES AND HE-APG NEITHER ASSUMES, NOR AUTHORIZES ANY 
OTHER PERSON TO ASSUME FOR HE-APG, ANY OTHER LIABILITY IN CONNECTION WITH THE SALE OF THIS 
XL15+ OCS module. THIS WARRANTY SHALL NOT APPLY TO THIS XL15+ OCS module OR ANY PART THEREOF 
WHICH HAS BEEN SUBJECT TO ACCIDENT, NEGLIGENCE, ALTERATION, ABUSE, OR MISUSE. HE-APG MAKES 
NO WARRANTY WHATSOEVER IN RESPECT TO ACCESSORIES OR PARTS NOT SUPPLIED BY HE-APG. THE 
TERM "ORIGINAL PURCHASER", AS USED IN THIS WARRANTY, SHALL BE DEEMED TO MEAN THAT PERSON 
FOR WHOM THE XL15+ OCS module IS ORIGINALLY INSTALLED. THIS WARRANTY SHALL APPLY ONLY 
WITHIN THE BOUNDARIES OF THE CONTINENTAL UNITED STATES. 
 
In no event, whether as a result of breach of contract, warranty, tort (including negligence) or otherwise, 
shall HE-APG or its suppliers be liable of any special, consequential, incidental or penal damages including, 
but not limited to, loss of profit or revenues, loss of use of the products or any associated equipment, 
damage to associated equipment, cost of capital, cost of substitute products, facilities, services or 
replacement power, down time costs, or claims of original purchaser's customers for such damages. 
 
To obtain warranty service, return the product to your distributor with a description of the problem, 
proof of purchase, postpaid, insured, and in a suitable package. 
 
 

ABOUT PROGRAMMING EXAMPLES 
 

Any example programs and program segments in this manual or provided on accompanying diskettes are 
included solely for illustrative purposes. Due to the many variables and requirements associated with any 
particular installation, Horner APG cannot assume responsibility or liability for actual use based on the 
examples and diagrams. It is the sole responsibility of the system designer utilizing the XL15+ OCS module 
to appropriately design the end system, to appropriately integrate the XL15+ OCS module and to make 
safety provisions for the end equipment as is usual and customary in industrial applications as defined in 
any codes or standards which apply. 
 
NOTE: The programming examples shown in this manual are for illustrative purposes only. 

Proper machine operation is the sole responsibility of the system integrator. 
  



  MAN1106-08.3-EN_XL15+_UM 

O c t o b e r  2 1 ,  2 0 2 1      P a g e  4 | 194 

VISUAL MAP OF KEY CHAPTERS 
 

FIRST STEP of ANY TASK: DATASHEET 

Each XL15+ OCS unit is sent with a datasheet in the box. The datasheets are the first documents to 
refer to for model-specific information related to XL15+ OCS models for specific installation 
information. To obtain updates to datasheets, manuals, and user documentation, visit a Horner 
website. 
North America https://hornerautomation.com      Europe  http://www.hornerautomation.eu 
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CHAPTER ONE: SAFETY AND COMPLIANCE 
 
 

1.1 Safety Warnings and Guidelines 
When found on the product, the following symbols specify:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

  

Warning:  Consult user documentation. Warning:  Electrical Shock Hazard. 

WARNING – EXPLOSION HAZARD – Do not disconnect equipment unless power has been switched off 
or the area is known to be non-hazardous 
 
WARNING:  To avoid the risk of electric shock or burns, always connect the safety (or earth) ground 
before making any other connections.  
 
WARNING:  To reduce the risk of fire, electrical shock, or physical injury it is strongly recommended 
to fuse the voltage measurement inputs. Be sure to locate fuses as close to the source as possible. 
 
WARNING:  Replace fuse with the same type and rating to provide protection against risk of fire and 
shock hazards.   
 
WARNING:  In the event of repeated failure, do not replace the fuse again as a repeated failure 
indicates a defective condition that will not clear by replacing the fuse.  
 
WARNING:  EXPLOSION HAZARD—Substitution of components may impair suitability for Class I, 
Division 2. 
 
WARNING:  The USB parts are for operational maintenance only. Do not leave permanently 
connected unless area is known to be non-hazardous. 
 
WARNING:  EXPLOSION HAZARD—BATTERIES MUST ONLY BE CHANGED IN AN AREA KNOWN TO BE 
NON-HAZARDOUS 
 
WARNING: Battery May Explode If Mistreated. Do Not Recharge, Disassemble or Dispose Of In Fire. 
 
WARNING: Only qualified electrical personnel familiar with the construction and operation of this 
equipment and the hazards involved should install, adjust, operate, or service this equipment. Read 
and understand this manual and other applicable manuals in their entirety before proceeding. Failure 
to observe this precaution could result in severe bodily injury or loss of life. 
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a. All applicable codes and standards need to be followed in the installation of this product. 
b. For I/O wiring (discrete), use the following wire type or equivalent: Belden 9918, 18 AWG, or 

larger. 

Adhere to the following safety precautions whenever any type of connection is made to the module.  
a. Connect the green safety (earth) ground first before making any other connections.  
b. When connecting to electric circuits or pulse-initiating equipment, open their related breakers. 

Do not make connections to live power lines.    
c. Make connections to the module first; then connect to the circuit to be monitored.   
d. Route power wires in a safe manner in accordance with good practice and local codes. 
e. Wear proper personal protective equipment including safety glasses and insulated gloves when 

making connections to power circuits.  
f. Ensure hands, shoes, and floors are dry before making any connection to a power line.  
g. Make sure the unit is turned OFF before making connection to terminals. Make sure all circuits 

are de-energized before making connections.  
h. Before each use, inspect all cables for breaks or cracks in the insulation. Replace immediately if 

defective. 
 

1.2 Grounding  
 
Grounding is covered in various chapters within this manual.  
 

1.3 Compliance  
 
To check for compliance and updates, visit the Horner website.  
 
North America  https://hornerautomation.com   
Europe    http://www.hornerautomation.eu 

https://hornerautomation.com/
http://www.hornerautomation.eu/
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CHAPTER 2: INTRODUCTION 
 

2.1 Visual Overview of XL15+ OCS 

 
 

Figure 2.1 – Overview of the XL15+   
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2.1.1    Where to Find Information about the XL15+ OCS  
 

a) Datasheet - The datasheet is the first document to refer to for key information related to 
specific XL15+ OCS models.  

 
1. The datasheets for all XL15+ OCS models are available on the Horner websites. 
2. Datasheets contain pin-outs, jumper settings, and other model specific information.  

 

Table 2.1 – Datasheet Manual Numbers 

Model 0 MAN1107 

Model 2 MAN1125 

Model 3 MAN1126 

Model 4 MAN1127 

Model 5 MAN1128 

Model 6 MAN1129 

 
 
b) User Manual -This manual provides general information that is common to XL15+ OCS 

models and can be downloaded from our website.                                                                                          
Visit the Horner website to obtain user documentation and updates. 

North America  https://hornerautomation.com   
Europe    http://www.hornerautomation.eu 

 
 
 
2.1.2    Four Main Types of Information are covered in this manual 

a) Safety and Installation guidelines / instructions (Mechanical and Electrical) 
b) Descriptions of hardware features: Serial ports, Removable Media, Communication Options, 

etc. 
c) Configuration and Use of the XL15+ OCS 
d) Maintenance and Support 

 
2.1.3 Manual Index 
Major topics of interest may be found in the Index towards the end of this manual. 
 
  

https://hornerautomation.com/
http://www.hornerautomation.eu/
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2.2 Connectivity to the XL15+ OCS  
The XL15+ OCS has excellent capabilities for connecting to a variety of devices. The diagram below 
shows some examples of devices that can be used with the XL15+ OCS. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2.2 – Visual Overview of Types of Devices that can be connected to XL15+OCS 
 

  An OCS wired to a machine can cause damaging ground currents. Consider using a USB 
isolator due to voltage potential differences as a preventative measure.  
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2.3 Features of XL15+ OCS    
 
The XL15+ OCSs are all-in-one industrial control devices. They combine control, user interface, I/O and 
networking into a single, integrated package. Unique features of the XL15+ OCS include: 
 

- 15” XGA 1024x768, 500 cd/m² bright, 16,777,216 color graphical touch sensing LCD display in all 
models of XL15+ with laminated touch screen. 

- Soft function keys. 
- Display of complex graphical objects including trends, gauges, meters, and animations. 
- Ultra high-speed dual-core CPU with higher performance graphic processing. 
- Advanced control capabilities including floating point, multiple auto-tuning PID loops, and string 

handling capabilities. 
- Removable media for up to 128 GB of storage of programs, data logging, or screen captures. 
- Dual isolated CsCAN networking port for communication with remote I/O, other controllers, or 

PCs. 
- Three high speed USB  host ports for communication with PCs and a USB controller 

programming port. 
- Three independent serial ports each available in RS232 or RS485. 
- Configurable serial protocols for communication to drives, PLCs, or other serial peripherals. 
- Full featured, built-in I/O including high resolution analog, thermocouple, RTD, high-speed 

counters, PWM outputs and relays (depending upon the XL15+ OCS model used). 
- Advanced high speed I/O capabilities. 
- Cscape programming software that allows all aspects of the XL15+ OCS to be programmed and 

configured from one integrated application. 
- Optional communication add-on modules. 
- Two on board Ethernet ports (10/100/1000 Mbps) for Cscape programming and application 

defined communication, with Auto MDI/MDI-X, Modbus TCP C/S, HTTP, FTP, SMTP, and 
Ethernet IP. 

- Mic In and Audio Out. 
- Mini Display Port Video Out  
- Special coated polycarbonate for premium appearance. 
- Extra USB ports can be used for combination of camera / flash drives / any USB hub etc. if 

multiple flash drive / camera are connected, only one flash drive / camera will be considered. 
- External Fonts support (with or without Unicode). 
- Added “Loading Program TTF Font files” while downloading TTF files to the unit. 
- While performing “Export to Removable media / Save PGM” operation, two files a.re created – 

XYZ.PGM / DEFAULT.PGM and XYZ.Dat / DEFAULT.DAT files if external fonts are used. 
- Updating FPGA during boot up of the device. 
- Four counter HSC mode with all features are supported (number of quadrature’s supported are 

two). 
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2.4 Accessories  
 
Please visit the Horner Control Accessories website for communication, programming, and I/O 

accessories.   

 

North America      http://hornerautomation.com/product-category/home/control-accessories/ 

Europe                   https://www.hornerautomation.eu/product-overview/ 

 

2.5 Useful Documents and References 
 
Visit our website to obtain user documentation, supplemental documents, certificates, and other 
documentation.  
 
North America   https://hornerautomation.com  
Europe   http://www.hornerautomation.eu 
 
 

2.6 Opening Cscape Help File  
 
After opening the Cscape Help file, either use the Contest, Index or Search tabs to located information. 
The Cscape Help file has more information than the scope of this user manual.  
 
   
 
Select “Index” tab.  
 
 
 
 
 

 

http://hornerautomation.com/product-category/home/control-accessories/
https://www.hornerautomation.eu/product-overview/
https://hornerautomation.com/
http://www.hornerautomation.eu/
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CHAPTER 3: MECHANICAL INSTALLATION 
 
NOTE: The datasheet is the first document to refer to for model-specific information related to XL15+ 
OCS models for key installation information. Visit the Horner websites to obtain datasheets, user 
documentation, and updates. 
 
North America  https://hornerautomation.com   
Europe    http://www.hornerautomation.eu  
 

3.1 Overview 
 
The mechanical installation greatly affects the operation, safety and appearance of the system.  
Information is provided to mechanically install the unit such as cut-out sizes, mounting procedures, and 
other recommendations for the proper mechanical installation of the unit. 
 
 

3.2 Mounting Requirements  
 
3.2.1 Mounting Procedures (Installed in a Panel Door)  
 
 

 
Figure 3.1 – Panel Mounting of an XL15+ Series OCS 

 
  

https://hornerautomation.com/
http://www.hornerautomation.eu/
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Once the panel design has been completed using the criteria and suggestions in the following sections, 
use the following steps to panel mount the XL15+ OCS. 
 

1. The XL15+ allows unique installation options that simplify installation for systems that may not 
need robust vibration or water resistance. 

2. If the system does not experience shock or vibration and will not be exposed to weather or wash 
down conditions, the unit can be installed by cutting the rectangular opening and installing the 
four (4) supplied clips. 

3. For systems that may experience shock or vibration or are installed outdoors or in wash down 
environments, the rectangular cut and clips are used and perimeter holes must be drilled in the 
panel. The supplied studs are then inserted into the perimeter of the controller and supplied nuts 
will secure the perimeter of the unit to the panel. 

4. Please reference the XL15+ installation cutout drawing document (MAN1108) for further details. 
5. Remove all connectors from the XL15+ OCS unit. 
6. Make sure both inner and outer gaskets are installed on the XL15+ OCS and are free from dust and 

debris. Check that the corners of the gasket are secure. 
7. Pass the unit through the panel. 
8. The two (2) spring clips will latch the unit in the panel. 
9. Insert each of the four (4) mounting clips into the slots in the XL15+ OCS case. One clip should be 

installed on each corner. Lightly tighten each screw so the clip is held in place. 
10. Tighten the screws on the clips such that the gasket is compressed against the panel. 

Recommended torque is 7-10 in-lbs (0.79-1.13 Nm). 
11. If the perimeter studs are needed, it is recommended to use a thread locker (similar to 242 Blue 

Loctite). Use supplied lock washers and nut. Recommended torque is 3-4 in-lbs (0.34-0.45 Nm).  
Refer to Figure 3.2 (below) for the proper torque sequence.   
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Figure 3.2—Perimeter Set Studs 
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3.3 Mounting Orientation  
 
 
 
3.3.1 XL15+ OCS Mounting Clip Locations 
 

  
 
 
 
 
 
 
 

Figure 3.3 – XL15+ OCS without Mounting Clips 
 
 
 
 
3.3.2 XL15+ OCS Mounting Orientation  
 

 
Figure 3.4 – Orientation of XL15+ OCS 

 
NOTE: There are no orientation restrictions on the XL15+ OCS. However, the above orientation provides 
for optimum readability of the screen and ease of use of the soft keys. 
  

Slots for mounting clips 
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3.4 Panel Cut-Out 
 
For installations requiring NEMA 4X liquid and dust protection the panel cutout should be cut, and 
perimeter holes must be drilled in the panel with a tolerance of +/- 0.5mm. 
 
 

 
Figure 3.5 – Panel Cutout Tolerances 
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3.5 XL15+ Dimensions 

 

 
 
 

Figure 3.6– XL15+ OCS Dimensions 
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3.6 Installation Procedure 
 
NOTE: Reference the Quick Reference Guide (MAN1124) for Mounting Template.  
 

• The XL15+ is a panel mounted device and is meant to be an enclosure suitable for the 
equipment, such that the equipment is only accessible with the use of a tool.  The XL15+ 
is suitable for use in Class I, Division II, Groups F and G, and Class III Hazardous Locations 
or non-hazardous locations only.  

• The XL15+ allows unique installation options that simplify installation for systems that 
may not need robust vibration or water resistance. 

• If the system does not experience shock or vibration and will not be exposed to weather 
or wash down conditions the unit can be installed by cutting the rectangular opening 
and installing the four supplied clips. 

• For systems that may experience shock or vibration or are installed outdoors or in wash 
down environments, the rectangular cut and clips are used and perimeter holes must be 
drilled in the panel. The supplied studs are then inserted into the perimeter of the 
controller and supplied nuts will secure the perimeter of the unit to the panel. 

 
1. Remove all connectors from the XL15+ OCS unit. 
2. Carefully locate an appropriate place to mount the XL15+. Be sure to leave enough room 

at the top of the unit for insertion and removal of the microSD card. Also leave enough 
room at the bottom for the insertion and removal of USB FLASH drives and wiring 

3. Carefully cut the host panel per the diagram, with a tolerance of+/- 0.5mm.  Remove 
any burrs/sharp edges and ensure the panel is not warped  in the cutting process. - If 
the opening is too large, water may leak into the enclosure, potentially damaging the 
OCS. If the opening is too small, the OCS may not fit through the hole without damage. 

4. Make sure both inner and outer gaskets are installed on the XL15+ OCS and are free 
from dust and debris. Check that the corners of the gasket are secure. Insert the OCS 
through the panel cutout (from the front). The gasket needs to be between the host 
panel and the OCS. 

5. The two (2) spring clips will latch the unit in the panel. 
6. Insert each of the four (4) mounting clips into the slots in the XL15+ OCS case. One clip 

should be installed on each corner. Lightly tighten each screw so the clip is held in place. 
7. Tighten the screws on the clips such that the gasket is compressed against the panel. 

Recommended torque is 7-10 in-lbs (0.79-1.13 Nm). If the perimeter studs are needed, 
it is recommended to use a thread locker (similar to 242 Blue Loctite). Use supplied lock 
washers and nut. Recommended torque is 3-4 in-lbs (0.34-0.45 Nm).   

8. Reinstall the I/O Removable Terminal Blocks. Connect communications cables to the 
serial port, USB ports, Ethernet port, and CAN port as required.  
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3.7  Factors Affecting Panel Layout Design and Clearances 
 
 
 
 
The designer of a panel layout needs to assess the requirements of a particular system and to consider 
the following design factors. 
 
3.7.1 Clearance / Adequate Space  
Install devices to allow sufficient clearance to open and close the panel door. 
 

Table 3.1 – Minimum Clearance Requirements for Panel Box and Door 

Minimum Distance between  
base of device and sides of cabinet 

2 inches (50.80mm) 

Minimum Distance between  
base of device and wiring ducts 

1.5 inches (38.10mm) 

If more than one device installed in panel 
box (or on door): Minimum Distance between 
bases of each device 

4 inches between bases of each device (101.60mm) 

When door is closed: 
Minimum Distance between device and 
closed door (Be sure to allow enough depth 
for the OCS.) 

2 inches (50.80mm) 

 
3.7.2 Grounding  
 
 
 
 
Panel Box: The panel box must be properly connected to earth ground to provide a good common ground 
reference.  
 
Panel Door: Tie a low impedance ground strap between the panel box and the panel door to ensure that 
they have the same ground reference. 
 
3.7.3 Temperature / Ventilation 
Ensure that the panel layout design allows for adequate ventilation and maintains the specified ambient 
temperature range. Consider the impact on the design of the panel layout if operating at the extreme 
ends of the ambient temperature range. For example, if it is determined that a cooling device is 
required, allow adequate space and clearances for the device in the panel box or on the panel door. 
 

3.7.4 Orientation 
When panel-mounted, there are no orientation restrictions on the XL15+ OCS.  
  

WARNING: It is important to follow the requirements of the panel manufacturer  
and to follow all applicable electrical codes and standards. 

WARNING: Be sure to meet the ground requirements of the  
panel manufacturer and also meet applicable electrical codes and standards. 

applicable electrical codes and standards. 



  MAN1106-08.3-EN_XL15+_UM 

O c t o b e r  2 1 ,  2 0 2 1      P a g e  25 | 194 

3.7.5 Noise 
Consider the impact on the panel layout design and clearance requirements if noise suppression devices 
are needed. Be sure to maintain an adequate distance between the XL15+ OCS and noisy devices such as 
relays, motor starters, etc. 
 
For details on output protection, especially when using contactors and solenoids, see MAN0962. 
  
3.7.6 Shock and Vibration  
The XL15+ OCS has been designed to operate in typical industrial environments that may inflict some 
shock and vibration on the unit. For applications that may inflict excessive shock and vibration please use 
proper dampening techniques or relocate the XL15+ OCS to a location that minimizes shock and/or 
vibration. 
 
3.7.7 Panel Layout Design and Clearance Checklist 
The following list provides highlights of panel layout design factors:  
 

 Meets the electrical code and applicable standards for proper grounding, etc.? 

 Meets the panel manufacturer’s requirements for grounding, etc.? 

 

Is the panel box properly connected to earth ground? Is the panel door properly grounded?  
Has the appropriate procedure been followed to properly ground the devices in the panel 
box and on the panel door? 

 

Are minimum clearance requirements met? Can the panel door be easily opened and 
closed? Is there adequate space between device bases as well as the sides of the panel and 
wiring ducts? 

 Is the panel box deep enough to accommodate the XL15+ OCS? 

 
Is there adequate ventilation? Is the ambient temperature range maintained?  Are cooling or 
heating devices required?   

 

Are noise suppression devices or isolation transformers required? Is there adequate distance 
between the base of the XL15+ OCS and noisy devices such as relays or motor starters? 
Ensure that power and signal wires are not routed in the same conduit. 

 
Are there other requirements that impact the particular system, which need to be 
considered? 
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CHAPTER 4: ELECTRICAL INSTALLATION 
 
NOTE: The datasheet is the first document to refer to for model-specific information related to XL15+ 
OCS models FOR key installation information. Visit the Horner websites to obtain datasheets, user 
documentation, and updates.  
 
North America  https://hornerautomation.com   
Europe   http://www.hornerautomation.eu 
 
 

4.1 Grounding Definition 
 
Ground: The term ground is defined as a conductive connection between a circuit or piece of equipment 
and the earth. Grounds are fundamentally used to protect an application from harmful interference causing 
either physical damage such as by lightning or voltage transients or from circuit disruption often caused by 
radio frequency interference (RFI). Grounding is also for the safety of the user. 
 
 

4.2 Ground Specifications 
 
Ideally, a ground resistance measurement from equipment to earth ground is 0Ω. In reality, it typically is 
higher. The U.S. National Electrical Code (NEC) states the resistance to ground shall not exceed 25Ω. Horner 
APG recommends less than 15Ω resistance from our equipment to ground. Resistance greater than 25Ω can 
cause undesirable or harmful interference to the device. 
  

https://hornerautomation.com/
http://www.hornerautomation.eu/
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4.3 How to Test for Good Ground 
 
In order to test ground resistance, a Ground Resistance Tester must be used. A typical Ground Resistance 
Meter Kit contains a meter, two or three wire leads, and two ground rods. Instructions are supplied for 
either a two-point or three-point ground test.  
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 

 
 

 
 

 
 

 

 
 
 

Figure 4.1 – Two-point Ground Connection Test  
  

METAL WATER PIPE OR
OTHER GOOD GROUND

GROUND ROD

GROUND
DISCONNECTED
FROM SERVICE

GROUND RESISTANCE METER
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4.4 Primary Power Port  
 
NOTE: The Primary Power Range is 18VDC to 30VDC.  
 
 

 
 
 
DC Input / Frame 

• Solid/Stranded Wire: 12-24 awg (2.5-0.2mm). 

• Strip length: 0.28” (7mm). 

• Torque, Terminal Hold-Down Screws: 4.5 – 7 in-lbs (0.50 – 0.78 N-m). 

• DC- is internally connected to I/O V-, but is isolated from CAN V-. A Class 2 power supply must 

be used. 

 
 
POWER UP 

1. OPTION: Attach ferrite core with a minimum of two turns of the DC+ and DC- signals from the 

DC supply that is powering the controllers. 

2. Connect to earth ground. 

3. Apply recommended power. 
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CHAPTER 5: SYSTEM SETTINGS AND ADJUSTMENTS 
 

5.1 System Menu - Overview 
The XL15+ has a built-in System Menu, which lets the user view System Settings and makes adjustments. 
To start the System Menu, press the far upper right corner of the touchscreen to bring out the function 

keys, then press the SYSTEM key (or set %SR3 to 1), which will display the Main Menu. Then use the  

and  (Up Arrow or Down Arrow) keys to select a Main Menu item and press Enter (Return Arrow) to 
display the item’s Sub-Menu.  
 
 
 
 
SYSTEM KEY.  
 
 
       
 
 
 
 
 
 
 
 
 
  

Press the upper right corner to bring 
out the function keys and the 
SYSTEM key in order to access the 
System Menu.  
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Figure 5.1 – System Menu  
 
 

Table 5.1 - OCS LEDs 
 

RUN 
• OFF indicates OCS is in IDLE/STOP mode. 

• Flashing indicates DO / IO mode or RUN with no ladder program.  

• ON indicates ladder code running.  
 

OK • OFF indicates one or more self-tests failed. 

• ON indicates all self-tests passed.  

 
 

  

See table below for 
RUN and OK LED 
information.  
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5.2 System Menu – Navigation and Editing 
As mentioned above, the System Menu is started by pressing the System key on the XL15+. Next press 

ESC to exit the System Menu or use   and   to select an item and press Enter to display the item’s Sub-
Menu. 
 
A Sub-Menu generally shows a list of System Settings and their values.  After opening a Sub-Menu, if any 
of its System Settings are editable, the first System Setting that can be edited is highlighted. If desired, the 

 and  keys can be used to select a different System Setting to be edited. 
 
At this point, either press ESC to exit the Sub-Menu (returning to the Main Menu), or press Enter to edit 
the highlighted System Setting. If Enter is pressed, the System Setting’s value will be highlighted, indicating 
that it is ready to be modified. 
 

When modifying a System Setting’s value, use either the arrow keys ( →  ) or the numeric keys, or 
the appropriate touch screen icons to select a new value. 
 
The arrow keys are used to edit System Settings that have just a few possible values. Each time the arrow 
key is pressed, a new possible value is displayed. When the desired value appears, press the Enter key to 
save it; otherwise press the ESC key to cancel the edit. 
 
 
The numeric keys are normally used to enter numeric System Settings.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

In addition, to edit a single numeric digit, use the  or → key to select the digit, and then either press a 

numeric key or use  or  to modify the digit. In any case, after entering the new desired value, press the 
Enter key to save it; otherwise press the ESC key to cancel the edit.  
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XL15+ System Menu Map 
Figure 5.2 

 
 
 

            
Error! Bookmark not defined. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
         

Sub-Menus 

Set Networks 

View Status 

View Diags 

View Battery 

Status 

View I/O Slots 

View Protocols 

Set Fkeys Mode 

Set Serial Ports 

Set Time/Date 

Set Beeper 

Set Screen 

Removable Media 

Fail-Safe System 

Clone Unit 

License Details 

(Press ESC to 

Exit) 

 

CAN Ok? Yes 

CAN ID: 253 

CAN Baud: 125KB 

  

MAC ID:  

 00:E0:C4:06:18:4D 

IP: 172.27.1.79 

NetM: 255.255.255.0 

GatW1 0.0.0.0 

  

MAC ID2:  

 00:E0:C4:06:18:4E 

IP2: 172.27.1.81 

NetM2: 255.255.255.0 

GatW2 0.0.0.0 

 

Model: HE-XP7E0 

Mode: Run 

Scan Rate(mS): 1.4 

Lcl Net Use(%): 0.0 

All Net Use(%:) 0.0 

Ladder Size: 23208 

Config Size: 916 

Graphics Size: 65798 

String Size: 42136 

Bitmap Size: 5003192 

Text Tbl Size: 216 

Font Tbl Size: 8 

Protocol Size: 54228 

SMS File Size: 172 

Firmware Rev: 14.99 

FPGA Rev: 0.0 

InitRD Rev: 1.06 

OS Ver: 310.17.31 

Self-Test: Ok 

 

Logic Error: Ok 

User Program: Ok 

User Graphics: Ok 

W-Dog Trips: 4 

Net Errors: 0 

Network State: Ok 

Network ID: Ok 

Dup Net ID: Ok 

Clock Error: Ok 

I/O System Ok 

Battery: Ok 

 

Slot 1: I/O: Empty 

Slot 2: I/O: Empty 

Slot 3: I/O: ETN300 

MJ1: 

(None Loaded) 

MJ2: 

(None Loaded) 

COM: 

(None Loaded) 

MJ3: 

(None Loaded) 

Fkeys: Momentary 

SYS-Fn enable: Yes 

  

( Use ↑↓ to adjust ) 

 

Dflt Pgm Port MJ1-232 

MJ1 RS485 Bias No 

MJ2 RS485 Bias No 

MJ3 RS485 Bias No 

MJ1 RS485 Term No 

MJ2 RS485 Term No  

MJ3 RS485 Term No 

( Use ↑↓ to adjust ) 

 

Time: 14:58:03 

Date: 08-Sep-2015 

Day: Tuesday 

UTC/Daylight Savings Time 

( Use ↑↓ to adjust ) 

(    each field    ) 

 

 
Beeper 

enable: 

Yes 

  

( Use ↑↓ to adjust ) 

 

Server enable: No 

Timeout(min): 15 

Popup Status: Off 

Update Time(mS): 5 

  

  

Update time sets  

the maximum time  

used by graphics  

in the logic scan.  

  

 

Media Directory 

Media Card Not Present 

 

Backup/Restore Data 

Enable AutoRun 

Enable AutoLoad 

(ESC to exit) 

Clone Unit 

Media Card Not Present 

 

Sub-Menus 

CPU Temperature (C) 

Battery Voltage (mV) 

CPU Frequency (MHz) 

MAX Temperature (C)  

 

License Details 

Server/ Users/ Pages/Data 

Points/ Exp. Date/User 

Logged In  
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5.3 Set Network ID  
This sub menu allows setting for the CAN and Ethernet network to be viewed or changed. 
 

 
 
 

CAN Ok? 
Yes= CAN1 connected to a CAN network and functioning properly 
No= Not ready to communicate on CAN network 

CAN ID: 1 to 253 = This node’s CsCAN Network ID; must be unique on network 

CAN Baud: 
125 KB = 125kBd CAN network 
250 KB = 250kBd CAN network 

500 KB = 500kBd CAN network 
1 MB  = 1 MBd CAN network 

MAC ID: Displays the Ethernet MAC ID of the unit 

IP: Displays the Ethernet IP address of the unit  

NetM: Displays the Ethernet net mask of the unit 

GatWy: Displays the Ethernet gateway of the unit 

 
NOTE: The IP address, Net Mask, and Gateway can be changed from the System Menu. This is designed 
for commissioning or temporary field changes. The actual parameters are defined in Cscape under the 
Ethernet configuration and are reverted to whenever the unit goes from idle to run mode. 
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5.4 View Status 
 

 
 
The View Status Sub-Menu displays up to 19 System Settings. Only the OCS Mode System Setting is editable. 
 

Model: 
XP7xx= Model number of this XL15+ OCS unit 
1yz = indicates the installed I/O module 
00 = no I/O module 

OCS Mode: 
Idle = XL15+ OCS is in Idle mode 
DoIO = XL15+ OCS is in Do I/O mode 
Run = XL15+ OCS is in Run mode 

Scan Rate(mS): 
0.0 = XL15+ OCS is not in Run mode 
0.1 to 999.9= Average number of mS for each ladder scan 

OCS Net Use %: 0.0 to 100.0 = CAN network bandwidth % used by this XL15+ OCS node 

All Net Use %: 0.0 to 100.0 = CAN network bandwidth % used by all nodes 

Ladder Size: x = Number of bytes in application ladder program 

Config Size: x = Number of bytes in application I/O configuration 

Graphics Size: x = Number of bytes in application graphic screens 

String Size: x = Number of bytes in application string table 

Bitmap Size: x = Number of bytes in application bitmaps  

Text Tbl Size: x = Number of bytes in application text tables 

Font Tbl Size: x = Number of bytes in application font tables 

Protocol Size: x = Number of bytes in application downloaded protocols 

SMS File Size: x = Number of bytes in application SMS protocol configuration 

Firmware Rev: xx.yy = Current firmware version 

OS Ver a.b.cd.yz = Current Operating System version 

FPGA Rev: x.y = Current FPGA version (High Speed IO Sub System) 

InitRD Rev: x.yz = Bootloader version 

Self-Test: 
Ok = All power-on self-tests passed 
Fault = One or more power-on self-tests failed 
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5.5 View Diags  

 
 
The View Diags Sub-Menu displays up to 11 System Diagnostics, none of which are editable. 
The first two System Diagnostics are critical. If either of these indicate a Fault condition, the XL15+ OCS 
will not enter or remain in Run mode, and the problem must be investigated and corrected. 
 

Logic Error:  
Ok = All executed ladder instructions are legal for loaded firmware 
Fault = A ladder instruction not supported by firmware was found 

User Program:  
Ok = Ladder program and I/O configuration loaded successfully 
Fault = Ladder program or I/O configuration not loaded or load failed 

 
The last nine System Diagnostics are informational. If any of these indicate a warning condition, the XL15+ 
OCS can still enter and remain in Run mode, but the problem should be investigated and corrected. 
 

User Graphics 
Ok = Application graphics objects loaded successfully. 
Fault = Application graphics objects not loaded or load failed. 

W-Dog Trips 
0 = Watchdog timer has not tripped since the last power-up. 
x = Number of times watchdog timer has tripped. 

Net Errors 
0 = No CAN network bus-off errors have occurred. 
x = Number of CAN network bus-off errors that have occurred. 

Network State 
Ok = At least one other node was found on the CAN network. 
Warning = No other nodes were found on the CAN network. 

Network ID 
Ok = This node’s CAN Network ID is in the range 1 to 253. 
Warning = This node’s CAN Network ID was out of range at power-up. 

Dup Net ID 
Ok = This node’s Network ID is unique on the CAN network. 
Warning = This node’s Network ID is duplicated in another node. 

Clock Error 
Ok = Time and date have been set. 
Warning = Time and date need to be set. 

I/O System 
Ok = I/O configuration matches the installed I/O and COM modules. 
Warning = I/O configuration needs updating to match installed modules. 

Battery 
Ok = Backup battery operating properly. 
Warning = Backup battery needs to be replaced. 
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5.6 View Battery Status 
 

 
 
The following %SR can be used to display various data on Cscape regarding battery status: 
 

• SR194 – CPU frequency 

• SR195 – CPU die temperature 

• SR196 – Max CPU die temperature 

• SR198 – Battery voltage 
 

Waiting The charging system is waiting for voltages and temperatures to stabilize. 

Battery Charging The battery is charging. 

Battery Full Shows at the end of a charge cycle. Remains in this state until the battery is 
steadily discharging. 

Battery Discharging The battery is steadily discharging. 
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5.7 View I/O Slots 

 
 
The View I/O Slots Sub-Menu displays three System Settings, none of which may be edited. 
 

Internal to the XL15+ OCS, there is a CPU board, and up to two installed modules. Model HE-EXV1E0 has 
no installed I/O or COM modules. All other models have an I/O module and can have a user-installed COM 
module.   
 
Depending on which I/O module is installed and which I/O module has been configured by Cscape, one of 
the following six System Settings should appear for Slot 1: 
 

Slot 1: I/O: Empty = No I/O module installed or configured 

Slot 1:*Unsupported = Unsupported I/O module installed 

Slot 1:-I/O Missing = No I/O module installed but an I/O module is configured 

Slot 1:+I/O: XExyy  = yy I/O module installed but no I/O module configured 

Slot 1:?I/O: XExyy  = yy I/O module installed but another I/O module configured 

Slot 1: I/O: XExyy 
  

= yy I/O module installed and configured properly 

Depending on the COM module that is installed and the COM module that has been configured by Cscape, 
one of the following six System Settings appears for Slot 2: 
 

Slot 2: I/O: Empty  = No COM module installed or configured 

Slot 2:*Unsupported = Unsupported COM module installed 

Slot 2:-I/O Missing  = No COM module installed but a COM module is configured 

Slot 2:+I/O: XzC  = z COM module installed but no COM module configured 

Slot 2:?I/O: XzC  = z COM module installed but another COM module configured 

Slot 2: I/O: XzC  = z COM module installed and configured properly 

 

Slot 3: I/O: ETN300  = ETN300 has been configured through Cscape 
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5.8 View Protocols  
 

 
 
The View Protocols Sub-Menu displays two System Settings, neither of which may be edited. 
 
The MJ1, MJ2, and MJ3 serial ports support downloadable protocols. To assign a downloadable protocol 
to an XL15+ OCS serial port, select the Protocol Config item in Cscape’s Program menu and then set up a 
protocol. 
 
In the View Protocols Sub-Menu, the currently downloaded protocol, if any, and its version number are 
displayed for each of MJ1, MJ2 COM board and MJ3. 
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5.9 Set Fkeys Mode  
 

 
 
The Set Fkeys Sub-Menu displays two System Settings, both of which may be edited. 
 

Fkeys 
Momentary= %K1-7 bits go On & Off as F1-F7 are pressed & released 
Toggle= %K1-7 bits toggle each time F1-F7 are pressed   

SYS_Fn enable 
Yes = Reset and all clear system functions enabled 
No = Reset and all clear system functions disabled 
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5.10 Set Serial Ports  
 

 
 
The Set Serial Ports Sub-Menu displays three System Settings, all of which may be edited, and one optional 
item. For the Dflt Pgm Port System setting, MJ1-232, MJ2, and MJ3 can be selected, unless a Modem 
(XMC) COM module is installed.   
 

Dflt Pgm Port 
MJ1-232= MJ1 RS232 port is the default programming port 
MJ2 & MJ3= If modem is onboard, then GPRS-C, GPRS-S are options 
Modem= Modem COM module is the default programming port 

MJ1 RS485 Bias 
No = MJ1 RS485 bias resistors are not switched in 
Yes = MJ1 RS485 bias resistors are switched in 

MJ2 RS485 Bias 
No = MJ2 RS485 bias resistors are not switched in 
Yes = MJ2 RS485 bias resistors are switched in 

MJ3 RS485 Bias 
No = MJ3 R5485 bias resistors are not switched in  
Yes = MJ3 R5485 bias resistors are switched in 
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5.11 Set Time/Date  
 
The following instructions are to set and display the real-time clock in the controller. More details can be 
found in the Help File in Cscape. 
 

Table 5.2 - Clock and Time Setting Terms 

Coordinated Universal Time (UTC) Abbreviated to UTC, Coordinated Universal Time is the 
primary time standard by which the world regulates clocks 
and time.  

Time Offset In order to obtain the local time (anywhere in the world), 
user needs to subtract / add a certain number of hours from 
UTC depending on how many time zones user is away from 
Greenwich. 

Network Time Protocol (NTP)  A Networking Time Protocol (NTP) for clock synchronization 
between computer systems over packet-switched, variable 
latency data networks.  

Daylight Saving Time Time as adjusted to achieve longer evening daylight, 
especially in summer, by setting the clocks an hour ahead of 
the standard time. 

Apply Daylight Saving (DST) Daylight Saving Time (DST) is the practice of setting the clocks 
forward one hour from standard time during the summer 
months, and back again in the fall, in order to make better 
use of natural daylight. Selecting this option increases the 
Time offset by 1 hour. 

 
NOTE: Not all controllers contain real-time clocks.  
 
NOTE: Controller Time Zone (UTC time): From Cscape 9.70 SP2 and FW 14.22 onwards, UTC time is 
supported. 
 
 

Table 5.3 – System Registers for UTC (Coordinated Universal Time) 

%SR210 (R/W)   Time Zone: set in hours + / - UTC.  

%SR211 (R/W)   Daylight Saving: YES = 1 
Daylight Saving: NO = 0 
(If daylight saving is enabled, one hour will be added to 
the local time). 

%SR212 (R) UTC – Seconds 

%SR213 (R) UTC – Minutes 

%SR214 (R) UTC – Hours 

%SR215 (R) UTC – Date 

%SR216 (R) UTC – Month 

%SR217 (R) UTC – Year 
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To Set Time Zone: The Time Zone setting is an hourly offset from UTC time. If using the Time Zone 
setting, set it first, then set the local time. UTC time will be automatically set based on the time zone and 
local time settings.  
 
If using NTP: NTP utilizes UTC time, therefore when using NTP, the appropriate hourly offset from UTC 
time must entered into the time zone setting.  
 
Daylight Saving Time: If currently observing Daylight Saving Time, set to Yes. If not currently observing 
Daylight Saving Time, set to No. The OCS controller does not automatically switch to daylight saving 
time; however, program logic can be written to accomplish an automatic switchover using system 
register %SR211. In program logic, move a “1” (INT) into %SR211 to enable Daylight Saving Time. Move a 
“0” (INT) into %SR211 to disable Daylight Saving Time. Trigger the move to %SR211 based on a compare 
function to the RTC date according to daylight saving practices in your desired region.  
 

To Set Local Time: The Set Time/Date sub-menu displays three system settings. Time and Date may be 

edited, and Day is automatically calculated from the Date setting.  

 

NOTE: Time and Date are split into three fields each, all of which may be edited. Touch the field or use  

or   buttons to select a field, then use the  or  buttons to edit the field.  

 

Time: 16:09:49 = Current time (hours:minutes:seconds in 24-hour format) 

Date: 10-Jun-2013 = Current date (day-month-year) 

Day: Monday = Current day of week calculated from the Date setting 
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5.12 Set Beeper   
 

 
 
The Set Beeper Sub-Menu displays one System Setting, which may be edited. 
 

Beeper enable: 
Yes (default) = Enables beeper 
No = Disables beeper (does NOT affect ladder access)  
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5.13 Set Screen 
 
The Set Screen Sub-Menu displays four System Settings, all of which may be edited. 
 
 

 
 
 

Video Streaming 

To enable Video Input: 
1. Ensure Video Streaming is set to Remote.  
2. Power cycle 
3. Check the User Display screens 

Saver enable:              
Yes = Enable screen saver    
No (default) = Disable screen saver  

Timeout (min): 
5 - 1200 = Amount of time in minutes to expire with NO touch activity 
before activating screen saver (black screen) 

Popup Status: 

Off (default) = Disable popup status  
Warning = Display popup status only if controller status changes to NOT 
Ok or NOT Run mode 
On = Display popup status on any controller status change 

Update Time (mS):   2 - 50 = Maximum amount of time to allow for graphics update per scan 
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5.14 Removable Media   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Removable Media Sub-Menu displays the Removable Media Manager. Having selected Removable 
Media from the Main Menu, one of four Sub-Menu screens will appear: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
If a directory name is highlighted, pressing Enter will switch to that directory showing its files and sub-
directories. In a sub-directory, highlighting “..” (dot dot) and pressing Enter will move up one directory. 
  

   Media Directory  

No Card 

   Media Directory  

Dir Empty 

   Media Directory  

Initializing 

 
= No microSD card has been installed in the Memory slot 

 
= microSD card is installed, but it is still initializing. 

 
= microSD card is installed and initialized, but contains no files. 

Shows size of highlighted file or shows <DIR> if directory is highlighted. 
Shows the date file or directory was created or last modified. 
Shows the time file or directory was created or last modified. 

= microSD card is installed and initialized, and it contains files. 
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5.15 Fail – Safe System 
 
The Fail-Safe System is a set of features that allow an application to continue running in the event of 
certain types of "soft" failures. These "soft" failures include: 

• Battery power loss 

• Battery-Backed Register RAM or Application Flash corruption due to, for example, an excessive 
EMI event. 

 
Selecting “Fail-Safe System” menu will open the following menu screen: 
 

 
 
 
Selecting Backup/Restore Data displays the following screen in: 
 

 
 

Backup  = Copies Battery Backed RAM contents on to the onboard FLASH memory of the 
OCS. 

Restore  = Copies the backed up data from onboard FLASH to the battery backed RAM. 

Clear Backup = The backup data will be erased from the onboard FLASH. 

Exit = Goes back to previous menu. 
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5.16 Enable AutoRun 
 
“Enable AutoRun” displays the following options which can be selected: 
 

 
 

Enable AutoRun 
No = OCS will be in IDLE mode after AutoLoad or Automatic Restore.     
Yes = OCS will automatically be placed into RUN mode after AutoLoad or 
Automatic Restore. 
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5.17 Enable AutoLoad 
 
 “Enable AutoLoad” displays the following options which can be selected: 
 
 

 
 
 

Enable AutoLoad 

No =    Does not load AUTOLOAD.PGM automatically when application 
program is absent or corrupted. 

Yes =  Loads AUTOLOAD.PGM file automatically from RM when application 
program is absent or corrupted. 
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5.18 Clone Unit 
 
‘Clone Unit’ feature allows the user to “clone” the OCS of the exact same model. This feature “clones” 
application program and unit settings stored in battery backed RAM of an OCS into the RM. Refer to the 
Removable Media chapter for details on using RM. It can then be used to clone a different OCS (same 
model).  
 
This feature can be used when: 
 

- Replacing an OCS by another unit of the same model. 
- Duplicating or “clone” units without a PC. 

 
Clone 
Selecting “Clone Unit” menu will open the following menu screen: 
 

 
 
NOTE: Free/Total – displays number of free and total bytes in Removable Media. 

 
Selecting Make Clone brings up the confirmation screen. Upon confirmation, the OCS will create two 
new files in the root directory of the Removable Media Drive as shown below: 
 
       
 
 

 
 
 
 
 
 
 
 
 

AUTOLOAD.PGM Application file 

CLONE.DAT File having all unit settings and register values from Battery Backed RAM 
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5.19 Load Clone 
 
Selecting “Clone Unit” menu will open the following menu screen. Select “Load Clone”. 

 

 
 

NOTE: For security enabled files, Load Clone asks for password validation before loading the application. 
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5.20 WebMI License Details 
 

 
 
License details page displays the information about the WebMI license. The information can also 
be viewed from Cscape using the following %SR registers: 

 
%SR209.3 WebMI server status 

%SR209.4 WebMI user logged in status 

%SR209.9 to SR209.16 Number of Users 

%SR218 Number of Webpages 

%SR219 Number of Data Points 

%SR220-SR222 Expiry Date of WebMI License 
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5.21 Touch Screen Calibration 
 
The touch screen is calibrated at the factory and rarely needs modification. However, if actual touch 
locations do not appear to correspond with responding objects on the display, field adjustment is 
available. To access the field adjustable touch screen calibration dialog, press and hold System key for 
longer than two (2) seconds and the “System Recovery Screen” will appear. Press “Touch Calibration” 
and then follow the prompts on the screen. Thereafter, use a plastic tip stylus and follow the dialog 
instructions.  
 

 
 
NOTE: System key combinations can be locked out from user access. If the SYS-F1 key combination does 
NOT respond, the SYS-Fn enable option is likely disabled. It can be enabled from the Set Fkeys Mode 
screen accessible from the System Menu.   
 
For best results in screen calibration, use a stylus with a plastic tip. When the crosshair appears, touch 
the center of the crosshair as exactly as possible and release.  
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CHAPTER 6: REGISTERS 
 

6.1 Register Definitions 
 
When programming the XL15+ OCS, data is stored in memory that is segmented into different types. 
This memory in the controller is referred to as registers. Different groups of registers are defined as 
either bits or words (16 bits). Multiple registers can usually be used to handle larger storage 
requirements. For example, 16 single bit registers can be used to store a word, or two 16-bit registers 
can be used to store a 32-bit value.   
 

Table 6.1 - Types of Registers found in the XL15+ OCS 

%AI Analog Input 
16-bit input registers used to gather analog input data such as voltages, 
temperatures, and speed settings coming from an attached device. 

%AQ Analog Output 
16-bit output registers used to send analog information such a voltages, levels 
or speed settings to an attached device. 

%D Display Bit 
These are digital flags used to control the displaying of screens on a unit which 
has the ability to display a screen. If the bit is SET, the screen is displayed. 

%I Digital Input 
Single-bit input registers. Typically, an external switch is connected to the 
registers. 

%K Key Bit 
Single-bit flags used to give the programmer direct access to any front panel 
keys appearing on a unit. 

%M Retentive Bit Retentive single-bit registers. 

%Q Digital Output 
Single-bit output registers. Typically, these bits are connected to an actuator, 
indicator light or other physical outputs. 

%R General Purpose 
Register 

Retentive 16-bit registers. 

%S System Bit Single-bit bit coils predefined for system use. 

%SR System Register 16-bit registers predefined for system use. 

%T Temporary Bit Non-retentive single-bit registers. 

 

6.2 Useful %S and %SR registers  
Table 6.2 – Common %S Register Definitions 

Register Name Description 
%S1 FST_SCN Indicate First Scan 

%S2 NET_OK Network is OK 

%S3 T_10MS 10mS timebase 

%S4 T_100MS 100mS timebase 

%S5 T_1SEC 1 second timebase 

%S6 IO_OK I/O is OK 

%S7 ALW_ON Always ON 

%S8 ALW_OFF Always OFF 

%S9 PAUSING_SCN Pause 'n Load soon 

%S10 RESUMED_SCN Pause 'n load done 

%S11 FORCE I/O being forced 

%S12 FORCE_EN Forcing is enabled 

%S13 NET_IO_OK Network I/O is OK 

%S16  Ethernet COM module is OK 
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For additional information on system bits and registers, refer to the on-line help found in Cscape. 
 

Table 6.3 – %SR Registers – Master %SR Table  

Register Default I/O Name Description 
Min-Max 

Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR1 USER_SCR 
User Screen Number  
*Excludes RCC Units   

0 to 1023 Read/Write Read/Write 

%SR2 ALRM_SCR 
Alarm Screen Number (0=none) 
*Excludes RCC Units   

0 to 1023 Read Only Read Only 

%SR3 SYS_SCR 

System Screen Number  
1 = Main System Menu 
2= Set Network ID, Network Status, (%SR29) 
3= Set Network Baud (%SR30) 
4= Set Contrast (%SR32) 
5= View OCS Status 
6= View OCS Diagnostics 
7= View I/O Slots 
8= Set Function Key Mode (%SR33) 
9= Set Serial Ports (%SR34) 
10= Set Time/Date (%SR44-%SR50) 
11= Set Beeper (%SR183) 
12= Set Screen (%SR185) 
13= Removable Media 
14= View Protocols 
15= IP Address (ETN I/O Board) 
16= Fail Safe System 
17= Backup / Restore Data 
18= Enable AutoRun 
19= Enable AutoLoad 
20= Clone Unit -  
21= Touch Calibration 
24= License Details 
*Excludes RCC Units  

0 to 24 
 

Read/Write Read/Write 

%SR4 SELF_TST Self-Test Results   Read Only Read Only 

%SR4.1  Self-Test Results – BIOS Error  Read Only Read Only 

%SR4.2  Self-Test Results – Engine Error  Read Only Read Only 

%SR4.3  Self-Test Results – Ladder Error  Read Only Read Only 

%SR4.4  Self-Test Results – RAM Error  Read Only Read Only 

%SR4.5  Self-Test Results – Duplicate ID Error  Read Only Read Only 

%SR4.6  Self-Test Results – Bad ID Error  Read Only Read Only 

%SR4.7  Self-Test Results – I/O Configuration Error  Read Only Read Only 

%SR4.8  Self-Test Results – Bad Network Error   Read Only Read Only 

%SR4.9  Self-Test Results – Bad Logic Error  Read Only Read Only 

%SR4.10  Self-Test Results – Bad Clock Error  Read Only Read Only 

%SR4.11  Self-Test Results – DeviceNet Error  Read Only Read Only 

%SR4.12-.16 Reserved     

%SR5 CS_MODE 

Control Station Mode  
0= Idle 
1= Do I/O 
2= Run 
3= Online Change 
*Supported in Linux and XL15+ units only  

0 to 3 Read Only Read/Write 

%SR6  Average Scan Rate ms ( / 10)  Read Only Read Only 

%SR7  Minimum Scan Rate ms ( / 10)  Read Only Read Only 

%SR8  Maximum Scan Rate ms ( / 10)  Read Only Read Only 
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Table 6.3 – %SR Registers – Master %SR Table  

Register Default I/O Name Description 
Min-Max 

Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR9 TCH_PRESSURE Current Touch Pressure  0 to 3000 Read Only Read Only 

%SR10 
TCH_PRESSURE_TS
H 

Threshold Touch Pressure 0 to 3000 

 

Read/Write 
 

Read/Write 

%SR11-12  Ladder Size (32-Bit DINT)  Read Only Read Only 

%SR13-14   
User Text Screen Size (32-Bit DINT) 
*Excludes RCC Units   

 Read Only Read Only 

%SR15-16  
System Text Screen Size (32-Bit DINT) 
*Excludes RCC Units   

 Read Only Read Only 

%SR17-18  I/O Configuration Table Size (32-Bit DINT)  Read Only Read Only 

%SR19-20  Network Config Table Size (32-Bit DINT)   Read Only Read Only 

%SR21-22  Security Data Table Size (32-Bit DINT)   Read Only Read Only 

%SR23  Ladder Code CRC  Read Only Read Only 

%SR24  User Text CRC  Read Only Read Only 

%SR25  System Text CRC  Read Only Read Only 

%SR26  I/O Configuration Table CRC  Read Only Read Only 

%SR27  Network Configuration Table CRC  Read Only Read Only 

%SR28  Security Data Table CRC  Read Only Read Only 

%SR29 
NET_ID 
 

Network ID   

Read Only Read / Write 
CsCAN Mode 1 to 253 

DeviceNet Mode 0 to 63 

CANOpen Mode 1 to 127 

%SR30  

Network Baud Rate 
0=125KB 
1= 250kB 
2= 5000KB 
3= 1MB 
4=50K 

0 to 4 
 

Read Only Read/Write 

%SR31  

Network Required  
0= Network not required 
1= Network required; 
2= Network optimized; 
3= Network required and optimized 

0 to 3 Read Only Read Only 

%SR32  
LCD Display Contrast setting 
*Excludes RCC Units  

0 to 255 Read Only Read/Write 

%SR33  

Function Key Toggle Mode  
0= Momentary 
1= Toggle 
*Excludes RCC Units    

0 to 1 
 

Read/Write 
Read/Write 

 

%SR34  

RS232 Serial Protocol Mode 
0= Firmware Update (RISM) 
1= CsCAN 
2= Generic (Ladder- Controlled) 
3= Modbus RTU 
4= Modbus ASCII 

 

 
 
 

Read Only 
 

Read Only 

%SR35-36  

Unique Serial Number /  
Hexadecimal LAN1 MAC ID  

 
 

 Read Only Read Only 

%SR37  Model Number  Read Only Read Only 
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Table 6.3 – %SR Registers – Master %SR Table  

Register Default I/O Name Description 
Min-Max 

Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR38  Engine Version ( /100)  Read Only Read Only 

%SR39  BIOS Rev Number  ( / 100)  Read Only Read Only 

%SR40  FPGA Image Rev Number ( / 10)  Read Only Read Only 

%SR41  
Vertical Pixel Count 
*Excludes RCC Units  

 Read Only Read Only 

%SR42  
Horizontal Pixel Count 
*Excludes RCC Units  

 Read Only Read Only 

%SR43  Keypad Type 
*Excludes RCC Units  

 Read Only Read Only 

%SR44 RTC_SEC Real-Time-Clock Second 0 to 59 Read Only Read Only 

%SR45 RTC_MIN Real-Time-Clock Minute 0 to 59 Read Only Read Only 

%SR46 RTC_HOUR Real-Time-Clock Hour 0 to 23 Read Only Read Only 

%SR47 RTC_DATE Real-Time-Clock Date 1 to 31 Read Only Read Only 

%SR48 RTC_MON Real-Time-Clock Month 1 to 12 Read Only Read Only 

%SR49 RTC_YEAR Real-Time-Clock Year 
1996 to 

2095 
Read Only Read Only 

%SR50 RTC_DAY Real-Time-Clock Day (1=Sunday) 1 to 7 Read Only Read Only 

%SR51  Network Error Count  Read Only Read Only 

%SR52  Watchdog-Tripped Error Count  Read Only Read Only 

%SR53-54 Reserved     

%SR55.13  Self-Test: Battery Low or Missing  Read Only Read Only 

%SR56    LAST_KEY 

Key Currently Pressed  
No key = 0 (No key pressed since power-up) 
F1 = 1 
F2= 2 
F3= 3 
F4 = 4 
F5= 5 
F6= 6  
F7=7 
F8= 8 
F9= 9  
F10 = 10 
F11= 11 
F12 = 12 
Enter = 13 
+/ - = 14 
. (dot) = 15 
0 = 16 
1 = 17 
2 = 18  
3 = 19 
4 = 20 
5 = 21 
6 = 22 
7= 23 
8 = 24 
9 = 25 
System = 26 
Escape = 27 
Left = 28 
Right = 29 
Up = 30 

0 to 255 
 

Read Only 
 

Read Only 
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Table 6.3 – %SR Registers – Master %SR Table  

Register Default I/O Name Description 
Min-Max 

Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

Down = 31 
Shift = 32 
Soft Key 1 = 34 
Soft Key 2 = 35 
Soft Key 3 = 36 
Soft Key 4 = 37 
Soft Key 5 = 38 
Soft Key 6 = 39 
Soft Key 7 = 40 
Soft Key 8 = 41 
Release = 255 (Keys pressed since power-up 
but not currently) 
*Excludes RCC Units  

%SR57  

LCD Backlight Dimmer Register 
0-100 = 0% to 100% On 
100-255 = 100% On 
*Excludes RCC Units  

0 to 255 Read/Write Read/Write 

%57.16  
Temporarily disable Screen Saver  
*Excludes RCC Units  

 Read/Write Read/Write 

%SR58 USER_LEDS User LEDs   Read/Write Read/Write 

%SR59  
Engine Build Number (Only last three 
numbers displayed)  

 
 

Read Only Read Only 

%SR60  

Build Option 
Build Test = 0 
Build Beta = 1 
Build Product = 2 

0 to 2 
 

Read Only 
 

Read Only 

%SR61 NUM_IDS Number of CsCAN Network IDs  Read Only Read Only 

%SR62-100 Reserved     

%SR101.3  
WebMI License Details – WebMI server 
status 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR101.4  
WebMI License Details – WebMI user logged 
in status 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR101.8-
101.16 

 
WebMI License Details – Number of users 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR102-107 Reserved     

%SR108  
WebMI License Details – Number of 
webpages 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR109  
WebMI License Details – Number of 
datapoints 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR110-112  
WebMI License Details – Expiry date of 
WebMI license 
*XLEe, XLTe, X2, X4, & X7 only 

 Read Only Read Only 

%SR113-130 Reserved     

%SR131-135  OCS Model: ASCII, 10 characters   Read Only Read Only 

%SR136  Communication Download Timeout  Read Only Read Only 

%SR137  Communication Idle Timeout  Read Only Read Only 

%SR138-148 Reserved     
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Table 6.3 – %SR Registers – Master %SR Table  

Register Default I/O Name Description 
Min-Max 

Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR149-150  
Free-running 10kHz count: 1 count = 0.1ms  
(32-Bit DINT) 

 Read Only Read Only 

%SR151 Reserved     

%SR152  RS-485 Termination   Read / Write Read / Write 

%SR152.1  
MJ2 Termination Enable 
*Excludes RCC972 

 Read / Write Read / Write 

%SR152.2  

MJ3 Termination Enable  
*XL15+ Only 
 
RS485 Termination Enable  
* X4 & X7 Only 

 Read / Write Read / Write 

%SR152.3*  
MJ1 Termination Enable  
*XL15+, XLE, XLT, RCC2414 Only 

 Read / Write Read / Write 

%SR152.4*  

MJ1 Biasing  
*XL15+ Only 
 
CAN Termination Enable  
*X4 & X7 Only 

 Read / Write Read / Write 

%SR153-163 Reserved      

%SR164  FailSafe / Clone     

%SR164.1  RS485 Port Biasing #1 (MJ1 or MJ2)  Read / Write Read / Write 

%SR164.2  RS485 Port Biasing #2 (MJ2 or MJ3)  Read / Write Read / Write 

%SR164.3 AUTO_RESTRD 
Indicates Automatic Restore Operation has 
been performed 

 Read Only Read Only 

%SR164.4 BCKUP_TAKN 
Indicates Backup of Registers has been 
taken 

 Read Only Read Only 

%SR164.5 EN_AUTO_RN 
Enable AUTORUN – Sets “Enable AutoRun” 
to “Yes” or “No” 

 Read / Write Read / Write 

%SR164.6 EN_AUTO_LD 
Enable AUTOLOAD – Sets “Enable 
AutoLoad” to “Yes” or “Not”  

 Read / Write Read / Write 

%SR164.7 STRT_BCKUP 
Start Backup trigger bit – Setting TRUE starts 
backup of all register data  

 Read / Write Read / Write 

%SR164.8 CLR_BACKUP 
Clear Backup trigger bit – Setting TRUE 
clears backup of all register data (if a backup 
was done previously)  

 Read / Write Read / Write 

%SR164.9 MAKE_CLONE 
MAKE_CLONE trigger bit = Setting TRUE 
does a Load Clone (if a media card is 
present)  

 Read / Write Read / Write 

%SR164.10 LOAD_CLONE 
LOAD_CLONE trigger bit – Setting TRUE does 
a LOAD CLONE (if a media card is present 
that contains clone files) 

 Read / Write Read / Write 

%SR164.11 MK_CLN_FL 
Make Clone Fail (This bit goes high when 
Make/Create Clone fails)  

 Read / Write Read / Write 

%SR164.12 
 

LD_CLN_FL 
Load Clone Fail (This big goes high when 
Load Clone fails)  

 Read / Write Read / Write 

%SR164.14   

Set to 1 to restore data manually, and this 
in turn sets %SR164.15 to 1.  
Set to 0 to abort restore operation. 
*RCC Units Only 

 Read / Write Read / Write 
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Table 6.3 – %SR Registers – Master %SR Table  

Register Default I/O Name Description 
Min-Max 

Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR164.15  
Set to 1 for manual restore of data.  
Set to 0 to complete the restore operation.   
*RCC Units Only 

 Read / Write Read / Write 

%SR165-166 Reserved     

%SR167  
Screen Update Time, Default= 5 
*X4 & X7 Only – Default = 10  

2 to 50 Read/Write Read/Write 

%SR168-170 Reserved     

%SR171  X-Coordinate Touched  Read Only Read Only 

%SR172  Y-Coordinate Touched  Read Only Read Only 

%SR173  System-Function Disable,  0 to 1 Read / Write Read / Write 

  %SR174  Removable Media Protect  Read/Write Read/Write 

%SR174.1  Request Media Card be Removed  Read / Write Read / Write 

%SR174.2  Indicates safe to remove Media  Read / Write Read / Write 

%SR175  Removable Media - Status  Read Only Read Only 

%SR176-177  Removable Media Free Space (32-Bit DINT)  Read Only Read Only 

%SR178-179  Removable Media Total Space (32-Bit DINT)  Read Only Read Only 

%SR180 Reserved     

%SR181 ALM_UNACK 
Bits 1-16 indicate Unacknowledged 
in Alarm Groups 1-16 

 Read Only Read Only 

%SR182 ALM_ACT 
Bits 1-16 indicate Active 
in Alarm Groups 1-16 

 Read Only Read Only 

%SR183 SYS_BEEP 
Beep on Keypress Enable  
0= Disabled 
1= Enabled 

0 to 1 Read / Write Read / Write 

%SR184 USER_BEEP 
Internal Beeper 
0=OFF 
1=ON 

0 to 1 Read/Write Read/Write 

%SR185  

Screen Saver Enabled  
0= Disabled 
1= Enabled 
NOTE: See %SR57.16  

0 to 1 Read Only Read Only 

%SR186  Screen Saver Time in minutes (delay) 5 to 1200 Read Only Read Only 

%SR187 NET_USE Network Usage (Avg) 0 to 1000 Read Only Read Only 

%SR188  Network Usage (Min) 0 to 1000 Read Only Read Only 

%SR189  
Maximum Net Usage of all units on the CAN 
network 

0 to 1000 
 

Read Only 
 

Read Only 

%SR190 NT_TX_AVG Network TX Usage % ( / 10) (Avg) 0 to 1000 Read Only Read Only 

%SR191  Network TX Usage % ( / 10) (Min)  0 to 1000 Read Only Read Only 

%SR192  Network TX Usage % ( / 10) (Max) 0 to 1000 Read Only Read Only 

EXTENDED SYSTEM REGISTERS 

%SR193 ONLINE_CHG Online Change    

%SR193.1  TRUE if 2 programs in target FLASH  Read Only Read Only 

%SR193.2  
TRUE to switch programs, FALSE when 
complete 

 Read Only Read Only 

%SR193.3  TRUE if executing program is temporary test  Read Only Read Only 

%SR193.4  
TRUE during last scan of switched-from 
program 

 Read Only Read Only 

%SR193.5  
TRUE during first scan of switched-to 
program 

 Read Only Read Only 

%SR193.6  
TRUE to revert to FLASH and delete all RAM; 
FALSE when complete 

 Read Only Read Only 
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Table 6.3 – %SR Registers – Master %SR Table  

Register Default I/O Name Description 
Min-Max 

Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

%SR193.9 
 
 

TRUE if error in temporary program  Read Only Read Only 

%SR194  
Battery Charge Temp Low 
*XL15+ Only – Frequency in MHz 

 Read Only Read Only 

%SR195  
Battery Charge Temp High  
*XL15+ Only – in degree centigrade 

 Read Only Read Only 

%SR196  

Charging State  
 
NOTE: Refer to MAN1142 for more details 
on Rechargeable Batteries  
 
0=Waiting 
1=Normal Charging 
2=Hot Charge  
3=Hot Charge  
4= Battery Hot  
5= Cold Charge  
6=Battery Cold  
7=No Battery  
8= Not Charging (after 8 hours of charging)  
9= CPU Hot, not charging  
10 Battery voltage <2V, not charging  
11= First 2 minutes Init Wait (Not Charging)  

0 to 11 
 

Read Only 
 

Read Only 

%SR197  Charging Current Max mA  Read Only Read Only 

%SR198  Battery Voltage is mV  Read Only Read Only 

%SR199 Reserved     

%SR200  InitRD Version ( /100)  Read Only Read Only 

%SR201-205  Linux Kernel version:  ASCII, 10 characters  Read Only Read Only 

%SR206-208 Reserved     

%SR209.3  
WebMI Server Status. Bit 3 is ON if server 
running.  

 Read Only Read Only 

%SR209.4  
WebMI User Logged in Status. Bit 4 is ON if 
1 or more users logged in.  

 Read Only Read Only 

%SR209.9-
209.16 

 
Number of Users. Shows in upper byte in 
decimal format.  

 Read Only Read Only 

%SR210 
 

Time Zone: set in minutes + / - UTC.  
(Ex: EST is -4 hours = -240 minutes)  

 Read/Write Read/Write 

%SR211 

 

Daylight Saving: YES = 1 
Daylight Saving: NO = 0 
(If daylight saving is enabled, one hour will 
be added to the local time). 

 Read/Write Read/Write 

%SR212  UTC – Seconds  Read Only Read Only 

%SR213  UTC – Minutes  Read Only Read Only 

%SR214  UTC – Hours  Read Only Read Only 

%SR215  UTC – Date  Read Only Read Only 

%SR216  UTC – Month  Read Only Read Only 

%SR217  UTC – Year  Read Only Read Only 

%SR218 

 
 
 
 
 
 

Number of Webpages, license detail 
(XLE/XLT, X2, X4, & X7 use %SR101 & 
%SR108-112 for WebMI License Details.) 

 Read Only Read Only 
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Table 6.3 – %SR Registers – Master %SR Table  

Register Default I/O Name Description 
Min-Max 

Values 

Program 
(Read/Write) 

 

Display 
(Read/Write) 

 

 

%SR219  
Number of Data Points, license detail. 
(XLE/XLT, X2, X4, & X7 use %SR101 & 
%SR108-112 for WebMI License Details) 

 Read Only Read Only 

%SR220-222  

Expiration Date of WebMI License, license 
detail.  
(XLE/XLT, X2, X4, & X7 use %SR101 & 
%SR108-112 for WebMI License Details) 

 Read Only Read Only 
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6.3 Register Map for XL15+ OCS I/O 
 

Table 6.4 – I/O Register Map 

Registers 
Description 

no I/O 102 I/O 103 I/O 104 I/O 105 I/O 106 I/O 

%I1-%I12 Unused Digital Inputs 

%I13-%I16 Unused Reserved Digital Inputs Reserved 

%I17-%I24 Unused Reserved Digital Inputs Reserved 

%I25-%I29 Unused Reserved 

%I30-%I31 Unused PWM Table (Below) 

%I32 Unused ESCP Alarm* 

%Q1 Unused PWM Table (Below) 

%Q1-%Q6 Unused Digital Outputs 

%Q7-%Q12 Unused Reserved Digital Outputs 

%Q13-%Q16 Unused Reserved 
Digital 

Outputs Reserved 

%Q17-%Q20 Unused Link: HSC Table  

%Q21-%Q24 Unused Reserved 

%AI1-%AI4 Unused Analog Inputs 
%AI1 - %AI2 for Analog Input Channels 
%AI3 - %AI4 - Unused 

Mirror of first 
four analog 
channels.  

%AI33 - %AI38 Unused 

Analog Inputs 
-for all 6 
channels 

%AQ1-%AQ8 Unused PWM Table (Below) 

%AQ9-%AQ10 Unused Analog Outputs 

Unused = These registers can be used as general-purpose registers 

 
 
*Electronic Short Circuit Protection [ESCP]  
 
NOTE:  The ESCP bit is set high when the output current is too high, and the output driver has shut down 
for thermal protection. This typically happens when outputs are shorted, or they are driving loads that 
are higher than the output rating. 
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Table 6.5 – PWM Function Registers Map  
Register PWM HSC Stepper 

%AQ1 
PWM1 Duty Cycle (32-bit) 

HSC1 
Preset Value 

Start Frequency 

%AQ2 Run Frequency 

%AQ3 
PWM2 Duty Cycle (32-bit) 

HSC2 
Preset Value 

Accel Count 
(32-bit) %AQ4 

%AQ5 PWM Prescale 
(32-bit) 

-- 
Run Count 

(32-bit) %AQ6 

%AQ7 PWM Period 
(32-bit) 

-- 
Decel Count 

(32-bit) %AQ8 

%Q1 -- -- Run 

%I30 
-- -- 

Ready/Done 

%I31 Error 

 

 

Table 6.6 – HSC Functions Register Map 

Register Frequency Totalize Pulse Quad 

%AI5-6 HSC1 (function) Accumulator Quad 1 Acc 

%AI7-8 HSC2 (function) Accumulator  

%AI9-10 HSC3 (function) Accumulator Quad 2 Acc 

%AI11-12 HSC4 (function) Accumulator  

%AQ1-2 
 

HSC1 Preset 
  

%AQ3-4 HSC2 Preset 

%Q17 

 

Clear HSC1 

 

Clear Quad 1 

%Q18 Clear HSC2 Set Quad 1 

%Q19 Clear HSC3 Clear Quad 2 

%Q20 Clear HSC4 Set Quad 2 
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6.4 Resource Limits  
 

Table 6.7– Resource Limits 

Resource Value  Resource Value 

%S 16 Ethernet 

CsCAN, Ping, EGD, SRTP, Modbus TCP 
Master (Downloadable protocol) & 

Slave, Ethernet IP, FTP, or HTTP @ 10, 
100, or 1000Mbps 

%SR 448 CsCAN 125kBd, 250kBd, 500kBd, or 1MBd 

%T 16000 Serial Ports 1 RS232, 1 RS485 Ports 

%M 16000 
IDs Per CsCAN 

Network 
64 w/o repeat (253 w/ 3 repeaters) 

%R 49999 
Keypad 
(Virtual) 

8 keys (7 fn keys and a System Key) 

%K 5 Display 800 x 480 7” TFT, 65K colors 

%D 1023 
Screen 

Memory 
64MB 

%I 2048 User Screens 1023 

%Q 2048 
Data Fields 

Per User 
Screen 

1023 

%AI 512 Ladder Code 1024kB 

%AQ 512   
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CHAPTER 7: CSCAPE CONFIGURATION 
 

7.1 Overview 
 
XL15+ OCS hardware is programmed with a Windows based PC application called Cscape. This 
application can be used to program, configure, monitor, and debug all aspects of the XL15+ OCS unit. 
Please see the on-line help provided with Cscape for additional details. 
 
 

7.2 Cscape Status Bar   
 
When the XL15+ OCS is connected to a PC using Cscape software a Status Bar appears at the bottom of 
the screen. The Cscape Status Bar can be used to determine if communications have been established 
between the XL15+ OCS and the Cscape program. Components of the Cscape Status Bar are explained 
below.  
 
 
 
 
 
 
 
 
 
 
 

Ready User:  HE-XExx1-CsCAN (Model=) Equal  Local :1   Target :2(R) [no forces] MOD 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 7.1 – Cscape Status Bar 

  

Equal Indicator – indicates whether the current program in Cscape is equal to the program stored in the 
Target Controller. 

• If Equal, the program in Cscape is the same as the program stored in the Target Controller. 

• If Not Equal, the program in Cscape is not the same as the program stored in the Target Controller. 

• If Unknown, there may have been a change since the last time the program in Cscape was compared 
to the Target Controller.  

Communications Status - indicates the current status of the 
“pass through” Connector.    
 

• Local: xx – indicates the Network ID of the OCS to which the 
Cscape program is physically connected through its serial port. It 
can serve as a pass through device to other nodes on the 
network.   

 

• Target: yy(R) – indicates the Network ID of the device with which 
the Cscape program is exchanging data.  

Note: The Local unit and Target unit can be the same unit 
or they can be separate units. 

 
The following are status indicators: 
 
(R) – Running 
(D) - Do I/O 
(I) – Idle 
(?) – Cscape is not communicating with the remote unit.  
[no forces] – indicates no I/O has been forced. 

Message Line - 
The contents of 
these messages are 
context sensitive. 
The Message line 
can be empty.   

Current User - 
indicates who is logged (for 
security purposes). 

Controller Model - Network (Model Confirmation) 
 

• Controller Model indicates the controller model for which 
the program in Cscape is configured.     

 

• Network indicates the type of network that the program in 
Cscape expects to use (e.g., CsCAN). 

 

• (Model Confirmation) provides the following indications: 
 

• (Model=) – the actual Target Controller matches the 
configured Controller Model and Network. 

 

• (Model Not=) – the actual Target Controller does not match 
the configured Controller Model and Network. 

 

• (Model ?) – there may have been a change since the last 
time the Target Controller was compared to the configured 
Controller Model and Network. 

File Modified Indicator - indicates that the 
file in the selected window has been 

modified but has not been saved.  
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7.3 Establishing Communications  
 
The XL15+ OCS can communicate with Cscape using USB to USB, USB to serial adapters, serial port 
communications via MJ1 Port, Ethernet, CAN (CsCAN), or modems.   
 
To communicate with the XL15+ via USB you will need the automated driver installer located on the 
Horner APG web site.  
 
Otherwise, the drivers may be loaded from the HE-XEC Ethernet Utility -> HTTP Web Server Demo 
-> Communications Drivers  section of the support files page on our website :     
 
North America  https://hornerautomation.com/support -files 
Europe   https://www.hornerautomation.eu/support/ 
 
For XL15+ use Cscape Version 9.8 or newer.  
 
Next, connect a PC’s (Personal Computer running a Windows Microsoft operating system) USB port via 
USB cable to the USB mini B port on the XL15+ OCS. 
 
 
 

 
Figure 7.2 – USB Programming Connector 

 
 
 
 
 
 
  

https://hornerautomation.com/support-files/#collapse_2
https://hornerautomation.com/support-files/#collapse_2
https://hornerautomation.com/support-files
https://www.hornerautomation.eu/support/
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The PC will detect a new device has been plugged into the USB port. 
 

 
Now that the XL15+ is plugged in, go to Cscape → Controller → Connection Wizard. If you are just 
opening Cscape, Connection Wizard usually opens by default. 
 

 
 
 
Select USB and click Next >>. 
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If the Connection Wizard does not pop up upon opening Cscape, then select go to the Cscape menu 
Controller → Connection Wizard, choose the connection method. If connecting for the first time, we 
suggest connecting via USB.  
 
 

 

 

 
 
 
 
 
 

Figure 7.3 – Cscape Connection Wizard Screenshots 
 

 
If Controller USB COM Port is not present in the dropdown list, the Windows operating system has not 
yet recognized the OCS as an installed device. Be sure the installation process is complete and that the 
correct drivers are installed. The Connection Wizard must be completely closed and reopened to refresh 
the USB dropdown list.  
  

 



  MAN1106-08.3-EN_XL15+_UM 

O c t o b e r  2 1 ,  2 0 2 1      P a g e  70 | 194 

An alternate way to select the COM setting is to go to Cscape → Tools → Application Settings → 
Communications → Configure and choose connection method in Add Target.  
 

 
Figure 7.4 – Cscape: Alternative Connection Method Screenshot 

 

 
Figure 7.5 – Add Target Screenshot in Cscape 

 
NOTE: The following fields, Target Name, Connection Medium, Connected Device, and Connection 
Settings, need to be filled for communication configuration if Cscape Connection Wizard was not used. 
Table 7.1 below explains the information needed in each field.  
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Table 7.1 – Communication Configuration Dialog  
Target Name Name for connection. This is not a mandatory column to be filled, by default 

Cscape will populate ‘Default1’ in edit box. 

Connection Medium 

Com Port Select this option to communicate over serial communication with the device. 
The port number can be configured here. 

Ethernet Select this option to communicate over Ethernet. Provide the IP address of the 
device and select the mode: HE GSM GPRS mode, Built in/ ETN Ethernet mode, 
or HE XEC Ethernet mode. 
 
Select HE GSM GPRS mode if communication with XL series controller on GPRS is 
required and the device has GSM modem installed in XL series controller. 

  
Select Built in/ ETN Ethernet mode if the device has on-board Ethernet port. 
  
Select HE XEC Ethernet mode if the device has Ethernet comm. option board 
installed in XL series controller.  

  
NOTE: For GPRS connectivity, GPRS configuration from Programs →Messaging 
→ GPRS needs to be done. 
 
NOTE: The controller should support the type of connectivity selected and 
configured for Ethernet communication. 

CAN Interface Select this option to communicate over CAN. This option requires additional 
hardware to be installed with the PC to be able to do so. Select the type of 
hardware installed from the dropdown. 

Installed Modem Select this option to communicate to the device through the internal modem of 
the computer. Cscape will automatically detect the internal modem attached 
with PC and list in the attached drop down. User can select modem and 
telephone number for target controller. 

NOTE: Cscape will do necessary initialization for the selected internal modem. 

USB Select this option to communicate over USB. Now Horner devices and Horner 
USB to serial converters are recognized and can be specifically selected. 

Connected Device 
NOTE: This configuration is required if the controller to which Cscape is communicating is connected to a CsCAN 
network. 

Connected Device By default, this option is selected and networking feature of Cscape is disabled. 

Target Node ID On selecting this option, Networking feature of Cscape is enabled. CsCAN ID for 
the target controller to be provide here. 

Connection Settings (General Communication Settings) 
Maximum Baud Rate Select the baud rate for serial communication. 

Timeout Select the communication timeout. 
 
NOTE: Select a larger timeout for GPRS and installed modem communication 
configuration 
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If communication is established, the target indicator will show the mode of the controller  
Target: yy(R) as shown in the status section above in this chapter, section Cscape Status Bar. 
 

 
 

 
 
 
        Local ID and Target ID Match 
 

 
If the controller is not communicating, you may need to set the Target ID of the controller in Cscape or 
change the controllers ID on the unit itself. The Target ID allows directing communications to a 
particular unit when multiple units are connected via a CsCAN network. Units without CsCAN network 
ports respond to any network ID and do not require the ID to be configured. 
 
 
To check or change the ID on the XL15+ OCS, press the System Menu key.     
 
The first item in the menu is Set Networks.  Pressing Enter allows the ID of the unit to be viewed or 
modified. 

 

 
 

To point Cscape at the correct controller, change the Target ID of Cscape use the Controller → Set 
Target Network ID dialog. 
 
 
 
 
 
 
 

 
 
  

 

When connected directly to the controller to which Cscape 
communications are required, the Local ID and the Target 
ID should match. 
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7.3.1 Communicating via MJ1 Serial Port 
Start by configuring Cscape to use the correct communications port. This can be done using the Tools → 
Options → Communication Port dialog in Cscape. 
 
Next, connect the PC’s serial port to the port labeled MJ1 on the XL15+. 
 
If communications are successful, the target indicator should show the mode of the controller Target: 
yy(R) as shown in the status section above. 
 
If the controller is not communicating, it may be required to set the target ID of the controller in Cscape 
or on the unit. The Target ID allows directing communications to a particular unit when multiple units 
are connected via a CsCAN network. Units without CsCAN network ports respond to any network ID and 
do not require the ID to be configured. 
 
To check or change the ID on the XL15+, press the System Button to enter the System Menu. The first 
item in the menu is Set Network ID.    
 
Pressing Enter allows the ID of the unit to be viewed or modified. 
 
To change the Target ID of Cscape use the Controller → Set Target Network ID dialog. 
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7.3.2 Communicating via On Board Ethernet Port 
From Cscape go to Controller → Hardware Configuration and do auto configuration for the connected 
controller, click on Config of Ethernet and go to Module Setup. 
 
The IP address, Net Mask, and Gateway of the controller may be temporarily set from the System Menu 
under the Set Networks menu item. Once running or power cycled, the configuration will come from the 
Cscape configuration stored in the unit. 
 
In Module configuration dialog, go to IP Address field enter unused IP Address and configure unused 
registers in Register field & then click OK.  
 

 
Figure 7.6– LAN1 Configuration Dialog 

 
Download the configuration in to Controller. Connect LAN cable to the Controller in default LAN Port.  
 
From Cscape go to Tools → Editor Options → Communication Port → Configure. Select Ethernet and 
enter IP address which is configured in the file. Select mode as XL Series mode from drop down list. 
 
The controller should get connected to Cscape. If communications are successful, the target indicator 
should show the mode of the controller Target: yy(R) as shown in the status section above. 
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7.4 Configuration  
 
An overview of configuration: 

1. Start the configuration by selecting the Controller → Hardware Configuration menu item.  
2. If the XL15+ OCS is connected to the PC, press the Auto Config System button to automatically 

detect the Base model, I/O and any add-on communication options. 
3. If the XL15+ OCS is not connected, press the Config button to the right of the top of the unit. This 

allows the base CPU to be selected. 
4. Select either XL15+ OCS CsCAN from the type drop down box. 
5. Once the type of XL15+ OCS is selected, the model # drop down box will provide the XL15+ OCS 

model numbers from which to choose from. 
6. Once the XL15+ OCS CPU is selected, press OK to exit the dialog and configure the I/O that is 

present in the first slot. 
7. The Hardware Configuration dialog (Specifically the Module Setup tab) provides four (4) buttons 

to configure all of the I/O. Go through each area of I/O and configure it. 
8. Once done configuring the I/O, OK out of configuration dialogs. 

 
Configuring the XL15+ OCS I/O has four main portions that are covered in this chapter.  
For additional information on I/O, refer to the chapters covering General I/O or High Speed I/O. 
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To access the I/O Setup Screen, select Config from the Hardware Configuration/ Local I/O dialog.  Then 
select the Module Setup tab, see screenshot below.  
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7.5 Digital / HSC Input Configuration  
 
The following figure illustrates the Digital / HSC Input Configuration dialog. 
 

 
Figure 7.7 – Digital / HSC Input Configuration Dialog 

 
The active mode group box allows the user to select if inputs are active high (Positive logic) or active low 
(Negative logic). It is important that this setting match what the jumper settings are on the hardware. 
 
The High-Speed Counters group box contains all of the windows that are used for configuring the four (4) 
available high-speed counters on the XL15+ OCS. In configuring a counter, the user needs to set the type, 
mode, and counts per rev. 
 
The type drop down includes the following options: Disabled, Totalizer, Frequency Counter, Pulse Width 
Measurement, Period Measurement, and Quadrature.  
 
For detailed descriptions of the High-Speed Counter types available within the drop-down menu, refer 
to the High-Speed I/O chapter. 
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7.6 Digital / PWM Output Configuration  
The following figure illustrates the Digital / PWM Output Configuration dialog. 
 

 
Figure 7.8 – Digital / PWM Output Configuration Dialog 

 
 
The Q1 and Q2 group boxes allow the user to specify the operation of the multi-function outputs.  
 
The PWM State On Controller Stop group box contains items that allow the user to specify how the PWM 
outputs behave when the controller is stopped. These items can either hold their value or default to some 
value when the controller is stopped. 
 
NOTE: The PWM outputs are set to the OFF state at power-up and during program download and remain 
in that state until the unit is placed in RUN. 
 
The Output State On Controller Stop group box contains items to allow the user to specify how the 
remaining digital outputs behave when the controller is stopped. These items can either hold their value 
or default to some value when the controller is stopped. 
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7.7 Analog Input Configuration 
The following figure illustrates the Analog Input Configuration dialog. 
 

 
Figure 7.9 – Analog Input Configuration Dialog 

 
The Channel x drop down windows allow the user to specify the mode for each analog input to operate. 
The Channel x drop down windows are enabled/disabled according to which model is being configured. 
All the models have the following modes available: 

- 0..10V 
- 0..20mA 
- 4..20mA 

 
On Model 5 and Model 6 I/O, other options on channels are outlined below: 
 

Table 7.2 – Analog In for Models 5 & 6 

Model 5 Model 6 

Channels 1 & 2 Channels 1-6 
0..10V 0..10V 

0..20mA 0..20mA 

4..20mA 4..20mA 

100mV Disable 

PT100 DIN RTD, 1/20°C 0-60mV 

Type J Thermocouple, 1/20°C PT100 DIN RTD, 1/10°C 

Type K Thermocouple, 1/20°C PT1000 DIN RTD, 1/10°C 

Type N Thermocouple, 1/20°C Type J Thermocouple, 1/10°C 

Type T Thermocouple, 1/20°C Type K Thermocouple, 1/10°C 

Type E Thermocouple, 1/20°C Type N Thermocouple, 1/10°C 

Type R Thermocouple, 1/20°C Type T Thermocouple, 1/10°C 

Type S Thermocouple, 1/20°C Type E Thermocouple, 1/10°C 

Type B Thermocouple, 1/20°C Type R Thermocouple, 1/10°C 

* The Filter Constant provides filtering to all channels. 
Type S Thermocouple, 1/10°C 

Type B Thermocouple, 1/10°C 
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7.7.1  Advanced Math Functions 
 
To access the Advanced Math Scaling function, select Tools → Project Toolbox. This will open a side bar, 
and then select Advanced Math → Scale. 
 

 
Figure 7.10 –Scaling Analog Inputs 
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Example 1 
The Cscape Scale function, found in the Advanced Math functions, allows for very easy conversion of the 
raw input value into a meaningful reading. For example, a pressure transducer may be specified as a 4-
20mA signal to signify a 0-2000 psi pressure reading.  With the analog channel set to the 4..20mA range, 
the raw analog input value, which is in INT format ranges from 0 to 4mA to 32000 for 20mA. Use the 
Scale function to obtain an Integer pressure reading using the 0-32000 raw input range and the sensor’s 
0-2000psi output range. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Example 2: 
If readings with fractions are required, the raw Integer input value must first be translated in REAL, or 
Floating Point format. The Cscape INT-to-REAL Conversion function may be used to convert the raw 
input value from INT to REAL format in an intermediate memory location. The SCALE function, specified 
as REAL type, may be used to scale the converted raw value into a reading that supports digits beyond 
the decimal place, i.e. 475.25psi.  
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7.8 Analog Output Configuration  
 
The following figure illustrates the Analog Output Configuration dialog. 
 

 
 

Figure 7.11 – Analog Output Configuration Dialog 
 
 
The Output value on STOP group box contains items that allow the user to specify how the analog output 
channels behave when the controller is stopped. The outputs can either hold their value or default to a 
value when the controller is stopped. 
 
The Output Mode group box allows the user to select the operating modes for each of the analog outputs. 
The modes include the following: 
 

- 0..10V 
- 0..20mA 
- 4..20mA 
- Disable 
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CHAPTER 8: GENERAL I/O 
 
NOTE: The datasheet is the first document to refer to for model-specific information related to XL15+ 
OCS models such as pin-outs, jumper settings, and other key installation information. Visit the Horner 
websites to obtain datasheets, user documentation, and updates.  
 
North America  https://hornerautomation.com   
Europe   http://www.hornerautomation.eu 
 

8.1 Overview 
 
The XL15+ OCS is a compact unit that contains high density, very versatile I/O. Using the I/O properly 
requires wiring to the proper terminals, configuring jumpers inside the XL15+ OCS unit and configuring 
Cscape properly. This section will offer some tips and suggestions to configure the I/O properly. For the 
register mapping of the I/O, refer to the Index at the end of this manual for the pages referencing register 
mapping.  
 

8.2 Removing the XL15+ OCS I/O Cover   
 
 
 
 
 
Some I/O configurations require jumper settings to be changed in the XL15+ OCS unit. Examples of these 
settings are setting positive or negative logic on digital inputs or setting current or voltage on analog 
inputs. 
 
Each XL15+ OCS I/O jumper is set to a factory default. Refer to the XL15+ datasheet to find the default 
setting to determine if a jumper change is necessary for a particular application. 
 
To remove the I/O cover of the XL15+ OCS, remove the four (4) Phillips screws from the I/O back. It may 
help to place the XL15+ OCS unit face down on a clean work surface. Once the four screws are removed, 
the I/O cover can be lifted straight off. 
 
 
 
 
 
 
 
 
 
 
 
 
 

WARNING: Power, including I/O power must be removed from the unit prior to removing the back 
cover. Failure to do so could result in electrocution and/or damage to equipment. 

https://hornerautomation.com/
http://www.hornerautomation.eu/
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Figure 8.1 – Removing the I/O Cover   
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Figure 8.2 – XL15+ I/O Cover Removed (sample I/O board)  
 

Once the back is removed, the jumper selection can be changed. The jumper settings are documented 
on each data sheet using a diagram such as the figure below and a description of the jumper settings. 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

Figure 8.3 – Example Jumper Diagram  
 
 
To re-install the cover, place the I/O cover back on the unit. 
  
Place the screw back into the hole and turn the screw slowly counter clockwise until it clicks into the 
threads. This prevents the screw from being cross-threaded. Now turn the screw clockwise until the cover 
is firmly secured. Repeat this process for all four (4) screws. 
 
Ensure not to exceed the recommended max torque of 7-10 in-lbs [0.8 – 1.13 Nm]. 
 
  

J1 J2

J3

JP3

JP1

001XLE005-R1

J4
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8.3 Model and I/O Overview  
 

Table 8.1 – I/O and Model Overview 

XL15+ Models DC In DC Out Relays HS In HS Out mA/V In 
mA/V 

RTD/Tc 
mA/V Out 

HE-XP7E0         

HE-XP7E2 12  6 4  4   

HE-XP7E3 12 12  4 2 2   

HE-XP7E4 24 16  4 2 2   

HE-XP7E5 12 12  4 2  2 2 

HE-XP7E6 12 12  4 2 6* 6* 4* 

Table 8.3 shows the different types of I/O included with the various XL15+ OCS models. Specific 
specifications, jumper settings and wiring diagrams can be found in the data sheets. Descriptions and 
applications of the different type of I/O can be found below. 
*up to 6 mA/V In, mA/V RTD/TC, and 4 mA/V Out. 
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8.4 Solid-State Digital Outputs  
 
Solid-state digital outputs are generally used to activate lamps, low voltage solenoids, relays, and other low 
voltage and low current devices.   
 
NOTE: The digital outputs used on the XL15+ OCS are “sourcing” outputs. This means the output applies a 
positive voltage to the output pin when turned ON. When turned off, the output applies approximately zero 
volts with respect to the I/O ground. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8.4 – Typical Output Wiring 
 

The digital outputs used in the XL15+ OCS have electronic short circuit protection and current limiting. While 
these electronic protections work in most applications, some application may require external fusing on 
these outputs. 
 
The digital outputs in the XL15+ OCS are typically controlled via %Q bits in the register mapping. Some of the 
outputs are designed for high-speed applications and can be used for PWM or frequency output 
applications. Please see the data sheet and the chapter on High Speed I/O for additional information. 
 
When the controller is stopped, the operation of each output is configurable. The outputs can hold the state 
they were in before the controller stopped, or they can go to a predetermined state. By default digital 
outputs turn off. For more information on stop state see the Index to find pages referencing Cscape settings.  
 
The digital outputs feature an output fault bit. %I32 will turn on if any of the outputs experience a short 
circuit, over-current or the output driver overheats. 
 
  

Q14 

Q15 

V+ 

0V 

LOAD 

LOAD 

10 - 30VDC 

Q16 LOAD 

J2 

J4 
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8.5 Relay Outputs  
 
Relay outputs are designed to switch loads that typically have high voltage or current requirements or 
require the isolation that relays provide. 
NOTE: The design of the XL15+ OCS does not require external coil power for the relays to function. The 
relays will activate anytime the XL15+ OCS is powered. 
 
There are several factors that should be considered when using relays: 

• Relay Life – Relays are mechanical devices that have a long but limited life. Typically, switching more 
current limits the life of relays. Please check the data sheets for expected relay life. 

• Current / Temperature De-Rating – Products containing relays often have total current limits based on 
the ambient temperature of the application. Please see the product data sheet for current / 
temperature de-rating information for relays. 

• Fusing – External fusing is generally required to protect the relays, devices, and wiring from shorts or 
overloads.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Protection for Inductive Loads—Inductive loads can cause reverse currents when they shut off that can 
shorten the life of relay contacts. Some protective measures need to be determined by an engineer. If 
you have questions on protection from inductive load, consult Technical Support. Details on devices that 
may protect outputs can be found in MAN0962. 
 
Output State on Controller Stop—When the controller is stopped, the operation of each output is 
configurable. The outputs can hold the state they were in before the controller stopped, or they can go 
to a predetermined state. By default, relay outputs turn off. For more information on Stop State see the 
Index for Cscape settings pages.   
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Warning:  To protect the module and associated wiring from load faults, use external (5A) fuse(s) as shown. Fuses 
of lower current or fusing for the entire system need to be in place to assure the maximum current rating 
of the unit is not exceeded. 

Warning: Connecting high voltage to any I/O pin can cause high voltage to appear at other I/O pins.  

 
 

Figure 8.5 – Relay Fusing 
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8.6 Digital Inputs  
 
NOTE: Refer to the datasheet for XL15+ OCS model being used for details on jumper settings.  
 
NOTE: The digital inputs on the XL15+ OCS are designed for low voltage DC inputs. The inputs are 
designed to support both positive and negative input modes. The mode is set by a jumper setting and a 
configuration parameter in Cscape. All the inputs on the unit must be configured to the same mode. 
 
  
 
 
 
 
 
 
 
 

 
Figure 8.6 – Positive and Negative Inputs 

 
In positive logic mode, a positive voltage applied to the input will turn the input. The internal design of 
this mode is basically a resistor from the input to I/O ground. This mode is sometimes called sourcing. 
 
In negative logic mode, connecting the input to the I/O ground or zero volts will turn the input on. The 
internal design of this mode is basically a resistor from the input to the positive I/O voltage (usually 12V 
or 24V). This mode is sometimes called sinking. 
 
Some of the digital inputs may support high-speed input functional such as counting or frequency 
measurement.   
  

I1

0V

001XLE036

12-24VDC

I1

0V

Positive Logic In                       Negative Logic In 
 

Positive Logic vs. Negative Logic Wiring 
The XL SERIES OCS can be wired for Positive Logic inputs or 

Negative Logic inputs. 
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8.7 Analog Inputs  
 
NOTE: See the data sheet for the XL15+ OCS model being used for jumper settings and see the appropriate page 
in this manual (see Index) for details on how to use Cscape to configure the digital filtering. 
 
The analog inputs on the XL15+ OCS allow voltage or current measurement from a variety of devices. The 
voltage or current mode is set though jumpers on the unit and settings in Cscape. Each channel can be 
separately configured for voltage or current mode. 
 
The analog inputs have a digital filter that can be used to filter electrical noise that may be unavoidable in 
some installations. The downside to digital filtering is the inputs will respond more slowly to sudden 
changes in the actual input.   
 
 
8.7.1 Common Cause of Analog Input Tranzorb Failure, Models 2, 3, & 4 

If a 4-20mA circuit is initially wired with loop power but without a load, the analog input could see 24VDC. 
This is higher than the rating of the tranzorb. 
 

This can be solved by not connecting loop power prior to load connection or by installing a low-cost PTC in 
series between the load and the analog input. 
 

 
Figure 8.7 – Analog Input Tranzorb - Troubleshooting 

 
 
 

8.7.2 Thermistor Option for Special Orders 
NOTE: The standard unit does NOT support thermistor. 
 
Thermistor support is a factory option for Models 2, 3, and 4 only. Model 2 can support a two-channel 
and four-channel thermistor. Models 3 & 4 support the two-channel thermistor only.  Please refer to the 
Thermistor Supplement, SUP0797, for thermistor specifications and implementation details.   
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8.8 Universal Analog Inputs Model 5 
 
NOTE: See the data sheet for the XL15+ OCS model being used for jumper settings, and see the 
appropriate pages in this manual (see Index) for details on how to use Cscape to configure the digital 
filtering, Advanced Math Functions. 
 
The universal analog inputs provide a high resolution, very flexible interface for a variety of analog inputs. 
These inputs include voltage, current, thermocouple, RTD, and millivolt. Each channel can be configured 
separately using jumpers and configuration settings in Cscape.   
 
Like the standard analog inputs, these inputs have a digital filter that can be used to filter electrical noise 
that may be unavoidable in some installations. The downside to digital filtering is the inputs will respond 
more slowly to sudden changes in the actual input.  
 
 

8.9 Universal Analog Inputs 
 
Universal Analog Inputs 
The Universal Analog Inputs on the Model 6 IO board are unique from other Horner XL-series 
input/output cards in that they are configurable through the module configuration instead of having to 
change jumper settings in order to setup the input type. To configure the Universal Analog input type: 

1) Select Analog In to access the Analog Input Configuration menu. 

2) Select any of the Analog input types from the dropdowns by clicking the down arrow beneath 

each corresponding Channel, as seen below: 

3)  

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8.8 – Analog Input Configuration Screen  
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4) Ensure the proper wiring is used for each of the three (3) pins A, B, and C on the Universal 

Analog Inputs as seen in the reference image below.    

 

Figure 8.9 – Loop Power Wiring Details 

 

 

8.10 Analog Outputs  
 
NOTE: Refer to the datasheet for XL15+ OCS model being used for details on jumper settings.  
The analog outputs on XL15+ OCS devices provide high resolution voltage or current outputs. The voltage 
or current selection is controlled with jumpers and configuration settings in Cscape.   
 
NOTE: Each channel can be separately configured for voltage or current mode. 
 
When the controller is stopped, the operation of each output is configurable. The outputs can hold the 
state they were in before the controller stopped or they can go to a predetermined value. By default, 
analog outputs are set to a value of zero.  
 
 

CHAPTER 9: HIGH SPEED I/O (HSC / PWM) 
 

Wiring Details: 
SPRING CLAMP TERMINALS:       Solid/Stranded wire—16-24 awg (1.5-0.2 mm2). 

               Strip Length—0.31” (8 mm). 
 
SCREW TERMINALS:     Solid/Stranded wire—14-28 awg (2.1-0.08 mm2). 
     Strip Length—0.24” – 0.28 (6-7 mm). 
     Torque Rating—2 in-lbs (0.2 N-m). 
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9.1 Overview  
In addition to the compliment of simple analog and digital I/O, several of the XL15+ OCS I/O modules 
support High Speed Counting (HSC) I/O functions and may also support Pulse Width Modulation (PWM) 
Output functions (non-relay modules). The HSC functions include internal timing, frequency, totalizing, 
pulse width/period, and quadrature measurement. The PWM functions include traditional PWM (with 
variable rate and duty cycle) and a stepper (limited functionality) with variable acceleration and 
deceleration rates. To determine function availability, refer to the associated model’s 
Specification/Installation sheet (Digital DC Input / Output sections). 
 
This chapter describes the operation of these high-level I/O functions. For configuration details of these 
functions, see Cscape Configuration.   
 

9.2 Glossary 
 

Table 9.1 – Glossary of High Speed I/O Terms 

Accumulator Register used to accumulate or store up a sum or count of many items or events.  

Clear 
A special function to zero out the value in a specific register. (Not used with Frequency 
or Period Measurement.) 

Disable A special function to prevent the counter from running. 

Encoder 
A sensor or transducer for converting rotary motion or position to a series of 
electronic pulses. 

Frequency 
Input 

The number of times an electromagnetic signal repeats an identical cycle in a unit of 
time, usually one second. 

Latch 
(strobe) 

A special function that uses a digital logic circuit to store one or more bits. A latch has 
a data input, a clock input, and an output. When the clock input is active, data on the 
input is "latched" or stored and transferred to the output register either immediately 
or when the clock input goes inactive. The output retains its value until the clock goes 
active again.  

Marker  
Input into the OCS that indicates a particular position. Typically, an encoder has a 
marker output that represents a specific point in the rotation. 

Polarity 
A polarity pull-down box is associated with each function and indicates the way the 
trigger happens (e.g., High level, Low Level, Falling Edge, Rising Edge).   

Preload 
(load) 

A special function used to trigger loading of a value into a register upon an event. (Not 
used with Frequency or Period Measurement.) 

Quadrature 
A high-speed device that expresses the phase relationship between two periodic 
quantities of the same period when the phase difference between them is one fourth 
of a period. A coupler in which the two output signals are 90° out of phase. 

Totalizer A counter that sums the total number of cycles applied to its input. 
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9.3 High Speed Counter (HSC) Functions  
The XL15+ supports two very high speed, configurable counters. There are four dedicated inputs that 
can be configured to a number of different options. Each of the two counters can run in one of five 
modes. Those modes are Totalizer, Frequency Counter, Pulse Width Measurement, Period 
Measurement, and Quadrature measurement. For some modes, more than one HSC input may be 
consumed. The measurement values are provided to ladder in a %AI register (Table 9.3). 
 
9.3.1 Frequency  
In frequency mode, the frequency of the input signal is written to the accumulator in terms of Hertz 
(cycles/second). When using frequency mode, four update selections are provided which specify the 
width of the sample window.  
 
NOTE: Selecting a shorter sample window provides a quicker measurement (faster response) but lowers 
the frequency accuracy (resolution) and increases the minimum frequency measurement limit. In this 
mode the Disable and Latch special functions are allowed. Refer to the HSC Glossary for a description of 
these functions. 
 
9.3.2 Totalize  
In totalize mode, the accumulator is simply incremented or decremented each time the input transitions 
in a specific direction.  
 
The totalizer supports the following modes: 
 

Table 9.2 – Modes supported by Totalizer 

Internal This mode ties the input to the counter to an internal 10MHz or 1MHz 
clock. The special functions can be used to accurately time events. 

Count Up This increments the accumulator when the input is enabled.   
NOTE: Two inputs can be assigned. Either input can cause the counter to 
increment. The second input can also be disabled. 

Count Down This decrements the accumulator when the input is enabled.   
NOTE: Two inputs can be assigned. Either input can cause the counter to 
decrement. The second input can also be disabled. 

Up/Down  
(Input 1 Up/Input 2 
Down) 

In this mode, Input 1 (assigned to any of the four inputs) increments the 
counter, while Input 2 (also assigned to any of the 4 inputs) decrements 
the counter. 

Clk/Dir 
(Input 1 Clk, Input 2 Dir) 

This mode uses Input 1 as a clock signal to increment or decrement the 
counter and then uses Input 2 to decide the direction. Input 2 disabled 
increments the counter, while Input 2 enabled decrements the counter. 

 
NOTE: The totalize mode enables the Disable, Latch, Preload, and Clear special functions. Refer to the 
HSC Glossary for a description of these functions. 
 
 
NOTE: Counter triggers off the rising edge of the signal.   
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9.3.3 Pulse Width Measurement 
 
In pulse width measurement mode, the high-speed input can measure the width of a pulse stream in 
one of two modes and provides a continuous indication of the last sampled value. In this mode, the 
Disable and Latch special functions are allowed. Refer to the HSC Glossary for a description of these 
functions. 
 
Width High 1 μs Counts – In this sub-mode the accumulator value will contain the number of 1 μs counts 
the pulse is high. 

 
 
 
 
 
 
Width Low 1 μs Counts - In this sub-mode the accumulator value will contain the number of 1 μs counts 
the pulse is low. 
 
 
 
 
 
 

Figures 9.1-9.2 - Pulse Width Measurements, High & Low 
  

Width High 

Width Low 
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9.3.4 Period Measurement 
 
In period measurement mode, the high-speed input can measure the period of a pulse stream in one of 
two modes and provides a continuous indication of the last sampled value. In this mode, the Disable and 
Latch special functions are allowed. Refer to the HSC Glossary for a description of these functions. 
 
Period Rising Edges 1 μs Counts – In this sub-mode the period of the input signal is reported in one (1) μs 
units. The period measurement will start on the rising edge of the input. 
 
 
 
 
 
 
 
Period Falling Edges 1 μs Counts – In this sub-mode the period of the input signal is reported in one (1) μs 
units. The period measurement will start on the falling edge of the input. 
 
 
 
 
 
 
 

Figures 9.3-9.4 – Period Measurement, Rising Edges & Falling Edges 
  

Period from Rising Edge 

Period from Falling Edge 
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9.3.5 Quadrature  
Quadrature mode uses two HSC inputs; any of the four HSC inputs can be assigned for this purpose.  

 
Quadrature mode works much like the totalizer except the accumulator will automatically increment or 
decrement based on the rotation phase of the two inputs. See the following example for more details. 
Quadrature inputs are typically used for reporting the value of an encoder. 
 
Two modes are available for quadrature that select whether the accumulator counts up or down when 
the phase of Input 1 leads Input 2. Check the encoder’s documentation to determine the output form it 
uses, or try both modes to determine if the encoder counts up when expected.   
 

Figure 9.5 – Quadrature 
 
 
Using the above waveforms and a HSC input configuration of “Quadrature” - “1 leads 2, count up,” the 
accumulator will count up when 1 is rising and 2 is low, 1 is high and 2 is rising, 1 is falling and 2 is high, 
and when 1 is low and 2 is falling. This results in four (4) counts per revolution. In order to determine the 
number of cycles, the accumulator would have to be divided by four (4).  
 
Marker reset operation is configured in the special operations and can be assigned to any of the four (4) 
high speed inputs or can be assigned to be controlled by a “Q” bit in ladder. 
 
NOTE: The quadrature mode enables the Disable, Latch, Preload, Clear, and Marker special functions. 
Refer to the HSC Glossary for a description of these functions. 
  

90° phase 
shift 

1 (leading) 

2 (lagging) 
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9.3.6 Register Match 
 
Totalizer & Quadrature counter modes support a register match function. When the accumulator value 
matches either the Match 1 or Match 2 value configured in the corresponding %AQ registers, a high-
speed output can Turn On, Turn Off, or Toggle. An internal %I register mirrors the output state whether 
the high-speed output is configured or not. The output can be reset in program logic using the 
corresponding %Q registers.   
 
 

1. 2-Counter Mode has Register Match support for both counters. 
2. 4-Counter Mode has Register Match support only for counters 1 and 2. 
3. The High-Speed Outputs are %Q1 for Counter 1 and %Q2 for Counter 2. They operate as high-

speed outputs, independent of the controller scan rate, when configured as ‘HSC Output’ in the 
Digital Out/PWM configuration in Cscape. 

4. The High-Speed Output state reflects in the status register “High Speed Out”, e.g. %I1603 for 
Counter 1 (the update speed of the status bit is scan rate dependent) 

5. The High-Speed Output can be reset through ladder with the assigned output, e.g. %Q1606 for 
Counter 1 

6. Both Match 1 and Match 2 values will trigger the match function. 
7. If the output is already triggered by any Match register while using ‘Turn On’ or ‘Turn Off’ 

modes, subsequent matches will not affect the output. 
8. If using ‘Toggle’ mode, every match of either Match value will toggle the output to the opposite 

state. 
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9.3.7 HSC Functions 
 
The high-speed input on the XL4 contains many optional tasks. All of which can be disabled, or set to an 
internal pre-assigned register (Assigned %Q) or to one of the external high speed inputs (External Input 
#1, 2, 3, or 4), or they can be set as an “overflow interrupt” or “underflow interrupt” meaning that they 
will occur when either the Overflow or Underflow input has been activated. 
 
Disable: When the Disable function is active, it will “disable” the high-speed inputs and no longer count 
pulses until it is re-enabled 
 
Latch: When the Latch function is active, it takes the current value of the Accumulator and moves it into 
the “Latch Value” register 
 
Preload: When the pre-load function is active, it will take the value from the “Preload” register and put 
it into the “Accumulator” for the corresponding Counter. 
 
Clear: When the clear function is active, it will move a value of 0 into the “Accumulator” for the 
corresponding counter. 
 
Marker: When the marker function is enabled, it acts as a dynamic enable/disable for the Disable, Latch, 
Preload, and Clear functions. If the marker is enabled and “Assigned %Q” is selected, then both the 
“Disable” and the “Disable Marker” bits need to be set high in order to disable the high-speed input. If 
the Marker is set for one of the inputs, then the input will need to be “High” in order to use any of the 
Disable, Clear, Preload, or Latch functions. 
 
 

9.3.8 Status Bits 
There are three status bits (%I registers for each high-speed counter). 
 
Overflow Flag: This status bit turns high when the Accumulator “overflows”, it moves from 
4,294,967,295 (-1 if Signed) to 0, this bit can be reset with the “Output Reset Bit”. See Table 12.3. 
 
Underflow Flag: This status bit turns high when the Accumulator “underflows”, it moves from 0 to 
4,294,967,295 (-1 if Signed), this bit can also be reset with the “Output Reset Bit”. 
 
NOTE: For the Overflow and Underflow flag registers, if using some sort of counter that counts both up 
and down, going over the threshold to go negative, triggers the underflow, and then going back over the 
threshold back into positive numbers will trigger the positive register to go active. 
 
High Speed Out: This register will follow the high-speed output assigned to the counter, it is important 
to note that this register is still populated within the scan time so the value in this register may not be 
up to date depending on the timing of the output (it should be up to date within one scan). 
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9.4 HSC Functions Register Map 
 
The register assignments for the high speed I/O can be moved via a setting in Cscape. The values shown 
are the DEFAULT values and may not match the same starting point as the values shown below. 
 

Table 9.3 HSC Functions Register Map 

Register Description 

%AI401-402 Acc / Counter value (Counter1) 

%AI403-404 Latch Value (Counter1) 

%AI405-406 Acc / Counter value (Counter2) 

%AI407-408 Latch Value (Counter2) 

%AI409-410 Acc / Counter value (Counter3) 

%AI411-412 Latch Value (Counter3) 

%AI413-414 Acc / Counter value (Counter4) 

%AI415-416 Latch Value (Counter4) 

Register  Description 

%AQ401-402 Preload Value (Counter1) 

%AQ403-404 Match1 Value(Counter1) 

%AQ405-406 Match2 Value(Counter1) 

%AQ407-408 Preload Value (Counter2) 

%AQ409-410 Match1 Value(Counter2) 

%AQ411-412 Match2 Value(Counter2) 

%AQ413-414 Preload Value (Counter3) 

%AQ415-416 Match1 Value(Counter3) 

%AQ417-418 Match2 Value(Counter3) 

%AQ419-420 Preload Value (Counter4) 

%AQ421-422 Match1 Value(Counter4) 

%AQ423-424 Match2 Value(Counter4) 

Register  Description 

%Q1601 Latch Trigger (Counter1) 

%Q1602 Preload Trigger (Counter1) 

%Q1603 Clear Trigger (Counter1) 

%Q1604 Disable Counter (Counter1) 

%Q1605 Direction (Counter1) 

%Q1606 Underflow/Overflow/HSCQ Reset (Counter1) ( High – Reset) 

%Q1607 Preload Disable(Counter1) (High – Disable) 

%Q1608 Latch Disable (Counter1)(High - Disable) 

%Q1609 Disable Marker Level (Counter1) 

%Q1610 Latch Marker Level (Counter1) 

%Q1611 Preload Marker Level (Counter1) 

%Q1612 Clear Marker Level (Counter1) 

%Q1613 Reserved (Counter1) 
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%Q1614 Reserved (Counter1) 

%Q1615 Reserved (Counter1) 

%Q1616 Reserved (Counter1) 

%Q1617 Latch Trigger (Counter2) 

Register  Description 

%Q1618 Preload Trigger (Counter2) 

%Q1619 Clear Trigger (Counter2) 

%Q1620 Disable Counter (Counter2) 

%Q1621 Direction (Counter2) 

%Q1622 Underflow/Overflow/HSCQ Reset (Counter2) ( High – Reset) 

%Q1623 Preload Disable(Counter2) (High – Disable) 

%Q1624 Latch Disable (Counter2)(High - Disable) 

%Q1625 Disable Marker Level (Counter2) 

%Q1626 Latch Marker Level (Counter2) 

%Q1627 Preload Marker Level (Counter2) 

%Q1628 Clear Marker Level (Counter2) 

%Q1629 Reserved (Counter2) 

%Q1630 Reserved (Counter2) 

%Q1631 Reserved (Counter2) 

%Q1632 Reserved (Counter2) 

%Q1633 Latch Trigger (Counter3) 

%Q1634 Preload Trigger (Counter3) 

%Q1635 Clear Trigger (Counter3) 

%Q1636 Disable Counter (Counter3) 

%Q1637 Direction (Counter3) 

%Q1638 Underflow/Overflow/HSCQ Reset (Counter3) ( High – Reset) 

%Q1639 Preload Disable(Counter3) (High – Disable) 

%Q1640 Latch Disable (Counter3)(High - Disable) 

%Q1641 Reserved (Counter3) 

%Q1642 Reserved (Counter3) 

%Q1643 Reserved (Counter3) 

%Q1644 Reserved (Counter3) 

%Q1645 Reserved (Counter3) 

%Q1646 Reserved (Counter3) 

%Q1647 Reserved (Counter3) 

%Q1648 Reserved (Counter3) 

%Q1649 Latch Trigger (Counter4) 

%Q1650 Preload Trigger (Counter4) 

%Q1651 Clear Trigger (Counter4) 

%Q1652 Disable Counter (Counter4) 

%Q1653 Direction (Counter4) 
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%Q1654 Underflow/Overflow/HSCQ Reset (Counter4) ( High – Reset) 

%Q1655 Preload Disable(Counter4) (High – Disable) 

%Q1656 Latch Disable (Counter4)(High - Disable) 

%Q1657 Reserved (Counter4) 

Register  Description 

%Q1658 Reserved (Counter4) 

%Q1659 Reserved (Counter4) 

%Q1660 Reserved (Counter4) 

%Q1661 Reserved (Counter4) 

%Q1662 Reserved (Counter4) 

%Q1663 Reserved (Counter4) 

%Q1664 Reserved (Counter4) 

Register  Description 

%I1601 Overflow Flag (Counter1) 

%I1602 Underflow Flag (Counter1) 

%I1603 HSCQ(Counter1) 

%I1604 Reserved (Counter1) 

%I1605 Overflow Flag (Counter2) 

%I1606 Underflow Flag (Counter2) 

%I1607 HSCQ(Counter2) 

%I1608 Reserved (Counter2) 

%I1609 Overflow Flag (Counter3) 

%I1610 Underflow Flag (Counter3) 

%I1611 HSCQ(Counter3) 

%I1612 Reserved (Counter3) 

%I1613 Overflow Flag (Counter4) 

%I1614 Underflow Flag (Counter4) 

%I1615 HSCQ(Counter4) 

%I1616 Reserved (Counter4) 
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9.5 High Speed Output Functions 
 
On units that support High Speed Output functions, two dedicated outputs are available that can be 
configured for one of four modes of operation. Those modes are Normal, PWM, HSC Match, and Stepper.   
 
9.5.1 Normal 
When either Q1 or Q2 is configured for Normal operation, the digital output registers %Q1 and %Q2 drives 
that respective output. 
 
9.5.2 PWM 
When either Q1 or Q2 is configured for PWM, the PWM function drives that respective output. Both PWM 
channels may be individually enabled and can have independent frequency and duty cycles. 
 
The PWMs require two parameters (%AQs) to be set for operation. These parameters may be set at run-
time.   

 
Duty Cycle - The Duty Cycle is a 32-bit value from 0 to 32,000 indicating the relative duty cycle of the 
output. For example, a value of 8000 would indicate a 25% duty cycle, a value of 16,000 would indicate a 
50% duty cycle. Zero (0) turns the output off, and 32,000 turns the output on.  

 
Frequency - The Frequency is a 32-bit value indicating the output frequency in Hertz. One over the 
frequency is the period. 

 

 
Figures 9.6 & 9.7 – PWM, Two Parameters: Duty Cycle and Frequency 
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At controller power-up or during a download, the PWM output is maintained at zero until both the 
Frequency and the Duty cycle are loaded with non-zero values. When the controller is placed in stop mode, 
the state of the PWM outputs is dependent on the PWM State on Controller Stop configuration. This 
configuration allows for either hold-last-state or specific frequency and duty cycle counts. Specifying zero for 
either the period or duty causes the PWM output to remain low during stop mode. 
 
NOTE: For standard I/O models (1E3, 1E4, 1E5, and 1E6) the maximum recommended PWM frequency is 
10kHz, due to the limitations of built-in output circuitry. The HE-XHSQ generates 24V pulse outputs with a 
recommended max of 400kHz. The HE-XHSQ-5 generates 5V pulse outputs with a recommended max of 
1.0MHz. The add-on HSQ and HSQ-5 module can be added to the 1E2 unit for HSC function. 
 
 

9.5.3 PWM Output Waveform 
 

 
Figure 9.8 – PWM Output Waveform  

 
 
 

Table 9.4 – PWM Output Waveform Table 

Rise Time 150ns Max 

Fall Time 150ns Max 

PWM Period Frequency = 
1

𝑃𝑒𝑟𝑖𝑜𝑑
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9.5.4 High Speed Counter Match 
When either Q1 or Q2 is configured for HSC Output operation, their output state is based on a 
comparison between the counter accumulator and match registers. See details above in the high-speed 
input section.  
 
 

9.5.5 Stepper Function 
The XL15+ supports two stepper functions, one on each high-speed output. 
 
The Stepper requires five parameters (%AQs) to be set for operation. These parameters may be set at 
run-time but are ‘latched’ when the stepper is commanded to start: 
 

Start Frequency 
(pulses per second) 

Sets the frequency for the first cycle during the acceleration phase and the 
frequency of the last cycle during the deceleration phase. When an 
acceleration or deceleration count is specified, the Start Frequency must be 
greater than 0 and must not exceed the run frequency or an error is 
generated. 

Run Frequency 
(pulses per second) 

Sets the frequency for the last cycle during the acceleration phase, the 
consistent frequency during the run phase, and the frequency of the first cycle 
during the deceleration mode. The Run Frequency must be greater than 0 and 
must not exceed 5000Hz (standard), 400,000Hz (HE-XHSQ), or 1.0MHz (HE-
XHSQ-5)  

Acceleration Count  

Sets the number of cycles to occur within the acceleration phase. The 
frequency of the cycles within this mode will vary linearly between the 
specified Start and Run frequency. The Accel count must not equal 1 or an 
error is generated. Setting this value to zero disables this phase. 

Run Count 
Sets the number of cycles to occur within the run phase. The frequency of the 
cycles within this mode is constant at the specified Run frequency. The Run 
count may be any value. Setting this value to zero disables this phase. 

Deceleration Count  

Sets the number of cycles to occur within the deceleration phase. The 
frequency of the cycles within this phase will vary linearly between the 
specified Run and Stop frequency. The Decel count must not equal 1 or an 
error is generated. Setting this value to zero disables this phase. 
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The stepper provides two Boolean registers to provide stepper status: 
 

Ready/Done 
A high indication on this register indicates the stepper sequence can be started 
(i.e. not currently busy) and also when the move is completed. 

Error 

A high indication on this register indicates that one of the analog parameters 
specified above is invalid or the stepper action was aborted before the 
operation was complete. This register is cleared on the next start command if 
the error was corrected. 

 

The stepper requires one discrete register to control the stepper action. Setting this register starts the 
stepper cycle. This register must remain set to complete the entire cycle. Clearing this register before the 
cycle is complete aborts the step sequence and sets the error bit. 
 
NOTE: Setting the PLC mode to stop while the stepper is in operation causes the stepper output to 
immediately drop to zero and the current stepper count to be lost. 
 
NOTE: The stepper output level may cause damage or be incompatible with some motor drive inputs. 
Consult drive documentation to determine if output level and type is compatible. 
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9.6 High Speed Output Functions Register Map 
 
The register assignments for the high speed I/O can be moved via a setting in Cscape. The values shown 
are the DEFAULT values and may not match the same starting point as the values shown below. 
 
 

Table 9.5 HSC Output Functions Register Map 

Register  Description 

%AQ451 – 452 Duty Cycle (PWM1) 

%AQ461 – 462 Duty Cycle (PWM2) 

   

%AQ453 – 454 Frequency (PWM1) 

%AQ463 – 464 Frequency (PWM2) 

   

%AQ451 – 452 Start Frequency (Stepper1) 

%AQ453 – 454 Run Frequency (Stepper1) 

%AQ455 – 456 Acceleration Count (Stepper1) 

%AQ457 – 458 Run Count(Stepper1) 

%AQ459 – 460 Deceleration Count (Stepper1) 

%AQ461 – 462 Start Frequency (Stepper2) 

%AQ463 – 464 Run Frequency (Stepper2) 

%AQ465 – 466 Acceleration Count (Stepper2) 

%AQ467 – 468 Run Count(Stepper2) 

%AQ469 – 470 Deceleration Count    (Stepper2) 

   

%Q1* Digital Out (Stepper1) 

%Q2* Digital Out (Stepper2) 

   

%I1649 Ready/Done (Stepper1) 

%I1650 Error (Stepper1) 

%  %I1651 Ready/Done (Stepper2) 

%I1652 Error (Stepper2) 

 
*Q30 and Q31 for model 2 using HSQ or HSQ-5 (necessary to start move) 
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9.7 PWM Examples  
 

Example 1 Duty Cycle Frequency 

To get a 50% Duty Cycle @ 10kHz 
waveform on PWM1: 

Set %AQ421-422 = 16,000 Set %AQ423-424 = 10,000 

 

Example 2 Duty Cycle Frequency 

To get a 50% Duty Cycle on PW1 
and 90 % Duty Cycle on PWM2 @ 
1kHz waveform: 

Set %AQ421-422 = 16,000 
 

Set %AQ431-432 = 28,800 
(duty cycle (32000 * 0.9)) 

Set %AQ423-424 = 1,000 
 

Set %AQ433-434 = 1,000 

 

Example 3 Duty Cycle Frequency 

To turn PWM 1 output ON all the 
time 

Set %AQ421-422 = 32,000 Set %AQ423-424 = Any Value 

 

Example 4 Duty Cycle Frequency 

To turn PWM 1 output OFF all the 
time 

Set %AQ421-422 = 0 Set %AQ423-424 = Any Value 

Table 9.6 – PWM Examples 
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9.8 STP Examples  
 

Example 1 Start 
Frequency 

Run 
Frequency 

Accel Count Run Count Decel Count 

10,000,000 
steps 
control 
sequence 

Set %AQ421 = 
2500 (Hz) 

Set %AQ422 = 
5000 (Hz) 

Set %AQ423-4 = 
1,000,000 

(Steps) 

Set %AQ425-6 = 
8,000,000 

(Steps) 

Set %AQ427-8 = 
1,0000,000  

(Steps) 

When the start bit is energized, the example starts at 2.5kHz and ramps up to 5kHz during the first 
1,000,000 steps. Then, it runs at5kHz for the next 8,000,000 steps. Finally, during the last 1,000,000 
steps, it slows to a stop. 

 

Example 2 Start 
Frequency 

Run 
Frequency 

Accel Count Run Count Decel Count 

5,000,000 
steps 
control 
sequence 

Set %AQ421 =  
500 (Hz) 
  

Set %AQ422 = 
1000 (Hz
 ) 

Set %AQ423-4 = 
2,000,000 

(Steps) 

Set %AQ425-6 = 
2,000,000 

(Steps) 

Set %AQ427-8 = 
1,000,000 (Steps) 

When the start bit is energized, the example starts at 0.5kHz and ramps up to 1kHz during the first 
2,000,000 steps. Then, it runs at 1kHz for the next 2,000,000 steps. Finally, during the last 1,000,000 
steps it slows to a stop. 

 

Example 3 Start 
Frequency 

Run 
Frequency 

Accel Count Run Count Decel Count 

6,000,000 
steps 
control 
sequence 

Set %AQ421 =  
50 (Hz)   

Set %AQ422 =  
250 (Hz) 

Set %AQ423-4 = 
150,000 (Steps) 

Set %AQ425-6 = 
5,500,000 

(Steps) 

Set %AQ427-8 = 
350,000 (Steps) 

When the start bit is energized, the following example starts at 50Hz and ramps up to 250Hz during the 
first 150,000 steps. Then, it runs at 250Hz for the next 5,500,000 steps. During the last 350,000 steps, it 
slows to a stop. 

Table 9.7 – STP Examples 
 

 
NOTE: Prior to the start of a move, the Ready/Done bit for that channel must be ON (%I1617 or %I1619 
for Channel 1 and 2 respectfully). The Ready/Done bit will turn OFF during the move, and then back ON 
once the move is completed. 
 
NOTE: The pulse generation hardware on the XL15+ can generate any frequency that can be evenly 
divided into 10MHz (10,000,000Hz) under the maximum recommended frequencies for each model. This 
results in a very smooth operation at lower frequencies, with a progressively choppier operation at 
higher frequencies, as the units reach their maximum recommended frequency.    
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CHAPTER 10: SERIAL COMMUNICATIONS  
 
 

10.1 Overview 
 
XL15+ OCS models provide three independent serial ports on 8-pin modular RJ45 connectors, which are 
labeled MJ1, MJ2, and MJ3. RS-232 or RS485 is available on MJ1. By default, MJ1 can be connected to the 
COM port of a PC running Cscape, for OCS programming. In addition, MJ1, MJ2, and MJ3 can be used for 
application-specific communication, using a variety of standard data exchange protocols. 
 
The next two 8-pin modular RJ45 connectors, which are labeled MJ2 and MJ3, provide a multiplexed serial 
port, which can be configured for either RS232 or RS485. Both MJ2 and MJ3 can be optionally set for OCS 
programming via the System Menu for connection to the COM port of a PC running Cscape. 
 
 

10.2 Port Descriptions 
 
The MJ1 serial port contains a multiplexed serial port, which can be configured for either an RS232 interface 

with RTS/CTS handshaking or a half-duplex RS485 interface. MJ2 and MJ3 serial ports can be configured as 
either RS232 or RS485. The MJ2 and MJ3 RS485 interfaces provide software controlled internal 
termination and biasing resistors. 
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10.3 Wiring 

 
Figure 10.1 – Wiring and Pins 
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10.4 RS485 Termination and Biasing 
 
Proper RS485 termination minimizes signal reflections and improves reliability. 
 
MJ1, MJ2, and MJ3 serial ports allow an internal termination resistor to be placed across pins 1 and 2 by 
software control. 
 
Only the two devices physically located at the endpoints of the RS485 network should be terminated. 
 
RS485 biasing passively asserts a line-idle state when no device is actively transmitting, which is useful for 
multi-drop RS485 networking. 
 
MJ1, MJ2, and MJ3 serial ports allow internal bias resistor to be activated by software control, pulling 
pin 1 up to 3.3V and pulling pin 2 down to ground. 
If biasing is used, it should be enabled in only one of the devices attached to the RS485 network. 
 
The “Set Serial Ports” option in the OCS System Menu can be used for termination and biasing. Also, an 
application graphics screen that writes to %SR can do the same thing. Below are the details: 
 
• For MJ1 termination make high %SR152.3 
• For MJ2 termination make high %SR152.1 
• For MJ3 termination make high %SR152.2 
• For MJ1 biasing make high %SR152.4 
• For MJ2 biasing make high %SR164.1 
• For MJ3 biasing make high %SR164.2 
 
 

10.5 Cscape Programming via Serial Port   
 
The XL15+ OCS MJ1, MJ2, and MJ3 serial ports support CsCAN Programming Protocol. If a PC COM port 
is connected to the XL15+ OCS MJ1, MJ2, or MJ3 serial port, Cscape can access the XL15+ OCS for 
programming and monitoring. Programming can also be done via the CAN port, USB A ports, or 
Ethernet. 
 
 

10.6 Ladder-Controlled Serial Communication  
 
Using Serial Communication function blocks, MJ1, MJ2, and MJ3 serial ports support Generic Modbus 
Master and Modbus Slave Protocols. In addition, external modems can be connected and accessed using 
Modem function blocks. 
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CHAPTER 11: CAN COMMUNICATIONS 
 
NOTE: For additional CAN information, refer to the CAN Networks manual (MAN0799) on the Horner 
websites.   
 

11.1 Overview 
All XL15+ OCS models provide two CAN network ports, which are implemented with 5-pin connectors.   
The connectors are labeled CAN1 and CAN2. 
 
              CAN1                                                                         CAN2 

           
 

Figure 11.1 – CAN1 & CAN2 Connector Locations 
 

The CAN1 port allows the XL15+ OCS to exchange global data with other OCS/RCS controllers and to 
access remote Network I/O devices (SmartStix, Smart Blocks and Smart Rail Modules). 
 
The CAN1 port also supports pass-through communications for programming multiple OCS controllers 
over the CsCAN network. 
 
CAN2 port supports CsCAN, CANopen, J1939, and DeviceNet Master (layer 3 as a selectable option – one 
only). 
 
 

11.2 Port Description 
 
The XL15+ OCS CAN ports implement the ISO 11898-2 physical layer and the CAN 2.0A data link layer 
standards. Also, since the CAN ports are powered by an internal isolated power supply, external CAN 
power is not required. 
 
NOTE: The CAN ports does not supply power to the network.  
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11.3 CAN Port Wiring  
 
 
 
 
 
 
 
 
 

 
Figure 11.2 – CAN1 / 

CAN2 Port Pins 

 

11.4 Cscape Programming via CAN 
 
The CAN1 port supports CsCAN Programming Protocol. If a PC has a CAN interface installed (via PCI card 
or USB), and the PC CAN port is connected to the XL15+ OCS CAN1 port, Cscape can access the XL15+ OCS 
for programming and monitoring. 
 
In addition, the XL15+ OCS supports single-point-programming of all XL15+ OCS and other OCS/RCS 
devices that are connected to the CAN1 port network. If the PC COM port is connected to the XL15+ OCS 
MJ1 serial port, the XL15+ OCS can act as a pass-through gateway allowing Cscape to access all XL15+ OCS 
and OCS/RCS devices that are attached to the CAN1 port network. 
 
 

11.5 Ladder-Controlled CAN Communication  
 
Using Put and Get Network Words function blocks, the CAN 1 port can exchange digital and analog global 
data with other XL15+ OCS or OCS/RCS devices (nodes) attached to the CAN1 port network.  
 
In addition, Put and Get Network Heartbeat function blocks allow nodes on the CAN 1 port network to 
regularly announce their presence and to detect the presence (or absence) of other nodes on the network. 
 
 

11.6 Using CAN for I/O Expansion (Network I/O)  
 
Connecting Network I/O devices (SmartStix, SmartBlock, SmartMod or SmartRail) to the XL15+ OCS CAN1 
or CAN2 port allows the XL15+ OCS I/O to be economically expanded and distributed. A variety of modules 
are available for this purpose. 

CAN1 & CAN2 Port Pins 

Pin Signal Signal Description 

1 V- Power – Black 

2 CN_L CAN Data Low - Blue 

3 SHLD Shield – No color 

4 CN_H CAN Data High - White 

5 V+ Power + - Red 

CAN Connector 
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CHAPTER 12: ETHERNET COMMUNICATION  
 

12.1 Ethernet Overview 
 
The XL15+ controller supports the following: 

1. Downloadable Protocols 
a. Modbus Client 

2. ETN300 Protocols 
a. ICMP (Ping) 
b. EGD 
c. Modbus Slave 
d. Ethernet I/P 
e. FTP 
f. ASCII over TCP/IP 

3. Supports a maximum of 4 WebMI simultaneous connections 
4. Ethernet SmartRail 

 
 

12.2 Ethernet Module Protocols and Features 
The following table describes the Ethernet Module Protocols and features supported by the two Ethernet 
ports on the XL15+. 
 

Table 12.1 – Ethernet Module Protocols & Features 

Protocol / Feature Protocol / Feature Description 

ICMP (Ping) Internet Control Message Protocol 

EGD  Ethernet Global Data 

SRTP Slave (90-30 Service 
Request) 

Service Request Transfer Protocol 

CsCAN TCP Server 
Horner APG CsCAN over Ethernet (for Cscape to OCS 
programming) 

Modbus Slave Modbus over Ethernet 

Ethernet / IP  ODVA CIP over Ethernet 

FTP (File Server) File Transfer Protocol 

ASCII over TCP/IP  ASCII Data over Ethernet 

NTP Protocol Network Time Protocol (Obtain clock from web-based server) 

HTTP (Web Server) Hypertext Transfer Protocol (Web Server) 

 
 

12.3 Ethernet System Requirements  
 
Full Ethernet functionality requires PC running Cscape Programming Software Version 9.8 or later (for 
configuration). 
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12.4 Ethernet Module Specifications 
 

Table 12.2 – Ethernet Module Specifications 

Speeds 
10 BaseT Ethernet (10Mbps) 
100 BaseTx Fast Ethernet (100Mbps) 
1000Mb  

Modes Half or Full Duplex 

Auto-Negotiation Both 10/100-Mbps and Half/Full Duplex 

Connector Type Shielded RJ-45 

Cable Type 
(Recommended) 

CAT5 (or better) UTP 

Port Auto MDI/MDI-X (Auto Crossover) 

 
 

12.5 Ethernet Module Configuration 
 
NOTE: The following configuration is required for all applications regardless of the protocols used. 
Additional configuration procedures must be performed for each protocol used. 
 
To configure the Ethernet Module, use Cscape Programming Software to perform the following steps: 
 

1. On the main Cscape screen, select the Controller menu and its Hardware Configuration sub-
menu to open the Hardware Configuration dialog (Figure 7.1). 

2. If configuring a different OCS Model than the one shown in the Hardware Configuration 
dialog, click on the topmost Config button, select the desired OCS Model, and then click OK.   
 

       
Figure 12.1 – Hardware Configuration Dialog  
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3. Click the Config button to the right of LAN1 for LAN 1 or LAN2 for LAN2, revealing the Ethernet 
Module Configuration dialog as shown in Figure 7.2 

 

 
Figure 12.2 – Ethernet Module Configuration 
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Configure the Ethernet Module parameters as follows: 
 
IP Address: Enter the static IP Address for the Ethernet Module being configured. 
 

NOTE: IP Addresses are entered as four numbers, each ranging from 0 to 255. These four 
numbers are called octets, and they are always separated by decimal points. 

 
Net Mask: Enter the Net Mask (sometimes called Subnet Mask) being used by all nodes on the local 
network. Typical local networks use Class C IP Addresses, in which case the low octet (rightmost 
number) is used to uniquely identify each node on the local network. In this case, the default Net Mask 
value of 255.255.255.0 should be used. 
 
Gateway: Enter the IP Address of a Gateway Server on the local network that allows for communication 
outside of the local network. To prevent the Ethernet Module from communicating outside the local 
network, set the Default Gateway IP Address to 0.0.0.0 (the default setting). 
 
Status Register: Enter an OCS Register reference (such as %R100) to indicate which 16-bit OCS register 
will have the Ethernet Status Word written to it. Table 7.3 shows how this register value is formatted and 
explains the meaning of each bit in the Status Word.  
 

 

Ethernet Status Word Register Format 

High Byte Low Byte 

Bit 
16 

Bit 
15 

Bit 
14 

Bit 
13 

Bit 
12 

Bit 
11 

Bit 
10 

Bit 
9 

Bit 
8 

Bit 
7 

Bit 
6 

Bit 
5 

Bit 
4 

Bit 
3 

Bit 
2 

Bit 1 

0 0 Dup Spd 0 Rx Tx Link TCP Connections 

Status Bit(s) Status Indication 
Status Values 

Minimum Maximum 

0 Reserved Always 0 

Dup Link Duplex (Auto-Negotiated) 
0 = Half 
Duplex 

1 = Full Duplex 

Spd Link Speed (Auto-Negotiated) 0 = 10MHz 1 = 100/1000MHz 

Rx Receive State 0 = Inactive 1 = Active 

Tx Transmit State 0 = Inactive 1 = Active 

Link Link State 0 = Down 1 = Up 

TCP Connections 
Total Number of Active TCP Connections 
(CsCAN, SRTP, Modbus, EIP, FTP, HTTP) 

0 40 

Table 12.3 – Ethernet Status Word Register Format 
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Version Register: Enter an OCS register reference (such as %R101) to indicate which 16-bit OCS register 
will have the Ethernet Firmware Version written to it, with two implied decimal points. For example, for 
Ethernet Firmware Version 4.30, the Version register will contain 430. 
 
Get Settings From: 
“Get settings from” allows the programmer to either configure the IP Address, Net Mask, or Gateway for 
two functions: Configuration or Register. 
 
Configuration – The configuration for the IP Address, Net Mask, or the Gateway will be assigned using the 
value in the Default Settings in this window. The System Menu can temporarily override the Configuration 
option, but only until the next power cycle or Run to Stop transition. At that point, these parameters will 
revert to their configured values. 
 
Register – The configuration for the IP Address, Net Mask, or the Gateway will be assigned using the values 
in the registers assigned. The System Menu cannot override these parameters when this mode is selected.   
 
NOTE: The low octet of the IP Address can be replaced with the unit’s CAN Network ID, by checking the 
Use CAN ID for last Octet checkbox. 
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12.5 Ethernet Configuration – IP Parameters 
 

For primary operation, the IP address, Net Mask, and Gateway should be set in the LAN config of the 
Cscape Hardware Configuration. There are options to get IP parameters from the LAN Config or to get 
parameters from registers. It is possible to set the Ethernet IP parameters from the OCS System Menu, 
but only as a temporary measure. The following points on IP parameter configuration should be 
considered. 
 

• IP Parameters in Non-Volatile RAM: The IP parameters of the Cscape LAN Config are written to 
non-volatile RAM on power down. IP parameter settings made in the System Menu are not 
written to non-volatile RAM. Any IP parameters settings made in the System Menu will be lost 
after cycling power to the unit. It will revert back to the last downloaded Cscape LAN Config that 
was loaded into non-volatile RAM at power down. 
 

• “Cscape LAN Config”/ “Get Settings from” Configuration: When ‘Get settings from’ is set to 
Configuration, the IP parameters specified under ‘Default Settings’ is used after downloading to 
the controller. The IP parameters are represented in System Menu / Set Networks and can be 
edited. However, any edits made from System Menu / Set Networks is not retained through a 
power cycle. After power cycle, the unit reverts to the last downloaded Cscape LAN Config that 
was loaded into non-volatile RAM at power down. 
 

• “Cscape LAN Config” / “Get Settings from” Register: When ‘Get settings from’ is set to Register, 
the IP parameters are retrieved from the OCS registers assigned in LAN Config. Configured 
registers must be populated with the desired IP parameters. 
The IP parameters are represented in System Menu / Set Networks. 
The IP parameters cannot be edited from System Menu / Set Networks while the unit is in run 
mode. 
The IP parameters always follow the values in the registers unless the OCS unit is placed in idle 
mode. Then the IP parameters can be edited in System Menu / Set Networks. When the OCS is 
placed back into run mode, it reverts to the registers for IP parameters. 

 
 

12.6 Ethernet Module Protocol Configuration  
 
The Protocol Support area contains a list of all the protocols supported by the platform being 
configured. To activate a protocol, check its checkbox. 
 
For protocols that require additional configuration, click on a listed protocol to select it and then click 
the Configure Selected Protocol button. This will open a new dialog with configuration options for the 
selected protocol. 
 
For detailed information on individual protocol configuration refer latest version of ETN 300 Manual 
SUP0740.  
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CHAPTER 13: DOWNLOADABLE COMMUNICATION PROTOCOLS 
 

13.1 Overview  

Through loadable protocol device drivers, certain models of the OCS family can provide the ability to 
exchange data with remote devices such as variable-frequency drives, PLCs, and remote I/O 
devices. This feature greatly expands the OCS ’s control capability with negligible effect on the OCS ’s 
ladder scan time. 
  
Remote devices that communicate serially must do so under certain rules of data transfer known as a 
protocol. Many device manufactures have created their own protocol for communications with their 
device. For an OCS to communicate with a specific device, it must be loaded with the corresponding 
serial communications protocol device driver that supports that protocol.  
  
A limited number of protocol device drivers are packaged with the Cscape distribution; however, as 
more are developed, they will be made available as add-on packages. A device driver is typically 
distributed as a Windows module, which contains the Configuration Menus, Help Files and the Target 
Executable Driver Code. When updating device drivers, an install routine loads the device driver to the 
Cscape directory structure and makes that driver available to Cscape applications. 
  
Once installed, the protocol device driver can be included as part of a Cscape application by selecting it 
from a list of installed protocol device drivers and attaching it to the desired serial port (Program > 
Protocol Config menu). Only one protocol device driver can be associated with a serial port, though 
some OCS models support multiple protocols on a single Ethernet port. 
  
Once the protocol is selected for a specific port, that port must be configured to match the bit transfer 
size and rate of the target device(s). This is configured under the Network Config menu, which contains 
port specific information such as the basic serial port parameters (i.e. baud rate, stop bits parity, retries, 
etc.). In addition to the serial port parameters, this menu also contains the transaction scan update 
control configuration and any network level protocol specific configuration. 
 
Once the network is configured, each device on the serial communications network must be configured. 
For some communications (i.e. RS232), the network can be limited to one device. The devices are 
configured under the Device Config menu, which contains an arbitrary device name, the device ID and 
optionally an OCS status register that contains any device fault information. 
  
Once each device(s) is configured, a Scan List of entries must be created which defines the transfer of 
data between a local (OCS) register(s) and a remote device register(s). These entries are created under 
the Data Mapping menu, which contains an OCS register, a target device ID, a target device register 
address, the number of registers to transfer, and update type.  
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Each entry can be configured for one of two types of initiating a transaction: Polled and Triggered. 
Polled type entries initiate a transaction with the remote device on every transaction scan. Triggered 
type entries only initiate a transaction when a corresponding local (OCS) binary trigger register is set. 
Once a triggered type transaction completes, the protocol device driver resets the local (OCS) binary 
register to indicate completion.  Refer to the Scan List section for more details on Polled and Triggered 
entries.  
 
These basic types are also subdivided into Read or Write operations. For polled operations, a Read 
operation only reads from a remote device. Likewise, a Read/Write operation continuously reads from 
the remote device unless the target OCS register value changes from one ladder scan to another. In this 
case, the new OCS value is written to the target device. For triggered operations, only a Read or Write 
action is available. 
 
When downloaded to the OCS, the Scan List is scanned sequentially to generate data transactions with 
the remote device. This transaction scanning can be on a continual basis (automatic) or controlled from 
ladder logic (manual) once a complex connection is programmatically created (i.e., dialup modem). The 
specific transaction-scanning mode is selected from the Network Config menu. 
 
The following Horner Automation websites offer OCS Protocol Software Downloads. 
North America  http://hornerautomation.com/support-files/ 
Europe   https://www.hornerautomation.eu/product-category/software/connectivity-software/ 

Please refer to the Cscape Help file for more information on Downloadable Protocols Configuration. 
After opening the Cscape Help file, select Contents → Networking and Communications → Protocol 
Configuration.  
 
 

  

http://hornerautomation.com/support-files/
https://www.hornerautomation.eu/product-category/software/connectivity-software/
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13.2 Protocol Config 

After opening Cscape, choose Program → Protocol Config, and select the port drop-down box to select 
a protocol device driver. All protocol device drivers currently loaded in Cscape are displayed in the 
dropdown selection. Some OCS models can be limited in the number of ports or number of protocol 
device drivers that can be selected. Once a protocol is selected, the Network, Devices, and Data (Scan 
List) must be configured through corresponding dialogs accessible through the respective buttons 
(Network, Device, and Scan List.)  
 

 

Figure 13.1 – Protocol Config Dialog  

 
 
Three fields must be configured after a protocol is selected:  

1. Network 

2. Devices 

3. Scan List 
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13.3 Network Configuration 
 

 
 
Network Configuration provides the required parameters to configure the network. Each 
protocol is different and may not require all the Network Config field. Please refer to the table 
below for the options in the Network Config field.  
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Table 13.1 – Network Protocols  
Baud Rate, Data Bits, Stop Bits, 
Parity 

These field define the bit level transfer over the serial port.  

 
Handshake 

None – No handshake lines are used 
Multidrop Full – Rx remains active while Tx is occurring.  
Multidrop Half – Rx is shut off while Tx is occurring.  
Radio Modem – Wait for CTS acknowledgement before transmitting 
(legacy radio modem support).  

Protocol If a driver supports multiple protocols, it is selected here, (i.e. Modbus 
supports RTU or ANSI). 

Mode Specifies if port operates in RS232 or RS485 mode. 

Retries Specifies number of times a transaction is retried on a failed response.  

Timeout Specifies the amount of time for a device to wait for a valid response.  

 
 
 
 
Update Scan 

 
 
Automatic 
 

Update Interval – Specifies the update interval at which all 
the mapped entries are executed.  

Reacquire Time – Specifies the amount of time to wait 
before attempting communications with an offline device.  

 
 
Manual 

Trigger – Specifies the binary register that a single 
transaction scan of the Scan List.  
 

ID Select – If an analog is specified in the field, the ID 
Select filter is enabled.  

Status Register Specifies the starting OCS register of eight (8) consecutive registers (4-
32bit counters), which provide an indication of the network health.  

Scanner Address Specifies the OCS’s device (network) ID if a master ID is required by the 
protocol. 

Protocol Help Provides protocol specific help.  
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13.4 Device List and Device Configuration  
 
Device List 

 
 
The Device List is reached from the Device button on the Protocol Config screen and provides a list of 
the configured devices on the Network. Devices must be created and exist in this list before 
corresponding Scan List entries can be created for this device. Typically, the number of entries is limited 
to 64 devices.  
 
 
 

Device Configuration  
 

 
 
This configuration is reached from the Device List when adding or modifying an existing device.   
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13.5 Scan List  
 

 
 
This can be accessed from the Scan List button on the Protocol Config screen or the Mapping button on 
the Device List screen and provides a Scan List of the Data Mapping entries. To transfer data between 
the OCS and remote target, a Scan List must be created that defines each transaction. Each mapping 
entry (transaction) contains the source and destination registers, the number of consecutive registers 
transferred, the direction of the transfer and what triggers the transfer. Typically, the number of entries 
is limited to 512.   

 
NOTE: The order of the Scan List is the order in which the transactions occur. Sort functions are provided 
to change the order of the list. Each entry also has an identifying index. If the device status register is 
enabled and a transaction failure occurs, the status register indicates the index number of the 
transaction that has failed.  
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13.6 Data Mapping Configuration (Scan List Entry) 

 
 
Update Type 
This field specifies the direction and what triggers the transfer of data between the OCS and target 
device for a mapping entry. 

  
Polled Read 
On every transaction scan, a read-only target device register(s) transaction occurs. 

  
Polled Read/Write  
On every transaction scan, a read target device register transaction occurs unless a local register value 
has changed. The write transaction only updates those local registers that have changed in value. If 
several non-consecutive local registers (contained in a single mapping entry) change value between 
transaction scans, it takes several consecutive transaction scans to write each changed register. 
  
When the OCS is placed in RUN mode, the initial action for this mapping type is a read target register 
transaction. This transaction initializes the local (OCS) register(s) to match that of the remote device 
register(s). Thereafter, any change to the corresponding OCS register(s) triggers a write operation to the 
remote device. 
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Polled Read/Write/Init  
 
On every transaction scan, a read target device register transaction occurs unless a local register value 
has changed. The write transaction only updates those local registers that have changed in value. If 
several non-consecutive local registers (contained in a single mapping entry) change value between 
transaction scans, it takes several consecutive scans to write each changed register. 
  
When the OCS is placed in RUN mode, the initial action for this mapping type is a write target register 
transaction. This transaction initializes the target device register(s) to match that of the local (OCS) 
register(s). Thereafter, any change to the corresponding OCS register(s) triggers a write operation to the 
remote device. 
  
The initial write transaction does not occur until after the first logic scan of the OCS. This allows registers 
to be initialized locally before Writing to the target device register(s). 

  
 
Triggered Read  
 
A read transaction is triggered by a high level on a separately designated OCS (binary) trigger 
register. Once the read transaction is complete (or the device is offline), the OCS trigger register is 
cleared by the OCS. This update type can be used for occasion data accesses such as retrieving trend 
data.  
 
NOTE: This operation increases the associated transaction scan time and can cause the Update Interval 
Exceeded Counter to increment on a tightly adjusted update interval. 

  
 
Triggered Write  
 
A write transaction is triggered by a high level on a separately designated OCS (binary) trigger register. 
Once the write transaction is complete (or the device is offline), the OCS trigger register is cleared by 
OCS. This function can be used for occasion data accesses such as sending recipe data. 
 
NOTE: This operation increases the associated transaction scan time and can cause the Update Interval 
Time Exceeded Counter to increment on a tightly adjusted update interval. 
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CHAPTER 14: USER INTERFACE 
 

14.1 Overview 
This chapter presents the user interface (or operator view) of the XL15+ and some of the model specific 
characteristics of the XL15+ as compared to the rest of the OCS line. This chapter does NOT cover building 
screens or using the Cscape graphics editor. For instructions on creating screens and using the graphics 
editor, refer to the Graphics Editor Help File in Cscape. 
 
 

14.2 Screen Specifications 
 

Display Type 15” VGA TFT (500 cd/m² nit typical) 

Resolution 1024x768 

Color 24-bit (16,777,216) 

Screen Memory 4GB 

User-Programmable Screens 1023 

Backlight LED – 50,000-hour life 

 
 
 

14.2 Displaying and Entering Data 
 

 
Figure 14.1 – Example Screen 
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Multiple objects are provided for displaying data such as virtual panel lights, push buttons, numeric value 
displays, bar graphs, meters, graphs, and animated bitmaps. On the XL15+, these graphical objects (through 
ladder manipulation of attribute bits) can change color, flash, or change visibility to attract operator 
attention. 
 
On objects that accept user input, the input is provided by touching the object or alternately changing an 
OCS register (i.e. function key registers). Objects that allow input generally have a raised 3D appearance. An 
exception is the binary type objects, such as buttons, which are shown in a depressed 3D appearance when 
in the ON state.  Objects that normally accept touch input may be disabled through program control 
(through ladder manipulation of an attribute bit). If an object is disabled, the object’s representation 
changes to a 2D appearance.   
 
On objects that represent non-discrete information, more action may be required beyond that of simply 
touching the object. For example, the slider object requires the operator to touch and slide the control in 
the direction desired. Alternately, alpha-numeric entry objects invoke a pop-up alpha-numeric keypad for 
additional user input. The alpha-numeric keypad is discussed below. 
 
NOTE: If the numeric entry object displays >>>>>>>, the value is too big to display in the field or is above the 
maximum for an editable field. Likewise, if the numeric entry object displays <<<<<<< in a numeric field, the 
value is too small to display or is below the minimum for an editable field. 
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14.3 Alpha-Numeric Keypad 
 
To allow entry of a specific number or text, several of the input objects invoke a pop-up alpha-numeric 
keypad when the object is touched. An example of the alpha-numeric keypad invoked from a numeric input 
object is shown in Figure 13.2. Once invoked, the operator may touch the appropriate keys to enter a 
specific value. When entering a value, the alpha-numeric keypad is in one of two modes [new-value or edit-
value]. 
 
New-Value Mode 
Generally, when the alpha-numeric keypad is first invoked, it is placed in new-value mode. Initially, the 
alpha-numeric keypad displays the current value with all the digits being highlighted. Once the first digit is 
entered, the current value is erased from the display and the new digit is placed in the first location.  
Thereafter, no digits are highlighted, and new digits are added to the rightmost position while the other 
digits are shifted left. 
 
Edit-Value Mode 
Edit-value mode may be entered from the initial new-value mode by pressing either the left or right arrow 
key before any digit key is pressed. The result will be a single character highlighted. The user may then 
either touch a key to change the digit at the selected position or the up and down arrows may be used to 
add or subtract (respectively) from the selected digit. The user may then use the left or right arrow keys to 
select a new position. 
 

    
Figure 14.1 – Alpha-numeric Keypad and ASCII Keypad 

 
Once the desired value is entered, pressing the Enter key moves that value into the object (and the 
corresponding OCS register) and the alpha-numeric keypad disappears. Alternately, pressing the ESC key 
any time before the Enter key cancels the operation, leaves the objects current value unchanged, and the 
alpha-numeric keypad disappears. 
 
NOTE: Each numeric entry object has a configured minimum and maximum value. If the operator enters 
a value outside of the configured range, the new value is ignored when Enter is pressed, and the current 
object value is NOT changed. 
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Since the alpha-numeric keypad services several different graphical objects, certain keys on the alpha-
numeric keypad may be disabled (grayed) when the keypad is invoked for certain objects. The following 
describes the alpha-numeric keypad variation based on object. 
 

Table 14.1 – Alpha-Numeric Keypad Object 

Numeric Object When editing a numeric value, the [+/-] or the [.] key are disabled (grayed) if the 
object is NOT configured for floating-point value or a signed value. 

Password Object When editing a password value, the arrow keys, [+/-], and the [.] keys are 
disabled.  Additionally, overwrite mode is disabled. When entering digits, the 
pop-up keypad hides the value by displaying ‘*’ alternately for each digit. 

ASCII Object When editing an ASCII value, an ASCII keypad is displayed as shown figure 13.2. 
The ASCII keypad has three modes, numeric, symbols, and alpha. In Alpha mode 
the Caps Lock button may be pressed to access capital letters. When you first 
enter this editor, typing a character will overwrite the entire old string and start 
a new entry. You may press the back space arrow to delete the previous 
character. Pressing Enter will save the entry; pressing ESC will cancel the edit and 
return the string to the previous value. 

Text Table Object When editing a Text Table Object, all the keys except the Up and Down arrow 
keys are grayed and disabled. The next text selection is made by pressing either 
the Up or Down arrow. 

Time/Date Object When editing a Time/Date Table Object, all the keys except the Up, Down, Left, 
and Right arrow keys are grayed and disabled. The specific field (i.e. hour or 
minutes) is selected using the Left and Right arrows. The value in the selected 
field is changed by pressing either the Up or Down arrow. 
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14.4 Screen Navigation 
 
To allow the operator to change screens, a screen jump object is generally used. This object may be 
visually represented as a 3-D button (responding to touch) or remain invisible and logically tied to an OCS 
register. An optional system ICON may be configured for display along with the legend, which aids in 
identifying the object as one that causes a screen change (shown below in Figure 13.3). 
 
Screen jumps can also be triggered on other keys or based on control logic for more advanced 
applications. To allow the operator to change screens, a screen jump object is generally used.  This 
object may be visually represented as a button (responding to touch) or remain invisible and logically 
tied to an OCS register. An optional system ICON may be configured for display along with the legend, 
which aids in identifying the object as one that causes a screen change. 
 

 
Screen Jump Object 

 
 
 
 
 
 
 
 
 
 
 

 
Figure 14.3 – Typical Screen Jump Object 
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14.5 Ladder-Based Screen Navigation  
 
Ladder logic can use several techniques to control screen navigation. Coils can be tied to %D registers to 
make them screen coils. These coils have two modes: switch and alarm. If the ladder program energizes 
an alarm display coil, the screen associated with this coil is displayed and overrides the normal user 
screens. This is designed to show alarm conditions or to display other ladder-detected events. When the 
text coil is de-energized, the previous screen that was being viewed before the alarm is returned.  
 
The switch display coil switches to the associated screen when it is energized. Once it is de-energized, the 
screen remains until it is switched by the user or ladder. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14.4 – Force and Switch Coils in Ladder Programming 
 

There is also a system register that can be used to for control-based screen navigation. %SR1 can be read 
to determine the current screen or written to change the current screen.   
 
Refer to the on-line help in Cscape for more information on control-based screen navigation. 
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14.6 Beeper Acknowledgement 
 
The XL15+ contains an internal beeper that provides an audible acknowledgment when an operator 
touches a graphic object that accepts touch input. When the graphic object is enabled, a short 5ms tone 
is emitted.  When the graphic object is disabled, a longer 100ms tone is emitted to enounce that graphical 
object is not currently accepting the touch input. 
 
If beep acknowledgement is not desired, the beeper function can be disabled from the System Menu.   
 
 

14.7 Touch (Slip) Sensitivity 
 
Touch slip sensitivity is preset to meet most applications; however, adjustment is available to reduce the 
sensitivity for touch release. That is, once a graphical object (button) is touched and held by a finger, the 
default touch slip sensitivity allows for a slight slip of the finger on the graphical object before the XL15+ 
assumes touch has been released (equates to approximately a quarter inch of movement with a stylus).   
 
In some applications (such as jog buttons) where the operator is pushing a button for a period of time, 
the amount of slip while holding a button pressed may exceed the default sensitivity. To increase the 
amount of tolerable slip and prevent false releases of the button, the XL15+ allows adjustment of the 
allowable slide up to 5x the default value. 
 
To enable the touch (slip) sensitivity, first an OCS data register must be allocated through the Graphics 
editor Configuration menu for Display Settings. Once a Touch Sensitivity register is assigned, that register 
may be modified [range = 1 (Low) to 5 (High)] to the desired slide amount. If a value outside the valid 
range is entered in the touch sensitivity register, it is ignored, and the last valid value is used. 
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14.8 Alarms 
 

Alarm Object 
 
Alarm presentation to the operator is highly configurable and beyond the scope of this document to 
describe fully. For more information refer to the graphics editor help file. This section presents a typical 
configuration thereby providing an introductory description on what the operator should expect. 
 
The alarm object is generally used to enunciate alarms to the operator. While the display characteristics 
of this object is configurable, it is generally displayed as a button that changes colors to indicate the 
highest state of the alarm(s) in the alarm group it is monitoring. The following indicates the priority of the 
alarm states and the default colors associated with these states. 
 

Highest (Red) Unacknowledged Alarms Exist  

— (Yellow) Acknowledged Alarms Exist 

Lowest (Green) No Alarms Exist 

 

 
Figure 14.5 – Alarm Object 
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Alarm Viewer 
 
To view, acknowledge and/or clear alarms, the operator must access the alarm viewer. This is 
accomplished by touching an (enabled) alarm object. When accessed, the alarm viewer is displayed as 
pop-up alarm viewer dialog similar to that shown in Figure 13.6.   
 
 

 
Figure 14.6 – Alarm Viewer 

 
The currently selected entry is indicated by a yellow highlight which can be moved up or down by touching 
the arrow buttons or by directly touching an entry. If more entries exist than can fit on the page, a scroll 
bar is displayed on the right side that also indicates the current relative position.   
 
The current state of the displayed alarm is indicated by its color and optionally by an abbreviated indicator 
after the date/time stamp (ALM, ACK, RTN). The operator can acknowledge an alarm by selecting it from 
the list and touching the ACK button. The operator can also clear an alarm if that function is enabled in 
the alarm object. If not enabled, the Clear buttons are grayed and do not respond to touch. Once view 
operations are complete, simply touch the Esc button to remove the pop-up alarm viewer. 
 
NOTE: OCS register %SR181 is reserved for unacknowledged alarms, and %SR182 is available for ladder 
use, which indicate presence of unacknowledged or acknowledged alarm (respectively) active alarms. 
The screen designer may implement these registers to switch screens or activate the beeper to attract 
the operator’s attention. 
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14.9 Removable Media 
 
Removable Media Object 
 
The Removable Media object is generally used to inform the operator on the current state of the 
Removable Media device and allow access to its file structure. The Removable Media object is displayed 
as a button that changes colors to indicate the current state of the Removable Media device. The following 
indicates the device states and the default colors associated with these states. 
 

Highest (Red) Device Error  

— (Yellow) Device Full (threshold adjustable) 

Lowest (Green) Device OK 

 

 
Figure 14.7 – Removable Media Object 

 
To view and perform file operations, the operator must access the removable viewer. This is 
accomplished by either touching an (enabled) Removable Media object or through the System Menu. 
When accessed, the Removable Media viewer is displayed as pop-up Removable Media dialog similar to 
that shown in Figure 13.8.   
 
NOTE: The Removable Media object can be configured to open the Removable Media viewer at a certain 
directory complete with restrictions on transversing back up the file path. This may be used to restrict 
operator access to non-critical files. 
 
  



  MAN1106-08.3-EN_XL15+_UM 

O c t o b e r  2 1 ,  2 0 2 1      P a g e  140 | 194 

Removable Media Viewer 
 

 
Figure 14.8 – Removable Media Viewer 

 
The currently selected entry is indicated by a yellow highlight which can be moved up or down by 
touching the arrow buttons or by directly touching an entry. If more entries exist than can fit on the 
page, a scroll bar is displayed on the right side that also indicates the current relative position.   
 
File operations are accomplished by pressing the appropriate button at the bottom of the Removable 
Media viewer. The configuration of the Removable Media object that invokes the Removable Media 
viewer defines what buttons are enabled and available to the user. A button is grayed and does not 
respond to touch if configured as disabled. 
 
The       (Enter) button (if enabled) performs certain operations based on the selected file’s type: 
 

..  change display to parent directory 

<DIR>  change display to child directory 

bmp, jpeg display bitmap (if compatible format) 

pgm  load application (if compatible model and version) 

 
Alternately, the (enter) button can be configured to simply load the ASCII representation of the file path 
(including the file name) to a group of OCS registers. That pathname can then be used by ladder for 
opening and manipulating that file. 
 
Once view operations are complete, simply touch the Esc button to remove the pop-up Removable 
Media viewer. 
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Safe Removal of Removable Media 
 
If the Removable Media is used in an application, the Removable Media device requires changing by the 
operator, and the application is attempting to write to the Removable Media when it is removed, the 
screen designer should create objects that allow the operator to temporally halt access to the 
Removable Media. This prevents corruption to the file system if the Removable Media is removed 
during a file write sequence. The graphic objects should set OCS register %SR174.1 (when requesting the 
card be removed) and provide an indicator based on OCS register %SR174.2 (which indicates that it is 
safe to remove the Removable Media). 
 
 

 
Figure 14.9 –Safe Removal of Removable Media 
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14.10 Screen Saver 
 
The XL15+ screen backlight life is typically five (5) years when in continuous use. If the application does 
not require interaction with the XL15+ for long periods of time, the backlight life can be extended by 
using the screen saver function. When enabled through the System Menu, the backlight is shut off 
(screen goes black) after a specified time of no-touch activity on the screen. When the screen saver 
shuts off the backlight, any operator touch on the screen or reactivates the backlight.   
 
NOTE: When the screen saver is active (backlight shut off), any initial touch activity on the screen to 
reactivate the backlight is otherwise ignored by the XL15+. Any additional touch activity is also ignored 
by the XL15+ for approximately one second thereafter.   
 
It is possible for the application to temporarily disable the screen saver by generating a positive 
transition to %SR57.16 (coil only) at a rate faster than the screen saver timeout value. This may be 
desired while waiting for alarm acknowledgement. 
 
 

14.11 Screen Brightness 
 
The XL15+ provides a feature that allows screen dimming for night operation. To enable this feature, the 
application must access and control system register %SR57 (Display Backlight Brightness). Screen 
brightness is continuously variable by driving %SR57 through the range of 100 (full bright) to 0 (full off).  
It is left to the screen designer on how to present a Screen Brightness control to the user, if required. 
 
NOTE: The backlight life can be extended by dimming or powering off the backlight.  
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14.12 Touch Screen Pressure 
 
The Horner XL series OCS controllers have a resistive touch screen that allows mechanically detecting 
touch events. The resistive touch screen works by measuring the resistance between two layers of 
conductive film. 
 
The following are required for this feature: 
 
Minimum Firmware Version: 15.xx or later 
Minimum OS Version: 2.6.35.49 
Minimum Cscape Version: 9.80 SP1 

 
Figure 14.10 – Touch Screen Pressure 

 
NOTE:  Touch creates contact between resistive circuit layers, closing a switch.  
 
With a unique change to the touch monitoring firmware user can measure the pressure being exerted 
on the touch screen. This feature has been added in some Horner XL series controllers. This allows the 
OCS programmer to be notified of the touch pressure and it can configure the pressure required to 
accept a touch event. 
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There are two system registers that provide this touch feature: 
 
%SR9 (I/O Name - TCH_PRESSURE) 

Records the highest pressure level of the last touch on the screen that exceeds the threshold 
value set in %SR10. This is a range of 0 to 3000. Zero (0) indicates no pressure and 3000 is the 
maximum amount of pressure that can be measured. 
 

%SR10 (I/O Name - TCH_PRESSURE_TSH) 
This register sets the pressure threshold to indicate a touch. A value of 200 is typically the 
lightest touch, 600 is moderate and 1000+ is a heavy touch. 
 

These new features allow customizing the feel of the touch screen and can be used to add unique user 
interface features such as having different operations depending on the force of the touch. 
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CHAPTER 15: AUDIO PLAYBACK CONFIGURATION 
 

15.1 Audio Configuration in Cscape 
 
1.  In Cscape, select the XL15+ and model number by selecting Controller → Hardware Configuration 
from the toolbar.  Click OK.  
 
2.  Next select Program from the toolbar and then Audio Config.    
 

 
 
The following dialog will open.   
 

 
Figure 15.1 - Audio Config Dialog 
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15.2 Audio Config Details  
 
Triggers – This register is used to play a particular audio by enabling the corresponding big address.  
Status – This register gives the status of the audio files, see table below.  
Status Register – 16 Bits x 2 
 
 

Table 15.1 - 1st and 2nd Status Registers 

 Bit Number Description 

 
1st Status Register 

Bit 1 to Bit 8 Volume Control (0-100) 

Bit 9 Play Control (1=Pause, 0=Play) 

Bits 10-16 Not Used 

 
 
 
 
 

2nd Status Register 

Bit 1 Cannot open ALSA Lib 

Bit 2 Cannot open MP3 Lib 

Bit 3 Audio output device cannot be setup 

Bit 4 Cannot open input Audio Stream 

Bit 5 Memory allocation failed 

Bit 6 Buffer is not free 

Bit 7 Write Fail 

Bit 8 Short Write 

Bit 9 Recover Error 

Bit 10 Filename Error 

Bits 11-16 Not Used 

 
 

15.3 Audio Files 
 
Index – Index of all the audio files will be assigned automatically when audio files are added.  
Audio Target Path – This gives information about the path of the audio file, audio filename, and format 
of the audio files added to the list.  
 

 
  



  MAN1106-08.3-EN_XL15+_UM 

O c t o b e r  2 1 ,  2 0 2 1      P a g e  147 | 194 

Add – Selecting this button display the following window, where an audio filename with full path needs 
to be configure. The Modify and Delete button are also available in the Audio Config dialog.  
 

 
 
 
IMPORTANT: 

1. Audio files are not downloaded from Cscape; they must be present  
2. Only one audio file can be played at a time. If multiple bits are simultaneously triggered, 

only the least significant bit will be acted upon. 
3. Only MP3 and WAV formats are supported.  
4. 256 audio files can be played. 
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CHAPTER 16: VIDEO OBJECT 
 

16.1 Video Object Overview 
 
The Video Object feature allows two options for video type: Stream and Playback.  The Video Object 
trigger is used to start, stop, and pause video, and the System Register provides the status of the video 
object, which supports various resolutions and frames per second.  
 

 
 

 
 

Table 16.1 – Features and Specifications of Video Properties 
 

Streaming Channels 
4 channels supported through USB hub 

1 channel can be viewed at a time 
 

 
Playback Formats  

.mp4 

.mov 

.mpg 

.wmv 

 
 
 
Resolution  

320x240 (QVGA) 

640x480 

720x408 

1024x576 

Variable Size 

FULL SCREEN 

4x3 Aspect Ratio 

16x9 Aspect Ratio 

Frames per Seconds 10, 15, 20, 24, 30 & MAX_FPS  
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16.2 Opening Video Object in Cscape 
 
NOTE: Video Object requires Firmware 14.03 or newer to use with the XL15+ devices. 
 
In Cscape, select the XL15+ and model number by selecting Controller → Hardware Configuration from 
the toolbar.   
 
1. Open the Graphics Editor by selecting the “T” button from the toolbar.  
 

 
 
 
2. In Graphic Editor, select the video button from the toolbar and then click in the grid.   

 

 
 
3.  Click in the grid. 
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4. Then double click on the icon in the middle to open the Video Properties dialog.  
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16.3 Video Properties: Video Type 
 
 

 
 

Figure 16.1 – Configuring Video Type 
 

 
There are two options for video type: Stream and Playback 
 
Stream – This option can be selected to view live video from a web cam. Four channels are supported 
through the USB hub. Only one channel can be viewed at a time. Enter Channel Number directly or 
through registers in the Enter Channel No field.  
 
Playback – This option can be selected to view videos that are stored in Removable Media on the 
controller. Videos present in both A (microSD) and B (USB) drives are supported and can be viewed. 
Supported formats including .mp4, .mov, .mpg, and .wmv, can be played. 
 
Select Playback and enter video name in the Enter Target Path field either directly or through registers.  
 
For example: Test1.mp4 (from microSD) or B:\Test2.mp4 (from USB). Refer to the Video Properties: 
Control section.   
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16.4 Video Properties: Control 
 

 
 

Figure 16.2 – Configuring Control   
 
Trigger 
 
The Video Properties: The video control trigger is used to start, stop and pause video.  
Video trigger is done by bit level addressing. The trigger reserves eight (8) bits and uses the first two (2) 
bits.  
 
NOTE: The least significant bit is Bit 1.  
 
Definitions are as follows:  
 

 

Bit 1 
High = Start 
Low  = Stop 

 

Bit 2 
High = Pause 
Low  = Play 

 
 
System Register 
 
The Video Control System Register provides the status of the Video Object. The status word is 16-bits 
and should be viewed in hexadecimal format.   
 
The status definitions are as follows:  
 

0x0001 Video is currently playing 

0x0002 Video is paused 

0x00010 Channel number cannot be greater than 4 

0x0020 File not present or corrupted 

0x0040 Frame per second not supported or not compatible 
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16.5 Configuring Display Properties 
 

 
Figure 16.3 – Configuring Display Properties   

 
 
 
 
Resolution Options 

320x240 (QVGA) 

640x480 

720x408 

1024x576 

Variable Size 

FULL SCREEN 

4x3 Aspect Ratio 

16x9 Aspect Ratio 

 
Frames per Seconds 

 
10, 15, 20, 24, 30 & MAX_FPS  
 

 
 

16.6 Video Object Performance 
  
1. When Video Object is active, navigating to System Menu or any popup window, causes Video Object 
to be inactive.  
2. Video Object can be made active in both Idle and Run modes. 
3. If actual Frames Per Second of the configured video is different from the one that is configured in 
Cscape, few frames will be missed when video is played.  
 
 

16.7 Web Cameras 
 
If multiple web cameras are directly connected to the XL15+, then only one web cam will be considered. 
If user needs to connect multiple web cams, USB hub needs to be used. A maximum of four channels 
(web cameras) are supported. 
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CHAPTER 17: REMOVABLE MEDIA 
 

17.1 Overview 
All XL15+ OCS models provide a Removable Media slot, labeled Memory Card, which supports standard 
microSD Flash memory cards. microSD cards can be used to save and load applications, to capture 
graphics screens, and to log data for later retrieval. 
 

 
Figure 17.1 – Removable microSD Memory Card Slot 

 
 

17.2 microSD Cards 
When the microSD card format was introduced, it was originally called TransFlash. Cards labeled either 
microSD or TransFlash, with up to 128GB of Flash memory, are compatible with the XL15+ OCS Memory 
slot (larger sizes were not tested at time of publication). The Memory slot is equipped with a “push-in, 
push-out” connector and a microSD card can be safely inserted into the memory card slot whether the 
XL15+ OCS power is On or Off.   
 
To install a microSD card: Align its 8-pin gold edge connector down, facing the front of the XL15+ OCS 
unit; then carefully push it all the way into the Memory Card Slot. Ensure that it clicks into place.    
 
To remove the microSD card: Push in on the top of the card gently to release the spring. The card pops 
out for removal. 
 
 

17.3 microSD File System 
The microSD Memory slot supports SDHC, SDXC IN FAT32 format up to 128GB max. The microSD slot can 
be used for program download (*.pgm), to save the downloaded program (*.pgm), for loading and 
logging data (*.csv), recipes (*.csv), WebMI, and in conjunction with the Fail-Safe feature. Long 
filenames are supported for program download, but when viewed in the System Menu and in the 
Removable Media screen object, the filename is displayed truncated.  
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17.4 Using the Removable Media Manager   
 
The Removable Media Manager is an interactive XL15+ OCS screen that performs the following 
functions: 

a. Display number of total and free K bytes 
b. Browse file and directory lists 
c. Delete files and directories 
d. Format a microSD card 
e. Load and save application programs 
f. View screen capture bitmaps 

 
The Removable Media Manager can be accessed via the System Menu or by using Cscape to place a 
Removable Media Manager object on an application graphics screen. 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 17.2 – Removable Media Submenu 
 
 
 

17.5 Using Removable Media to Log Data 
 
Using Read and Write Removable Media function blocks, an application ladder program can read and 
write XL15+ OCS register data in the form of comma-delimited files, with a .CSV extension. These files 
are compatible with standard database and spreadsheet PC programs. In addition, an application ladder 
program can use Rename and Delete Removable Media function blocks to rename and delete files. 
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17.6 Using Removable Media to Load and Save Applications  
 
A special file type, with a .PGM extension, is used to store XL15+ OCS application programs on microSD. 
 
To load an application from microSD to the XL15+ OCS, use the Removable Media Manager (open the 
Removable Media Manager in the System Menu) to find and highlight the desired .PGM file, and then 

press the Enter key.   
 
To save an application from the XL15+ to microSD, open the Removable Media Manager in the System 

Menu and press the Save Pgm  function key. The application will be saved in a file called 
DEFAULT.PGM in the microSD root directory.   
 
NOTE: Saving an application to microSD can only be done from the Removable Media System 
Menu and is not available on a Removable Media Manager object that was placed on an 
application graphics screen by Cscape. 
 
Cscape can also save an application directly to a microSD card, which is plugged into the PC’s microSD 
compatible card reader by selecting the Export to Removable Media item on the Cscape File menu. 
 
 

17.7 Using Removable Media to View and Capture Screens 
The XL15+ OCS File System uses bitmap files with the .BMP extension or JPEG files with the .JPG 
extension to store XL15+ OCS graphic screen captures. 
 
To view a captured XL15+ OCS screen, use the Removable Media Manager to find and highlight the 

desired .BMP or .JPG file, and then press Enter.  
 
To capture an XL15+ OCS screen, turning On the assigned Screen Capture Control Register will capture 
the current XL15+ OCS graphics screen and write it to the microSD card using the assigned Screen 
Capture Filename. 
 
Before capturing an XL15+ OCS screen, Cscape must first be used to assign a Screen Capture Control 
Register and Filename in the application. To do this, first open the Graphics Editor by selecting the View 
/ Edit Screens item on the Cscape Screens menu. Next, select the Screen Capture item of the Graphics 
Editor Config menu and then enter a Control Register and Filename. 
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17.8 Configuration of a Removable Media  
 
The configuration of the Removable Media Object that loads the Removable Media Viewer defines what 
buttons are enabled and available to the user.  
 
The       (Enter) button performs certain operations based on the selected file’s type: 
 
 ..  - change display to parent directory 
 <DIR>  - change display to child directory 
 pgm  - load application (if compatible model and version) 
 
Alternately, by checking the ‘Write Selected Filename’ option, the RM Manager object will load the 
currently displayed path and filename into a block of registers for use with other Removable Media 
functions. The register block is assigned in the ‘File Select’ config found in the Config menu of the 
graphic/screen editor.   
 
Once view operations are complete, simply touch the Esc button to remove the pop-up Removable 
Media viewer. 
 
 

17.9 Removable Media (RM) Function Blocks in Cscape 
 
NOTE: For detailed information regarding RM function blocks and parameters, refer to the Help file in 
Cscape. Refer ‘USB Flash Media support for RM Functions’ for USB flash drive access details. 
 
The following RM functional blocks are available in Cscape Software. These function blocks will reference 

- microSD when filename is prefixed with ‘A:’ or nothing, OR 
- USB Type-A Flash Drive when filename is prefixed with ‘B:’. 
 

 

Table 17.1 – RM Functional Blocks 

Read RM csv Allows reading of a comma-separated value file from the microSD interface 
into the controller register space. 

Write RM csv Allows writing of a comma-separated value file to the microSD interface from 
the controller register space. 

Rename RM csv Allows renaming a file on the RM card. The data in the file is not changed. 

Delete RM csv Allows deleting a file on the RM card 

Copy RM csv Allows copying a file on the RM card. The data in the file is not changed. 
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17.10 Removable Media (RM) Features—Program Features 

 
a. Datalog Configuration—This feature allows the controller to periodically log register values to 
Removable Media. The register data is stored in .csv (comma separated value) format, which is 
compatible with 3rd party PC applications, such as Microsoft Excel.  
 
b. Report Editor—This feature allows the OCS to be configured to generate text printouts which 
incorporate data from the registers embedded in the text. The reports can be printed using a serial 
interface printer through any of the serial ports of the OCS or can be saved on the Removable Media of 
the device.  
 
c. Recipes Editor—Recipes allow the user to send or update multiple registers simultaneously.  
 
 

17.11 Removable Media (RM) Features—Graphic/Screen Editor 

 
a. Trends—The historic support feature in the trend object utilizes Removable Media.  
 
b. Removable Media—This is a graphic object used to access files and functions pertaining to 
Removable Media. 
 
c. Recipes—This is a graphic object that is used in conjunction with the recipe editor which is mentioned 
above.  
 
 

17.12 Removable Media (RM) Features—Additional Configuration 
 
a. Alarms—Alarm data can be logged to a .csv file stored on Removable Media.  
 
b. Screen Capture—The screen capture function allows a bitmap or jpeg image of the displayed OCS 
screen to be written to the Removable Media card. 
  
c. Filename Counters— The filename counters can be accessed wherever Removable Media functions 
require a path name. A typical application is the auto-incrementing of a file name when doing screen 
captures. 
 
d. File Select— File Select is used to specify the register block that is used with the Removable Media 
Manager object ‘Write Selected Filename’ option. 
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17.13 Filenames used with the Removable Media (RM) Function Blocks 
 
The RM function blocks support the flash with a DOS/Windows standard FAT-16 file system. All names 
must be limited to the “8.3” format where the filename contains eight characters a period then a three-
character extension. The entire filename including any path must be less than or equal to 147 characters. 
 
When creating filenames and directories it is sometimes desirable to include parts of the current date or 
time. There are six special symbols that can be entered into a filename that are replaced by the OCS with 
current time and date information. 
 

Table 17.2 – Filename Special Symbols  

Symbol Description Example 

$Y Substitutes the current 2 digit year 2015 = 15 

$M Substitutes the current month with a 2 digit code March = 03 

$D Substitutes the current day 22nd = 22 

$h Substitutes the current hour in 24 hour format 4 pm = 16 

$m Substitutes the current minute 45 = 45 

$s Substitutes the current second 34 = 34 

 
 
NOTE: All the symbols start with the dollar sign ($) character. Date symbols are in upper case, and time 
symbols are in lower case. The following are examples of the substituted time/date filenames: 
 
 
 

Current date and time = March 1, 2013 3:45:34 PM 

Filename: Data$M$D.csv  = Data0301.csv 

Filename: Year$Y\Month$M\aa$D_$h.csv = Year04\Month03\aa01_15.csv 

Filename: Month_$M\Day_$D\$h_$m_$s.csv = Month_03\Day_01\15_45_34.csv 
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17.14 System Registers used with RM  
 

Table 17.3 – System Registers used with RM 

%SR174 Removable 
Media Protect 

Write a 1 to %SR174 to prohibit read/write access to the Removable 
Media card.  Write a zero (0) to allow access. 

%SR175 Status This shows the current status of the RM interface. 

%SR176 Free Space This 32-bit register shows the free space on the RM card in bytes. 

%SR178 Card Capacity This 32-bit register shows the total card capacity in kilobytes. 

 
 

Possible status values are shown in the table: 
 
 
 
 
 
 
 
 
 
 
 

 
 
For additional status information, consult the Cscape Help File. 
 
 

  

Table 17.4 – RM Status Values 

0 RM interface OK 

1 Card present but unknown format 

2 No card in slot 

3 Card present, but not supported 

4 Card swapped before operation was complete 

5 Unknown error 
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CHAPTER 18: CLONE UNIT 
 

18.1 Overview 
 
‘Clone Unit’ feature allows the user to “clone” the OCS of the exact same model. This feature “clones” 
application program and unit settings stored in Battery backed RAM of an OCS into the RM. Refer to the 
Removable Media Chapter for more details. It can then be used to clone a different OCS (exact same 
model).  
 
This feature can be used for: 
 

- Replacing an OCS by another unit of the same model. 
- Duplicating or “clone” units without a PC. 

 

18.2 Clone 
 
User needs to perform the following to Clone: 
 

1. The ‘Clone Unit’ can be accessed by going to the ‘System Menu’ of the OCS. A new menu “Clone 
Unit” has been added at the end of the main system Menu as shown below: 
 

 
Figure 18.1 – System Menu 
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2. Selecting “Clone Unit” menu will open the following menu screen: 
 

 
Figure 18.2 – Clone Unit Menu before Cloning   

 
Free/Total – displays number of free and total bytes in Removable Media. 
 
 
3. Make/Create Clone option enables user to duplicate / Clone application file, all unit settings and all 

register values from Battery Backed RAM. 
 
Selecting Make Clone brings up the screen below for the user: 
 

 
Figure 18.3 – Clone Unit Confirm Screen 
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After confirmation, the OCS will create two new files in the root directory of the Removable Media Drive 
as shown below: 
 
AUTOLOAD.PGM Application file 
CLONE.DAT  File having all unit settings and register values from Battery Backed RAM 
 

 

Figure 18.4 – Clone Unit Files 
 
 
NOTE: Make/Create clone operation automatically includes the security in \AUTOLOAD.PGM file for 
security enabled files. 
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4. Once the cloning is successful, the OCS gives a message as below: 
 

 
Figure 18.5 – Cloning Status 

 
Make/Create clone can also be triggered by setting %SR164.9 bit to “1” from Ladder program or 
graphics. Once the operation is completed, this bit is made zero by the firmware. When Make Clone 
operation is triggered by this SR bit, it does not ask the user for confirmation for making clone. The 
success / failure of the operation is also not notified on screen to the user.  
 
In case of failure of “Make Clone” operation, %SR164.11 bit is set to “1” by the firmware and never 
reset.  
 
NOTE: Backup of registers in flash memory is not performed by Clone Feature. If user desires, Backup 
should be done as explained in the Fail-Safe System chapter. 
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18.3 Load Clone 
 
This option loads the application, all unit settings and register values from Removable Media to the 
Battery backed RAM (Regardless of AutoLoad settings) and then resets the OCS for the settings to take 
effect. 
 
User needs to perform the following to Load Clone: 
 
1. Select Clone Unit from main System Menu of OCS as shown below: 
 

 
Figure 18.6 – System Menu 

 
2. Selecting Clone Unit menu will open the following menu screen. Select Load Clone. 
 

Figure 18.7 – Clone Unit Menu after Cloning 
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3. User needs to confirm Load Clone as shown below: 
 

 
Figure 18.8 – Load Clone Confirm Screen 

 
4. After confirmation, all unit settings and register values will be loaded from Removable Media to the 

Battery backed RAM (Regardless of AutoLoad settings) and then OCS resets for the settings to take 
effect. 

 
NOTE: For security enabled files, Load Clone asks for password validation before loading the application. 
 
Load Clone can also be triggered by setting %SR164.10 bit to “1” from Ladder program or graphics. Once 
the operation is completed, this bit is made zero by the firmware. When Load Clone operation is triggered 
by this SR bit, it does not ask the user for confirmation for loading clone. The success / failure of the 
operation is also not notified on screen to the user.  
 
In case of failure of Load Clone operation, %SR164.12 bit is set to “1” by the firmware and never reset. 
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CHAPTER 19: FAIL – SAFE SYSTEM 
 

19.1 Overview 
 
The Fail-Safe System is a set of features that allow an application to continue running in the event of 
certain types of "soft" failures.  These "soft" failures include: 
 

• Battery power loss. 

• Battery-Backed Register RAM or Application Flash corruption due to, for example, an 
excessive EMI event. 

 
The Fail-Safe System has the following capabilities: 
  

• Manually backup the current Battery-Backed RAM Register Settings into Flash memory. 

• Manually restore Register Settings from the values previously backed up in Flash to Battery-
Backed RAM. 

• Detect corrupted Register Settings at power-up and then automatically restore them from Flash. 

• Detect corrupted or empty application in Flash memory at power-up and then automatically 
load the AUTOLOAD.PGM application file from Removable Media (Compact Flash or microSD). 

• If an automatic Register Restore or Application Load occurs, the OCS can automatically be 
placed in RUN mode 
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The fail-safe system can be accessed by going to the System Menu of the controller. A new menu “Fail-
Safe System” has been added at the end of the main System Menu for this. Selecting “Fail-Safe System” 
menu will open the following menu screen: 
 

 
Figure 19.1 – Fail–Safe System Menu 

 

 

19.2 Settings 
 
To use the fail – safe feature, the user needs to do the following: 
 

1. From Cscape, create AUTOLOAD.PGM for the application program using ‘Export to Removable 
Media’. 

2. Place the Removable Media with AUTOLOAD.PGM in the device. 
3. Set the ‘Enable AutoLoad’ option in the device to YES. 
4. Set the ‘Enable AutoRun’ option to YES if the controller needs to be placed in RUN mode 

automatically after automatic restore of data or AutoLoad operation. 
5. Backup the current Battery-Backed RAM Register contents in On-Board Flash memory using 

System Menu options. 
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19.3 Backup / Restore Data 
 
Selecting this option brings up a screen having four operations: 

- Backup OCS Data. 
- Restore OCS Data. 
- Clear Backup Data. 
- Exit 

 

 
Figure 19.2 – Backup / Restore Data 

 
 
Backup OCS Data:  
When initiated, this will allow the user to manually copy Battery-Backed RAM contents on to the onboard 
FLASH memory of the OCS. This will have the effect of backing up all the registers and controller settings 
(Network ID, etc.) that would otherwise be lost due to a battery failure.  
%SR164.4 is set to the value of 1 when backup operation is performed. 
 
 

 
Figure 19.3 – Backup Registers 
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Restore OCS Data:  
When initiated, this will allow the user to manually copy the backed up data from the onboard FLASH to 
the Battery-Backed RAM. 
 
A restore operation will be automatically initiated if a backup has been previously created and on power-
up the Battery-Backed RAM registers fail their check.   
 
The following process will be followed for restoring data: 

- The controller will be placed in IDLE mode. 
- Data will be copied from onboard FLASH to OCS Battery-Backed RAM 
- The controller will reset.  
- The controller will be put in RUN mode if the AutoRun setting is ‘Yes’ else it will remain in IDLE 

mode. 

 
Figure 19.4 – Restore OCS Data 

 
%SR164.3 is set to the value of 1 only when an automatic restore operation is performed - not on a manual 
one. This bit is reset to the value of 0 when a new backup is created. 
 

Restoring of data can be manually performed by selecting RESTORE option from the Backup / Restore 

Data menu. This will cause the controller to reset.  
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Clear Backup Data:  
When initiated, the backup data will be erased from the onboard FLASH and no backup will exist. 
%SR164.4 and %SR164.3 is reset to 0 when backed up data is erased. 
 

 
Figure 19.5 – Clear Backup Data 

 
Exit: Goes back to the previous screen.  
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The OCS follows the following sequence in execution of Automatic Restore: 
 

 
 

Figure 19.6 – Flow Chart for Automatic Restore  
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19.4 AutoLoad 
 
This System Menu option allows the user to specify whether the OCS automatically loads the application 
AUTOLOAD.PGM located in Removable Media.   
 
When the AutoLoad setting is enabled (set to YES), it can either be manually initiated or automatically 
initiated at power-up. 
  
The automatic initiation will happen only in the following two cases: 

• When there is no application program in the OCS and a valid AUTOLOAD.PGM is available in the 
Removable Media of the device. 

• When the program residing in onboard memory is corrupted and a valid AUTOLOAD.PGM is 
available in the Removable Media of the device. 

 
AutoLoad can be manually initiated when the SYS-F3 key is pressed (OCS can be in any of the following 
mode – Idle / Run / DOIO). This also requires a valid AUTOLOAD.PGM to be present in the Removable 
Media of the device.   
 
When the AutoLoad setting is not enabled (set to NO), OCS will be in IDLE mode, and the application is 
not loaded. 
 
If the AUTOLOAD.PGM is security enabled, the user will be prompted to enter the password before loading 
the application. The application will be loaded from the Removable Media only after getting the correct 
password.  
 
%SR164.6 can be set to enable AutoLoad feature. 
 

 
Figure 19.7 – AutoLoad Menu  
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The OCS follows the following sequence in execution of AutoLoad: 
 

 
 

Figure 19.8 – Flow Chart for AutoLoad  
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19.5 AutoRun 
 
This system menu option, when enabled (YES), allows the user to automatically place the OCS into RUN 
mode after the AutoLoad operation or automatic Restore Data operation.  
 
When the AutoRun setting is disabled (NO), the OCS remains in the IDLE mode after a Restore Data or 
AutoLoad operation. 
 
%SR164.5 can be set by putting the system into RUN mode automatically, once an AutoLoad has been 
performed or an Automatic Restore has occurred. 
 
If for any reason the AutoLoad-Run (loading the AUTOLOAD.PGM automatically and OCS put in RUN mode) 
sequence does not succeed, a pop-up message box saying "AUTO-LOAD-RUN SEQUENCE FAILED" will be 
displayed. It will also show the reason for its failure. On acknowledging this message box the AutoLoad-Run 
sequence will be terminated, controller will return to the first user-screen and will be placed in IDLE mode. 
 

 
 

Figure 19.9 – AutoRun Menu 
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CHAPTER 20: MODBUS COMMUNICATIONS 
 

20.1 Modbus Overview 
 
For complete Modbus instructions, please refer to the Help file in Cscape.  
 
Modbus (serial) is a popular, de-facto standard protocol that allows industrial devices from multiple 
manufacturers to easily share data in real-time. For Modbus serial communications, the XL15+ can act as 
either a Master or a Slave.  
 
Modbus protocol (serial) allows for one master and multiple slaves. The master always initiates the 
conversation by sending a request to a particular slave. Only the addressed slave will send a response 
when the request is completed. Should the slave be unable to complete the request, it returns the 
appropriate error response. Should the slave be unable to respond, the master’s timeout timer expires 
to provide an indication of No Response.  
 

20.2 Modbus Slave Overview  
 
For complete Modbus Slave instructions, please refer to the Help file in Cscape.  
 
The Modbus slave function block, when used with the appropriate Modem and/or Open function blocks, 
allows the primary serial port on the controller to act as a Modbus slave. The Modbus function supports 
both ASCII and RTU modes of operation across a range of baud rates and protocol frames. Also 
supported is port activity status, an inactivity timer, support for call-on exception, and support for store 
and forward (repeater) operation for radio modems.  
 
The Modbus Addressing section describes the supported Modbus Commands as well as the Modbus 
Map for XL15+ References (%R, %M, etc.).   
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20.3 Modbus Master Overview 
 
For complete Modbus Master instructions, please refer to the Help file in Cscape.  
 
When acting as a Modbus master, there are two primary mechanisms used by the XL15+ to allow the 
user to specify the data to be read/written from/to the slaves. 
 
Modbus Master Function Block—This is for serial only. This is an advanced feature that should only be 
used in rare occasions.   

 
Protocol Config—The Protocol Config is configured in the Hardware Configuration dialog box in Cscape 
(serial) – Refer to the Modbus Addressing section. This is the preferred method in most applications.  
 
After the protocol has been selected from the dropdown menu, the Network, Devices, and Scan List 
become available. The Protocol Config is configured on three different levels: 

• Network—Parameters, such as the polling rate of the data scan, are specified along with 
timeout values, retry, and re-acquisition settings. Serial configuration, baud rate, parity, etc. are 
also set here.  

• Devices—For every slave to be polled, configuration details are added in the Devices dialog box. 
This includes Slave ID (serial). Under Device Type, the Modbus addressing style matching that 
specified in the slave’s user documentation may be selected. For instance, some slaves specify 
Modbus addresses (i.e. 40,001), and others specify offsets (i.e. 0000).   

o Hex or Decimal—Some specify addresses in hex, and others in decimal. By allowing the 
user to select the Modbus addressing style for each slave on the network, minimal 
address conversion is required. Also, if the slave is another Horner product (i.e. another 
OCS), the “Native Addressing” option can be selected (i.e. %R1, %M17, etc.), and this 
skips the conversion to Modbus style altogether. 

• Scan List—This is where the specific Modbus addresses to be read/written from/to each slave 
are specified. Up to 32 words of data can be read at the same time.  
 
NOTE: Once configuration has been completed on the Network and Devices level, Modbus data 
can be directly read/written from graphics objects in the Cscape screen editor. This is available 
even if the Modbus register is not listed on the scan list. 

   
 
The above information is just an introduction to the topic. For more detailed information, please consult 
the Cscape Help file. 
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20.4 Opening Cscape Help File  
 
After opening the Cscape Help file, select the Index table and search for “Modbus Slave” or “Modbus 
Master”, as shown below.  
 
   
 
Select “Index” tab.  
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20.5 Modbus Addressing Table 
 
To access XL15+ registers, a Modbus Master must be configured with the appropriate register type and 
offset. This is usually accomplished with one of two methods: 
 
Method 1:  The first method uses Traditional Modbus References, in which the high digit represents the 
register type and the lower digits represent the register offset (starting with Register 1 for each type). 
Since only four register types can be represented in this manner, XL15+ Modbus Function Blocks pack 
several XL15+ register types into each Modbus register type. Starting addresses of each XL15+ register 
type are shown in the Traditional Modbus Reference column of the Table 20.1.   
 
Method 2: The second method requires the Modbus Master to be configured with a specific Modbus 
Command  and Modbus Offset. The supported Modbus commands and the associated offsets are also 
illustrated in Table 20.1.  
 

Table 20.1 – Modbus Master MappingError! Bookmark not defined. 

XL15+ 
Reference 

Maximum 
Range 

Trad. Modbus 
Ref. 

(5 Digits) 

Expanded 
Modbus Ref. 

(6 Digits) 

Modbus Commands Modbus 
Offset 

%I1 2048 10001 010001  
Read Input Status (2)  

0 

%IG1 256 13001 013001 3000 

%S1 256 14001 014001 4000 

%K1 5 15001 015001 5000 

 

%Q1 2048 00001 000001 Read Coil Status (1) 
Force Coil (5) 
Force Multiple Coils (15) 

0 

%M1 2048 03001 003001 3000 

%T1 2048 06001 006001 6000 

%QG1 256 09001 009001 9000 

 

%AI1 512 30001 030001  
Read Input Register (4) 

0 

%AIG1 32 33001 033001 3000 

%SR1 256 34001 034001 4000 

 

%AQ1 512 40001 040001 Read Holding Register (3) 
Load Register (6) 
Load Multiple Registers (16) 

0 

%R1 2488 40513 040513 512 

%R1 2048 43001 043001 3000 

%AQG1 32 46001 046001 6000 

%R1 9999 -- 410001 10000 
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CHAPTER 21: MAINTENANCE 
 

21.1 Firmware Update Overview 
 
The XL15+ OCS products contain field updatable firmware to allow new features to be added to the 
product at a later time. Firmware updates should only be performed when a new feature or correction is 
required. 
 
 
 
 
 
 
 
 

21.2 How to Check for Current Firmware Revision  
To check the firmware revision on a controller, open System Menu → View Status.   

 
 
 

 
  

Warning: Firmware updates should only be performed when the equipment being controlled by the 
XL15+ OCS is in a safe, non-operational state. Communication or hardware failures during the 
firmware update process can cause the controller to behave erratically resulting in injury or 
equipment damage. Make sure the functions of the equipment work properly after a firmware update 
before returning the device to an operational mode. 



  MAN1106-08.3-EN_XL15+_UM 

O c t o b e r  2 1 ,  2 0 2 1      P a g e  181 | 194 

21.3 Details 
 
 
 
 

 
 
 
There are two methods for updating firmware. The method used depends on the type of controller 
being updated.  
 
Method A: Removable Media Method – The controller firmware is updated by a bootloader, using a 
microSD card or USB Flash drive (not through the Cscape Firmware Update Wizard). To update or 
change firmware: 

1) Download desired Firmware set from the Horner APG website. (Verify CsCAN or CANopen 

communications.) 

2) Save Firmware files to microSD card or USB, these are the removable media devices. 

3) Update the firmware through the controller’s Firmware Update function  

NOTE:  Files from the Horner website come as a .ZIP file which need to be unzipped and placed in the 
root of the drive for them to function properly.  
 
Method B: RS232 Serial Connection – Serial firmware updates are done from Cscape software to the 
controller’s primary serial port, MJ1 in most cases.  
 

STEP ONE:  
In North America, visit https://hornerautomation.com  Then click Support → Downloads 
→Controller Firmware and download the most recent firmware set with the correct 
communication protocol.  
 

-OR- 
 

In Europe, visit http://www.hornerautomation.eu and click Support → Firmware tab and 
download the desired firmware (an account is required to access firmware updates, create one 
if necessary).   

 

  

Note:  Updating firmware will clear the application program, screens, configurations, and register 
data. If required, make sure to backup program and register data before updating firmware. The 
controller’s User Manual has instructions for doing backups.  
 

https://hornerautomation.com/
http://www.hornerautomation.eu/
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21.4 Firmware Update for XL15+ 
 
 
Update firmware in an XL15+ (from Firmware 15.32 onwards) by completing the following steps: 
 

a. Make a bootable SD card for XL15+ controller. (Refer to MAN1150-02-

EN_XL15+_FW_Restore.pdf). Plug removable media (bootable microSD card) into XL15+ 

controller.   

b. Power down the controller.  

c. While pressing the load / boot switch, power up the XL15+ controller. Release the switch.  

d. This starts a firmware load and takes the controller to Boot Installer screen.  

e. Press the Install Bootloader button and then Press YES. 

f. Once operation is completed, “Re-installed the system” message appears. Press OK.  

g. Power-cycle the controller and wait for it to boot up.  
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21.5 Backup Battery  
 
The XL15+ has a battery backup system. It uses a lithium button coin type battery. The battery powers the 
real time clock, registers, and data memory when power is removed.    
 
The battery will generally last seven (7) to ten (10) years. Environmental conditions, including extreme 
temperatures and humidity, can affect battery life. If the battery older than seven (7) to ten (10) years 
old, it is recommended that it be replaced as preventative maintenance. 
 
NOTE: Use only the proper battery type listed.  
 
 

 
WARNING: DO NOT USE IF BATTERY IS LEAKING OR HAS BEEN DAMAGED.  
 
WARNING: LITHIUM BATTERIES MAY EXPLODE OR CATCH FIRE IF MISTREATED.  
DO NOT RECHARGE, DISASSEMBLE, HEAT ABOVE 100° C (212° F) INCINERATE, OR PUNCTURE. 
 
WARNING: EXPLOSION HAZARD – BATTERIES MUST BE ONLY BE CHANGED IN A AREA KNOWN TO BE 
NON-HAZARDOUS.  
 
WARNING: Disposal of lithium batteries must be done in accordance with federal, state, and local 
regulations. Be sure to consult with the appropriate regulatory agencies before disposing batteries. In 
addition, do not recharge, disassemble, heat or incinerate lithium batteries. 
 
WARNING:  Do not make substitutions for the battery. Be sure to only use the authorized part number 
to replace the battery. 
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The XL15+ OCS uses a lithium coin-type battery with, part no. BAT00013, with harness and connector 
available from Horner APG.  
 

Below are the steps to replace the battery:  
 

 
 

1. Make sure the user program and any data stored in retentive memory is backed up. 
2. Disconnect all power from the XL15+ OCS unit including I/O power. 
3. On the back of the XL15+ model, slide off the battery plate cover. 
4. Connect the new battery into the adjacent connector first and then remove the old battery.  
5. Dispose of the old battery properly; see the above warning on disposal regulations. 
6. Slide battery plate cover back on the unit. 
7. Apply power to the unit.  Check that the battery error is no longer reported.  If the unit still reports 

the error, remove the battery immediately and contact Technical Support.  
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CHAPTER 22: TROUBLESHOOTING / TECHNICAL SUPPORT 
 
Chapter 22 provides commonly requested troubleshooting information and checklists for the following 
topics.   

- Connecting to the XL15+ OCS controller 
- Local controller and local I/O 
- CsCAN Network 
- Removable Media 

 
If this information is not enough, please contact Technical Support at the locations indicated at the end 
of this chapter.    
 

22.1 Connecting to the XL15+ OCS 
Cscape connects to the local controller automatically when the serial connection is made. The status bar 
below shows an example of a successful connection. This status bar is located in the bottom right hand 
corner of the Cscape window.  
 
 
 
In general, the Target number should match the Local number. The exception to this is when the controller 
is being used as a "pass through" unit where other controllers on a CsCAN network could be accessed 
through the local controller. 
 
Determine connection status by examining feedback next to Local & Target in the status bar of Cscape. 
 

Table 22.1 – Cscape Target & Local Numbers 

Local: ### If a number shows next to Local then communication is established to the local controller. 

Local: No Port 
Cscape is unable to access the COM port of the PC. This could mean that Cscape is configured for a 
COM port that is not present or that another program has control of the COM port. Only one Cscape 
window can access a port at a time. Subsequent instances of Cscape opened will indicate No Port. 

Local: No Com 
Cscape has accessed a PC COM port, but is not communicating with the controller. This typically occurs 
when the controller is not physically connected. 

Local: ??? 
Unknown communication error. Close Cscape, power cycle the controller and reopen Cscape with a 
blank project. Check Local. 

Target: #(I,R,D) 
If I (idle), R (run), or D (do I/O) shows next to Target number then communication is established to the 
target controller. 

Target: #(?) 
Communication is not established to the target controller. Check node ID of controller and set Target 
to match. Make sure local connection is established. 
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22.1.1 Connecting Troubleshooting Checklist (serial port – MJ1 Programming) 
1. Controller must be powered up. 
2. Ensure that the correct COM port is selected in Cscape. Tools → Applications Settings → 

Communications . 
3. Ensure that a cable with proper pinout is being used between PC and controller port MJ1. 
4. Check that a Loaded Protocol or ladder is not actively using MJ1. Taking the controller out of Run 

Mode from the System Menu on the controller will make MJ1 available to Cscape. 
5. Successful communications with USB-to-serial adapters vary. If in doubt, Horner APG offers a USB 

to serial adapter. Part numbers HE-XCK and HE-CPK. 
 
22.1.2 Connecting Troubleshooting Checklist (USB Port - Mini B Programming) 

1. Controller must be powered up. 
2. Ensure that the correct COM port is selected in Cscape. Tools → Applications Settings → 

Communications. 
3. Be sure that the USB cable is connected between the PC and the controller. Check Windows 

Device Manager to ensure that the USB driver is properly installed and to verity the port number.  
 

22.1.3 Connecting Troubleshooting Checklist (ETN port programming)                 
1. Controller must be powered up. 
2. Ensure that the correct IP address is given in the Ethernet field and correct Mode is selected, in 

Cscape: Tools → Application Settings → Communications  . 
3. Ensure that an Ethernet connection has been established by pinging the controller from the 

Windows DOS prompt.   
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22.2 Local Controller and Local I/O  
The System Menu provides the following status indications that are useful for troubleshooting and system 
maintenance. 

- Self-test results, diagnostics 
- RUN and OK status 
- Network status and usage 
- Average logic scan rate 
- Application memory usage 
- Loaded firmware versions 
- Loaded protocols 
- Removable Media access 

 
To view the System Menu, press the System key.  
 
22.2.1 Local I/O Troubleshooting Checklist   

1. Verify the controller is in RUN mode. 
2. Check diagnostics to ensure controller passed self-tests. 

Press View Diags in the System Menu or in Cscape, click Controller → Diagnostics 
3. Check data sheets to ensure proper wiring. 
4. Ensure that hardware jumpers and software configuration for I/O match. 
5. Check data sheets for voltage and current limits. 
6. Take ladder out of the picture. From Cscape set controller to “Do I/O” mode. In this mode inputs 

can be monitored and outputs set from a data watch window in Cscape without interference from 
the ladder program. Some I/O problems are only a result of a mistake in the ladder program. 

 
 
 
 

  

WARNING: Setting outputs ON in Do I/O mode can result in injury or cause machinery to engage 
in an unsafe manner depending on the application and the environment.  
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22.3 CsCAN Network  
 
For complete information on setting up a CsCAN network, refer to CAN Networks manual (MAN0799) by 
visiting the Horner websites for the address to obtain documentation and updates. Network status, node 
ID, errors, and baud rate in the controller System Menu are all in reference to the CsCAN network. These 
indications can provide performance feedback on the CsCAN network and can also be used to aid in 
troubleshooting. 
 
22.3.1 CsCAN Network Troubleshooting Checklist   

1. Use the proper Belden wire type or equivalent for the network as specified in MAN0799. 
2. The XL15+ OCS does not provide 24VDC to the network. An external voltage source must be 

used for other devices such as SmartStix I/O.   
3. Check voltage at both ends of the network to ensure that voltage meets specifications of 

attached devices. 
4. Proper termination is required. Use 121Ω (or 120Ω) resistors at each end of the network. The 

resistors should be placed across the CAN_HI and CAN_LO terminals. 
5. Measure the resistance between CAN_HI and CAN_LO. If the network is properly wired and 

terminated, there should be around 60Ω. 
6. Check for duplicate node ID’s. 
7. Keep proper wires together. One twisted pair is for V+ and V- and the other twisted pair is used 

for CAN_HI and CAN_LO. 
8. Make sure the baud rate is the same for all controllers on the network. 
9. Assure shields are connected at one end of each segment -- they are not continuous through 

the network.   
10. Do not exceed the maximum length determined by the baud rate and cable type. 
11. Total drop length for each drop should not exceed 6m (20’). A drop may include more than one 

node. The drop length adds to the overall network length. 
12. Network should be wired in "straight line" fashion, not in a "star" pattern. 
13. In applications requiring multiple power supplies, make sure the V- of all supplies is connected 

and to earth ground at one place only. 
14. In some electrically noisy environments it may be necessary to add repeaters to the network. 

Repeaters can be used to add additional nodes and/or distance to the network and protect the 
signal against noisy environments.  
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22.4 Removable Media - Basic Troubleshooting 

 

Table 22.2 – Removable Media TroubleshootingError! Bookmark not defined. 

Description Action 

XL15+ OCS does not read media card. The media card should be formatted with the XL15+ OCS. 

XL15+ OCS will not download project 
file. 

Make sure the project file is saved as a .pgm file and not a 
.csp file. In addition, to file must be .pgm, the file's I/O 
configuration must match the XL15+ configuration for it to 
download. 

 
 

22.5 Technical Support Contacts 
 
For manual updates and assistance, contact Technical Support at the following locations: 
 
North America:   
Tel: (317) 916-4274 
Fax: (317) 639-4279 
Website: https://hornerautomation.com  
Email: techsppt@heapg.com 
 
Europe:  
Tel: (+) 353-21-4321-266 
Fax: (+353)-21-4321826 
Website: https://www.hornerautomation.eu 
Email: technical.support@horner-apg.com 
 
  

https://hornerautomation.com/
mailto:techsppt@heapg.com
https://www.hornerautomation.eu/
mailto:technical.support@horner-apg.com
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CHANGE LOG 
 

 

  

Change Log 

Date Rev # Description of Revision Location in Doc 

4/22/2020 7 - Updated Firmware Update Steps per new Firmware 
Update Manual  (Mantis 2209) 
  
-Added Revised Audio Chapter (Mantis 2588) 
 
-Rearranged Chapter Order (Mantis 3029) 
 
-Updated Model 6 and RTC/TC Formula  
(Mantis 1528) 

Firmware Updates 
 
 
Audio Chapter 
 
Throughout 
 
Cscape Config/Analog 
In/Table 7.2 

8/13/2021 8 #4845 – Updated WebMI Register 
#4802 – 4802 – WebMI – Max # of Connections 
#6482 – Updated Install Procedure 
Updated Firmware Updates 

%SR Tables 
Ethernet Overview 
Installation Procedure 
Firmware Update 

10/21/21 8.1 #6565 – Changed name to XL15+ Throughout 

3/14/2022. 8.2 #6429 – Updated OCS I/O Register Table OCS I/O Register Table 
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Alarm Viewer, 134 
Alarms, 133 
Alpha-Numeric Keypad, 128 
Analog Input Configuration Dialog, 76 
Analog Input Configuration Screen, 87 
Analog input tranzorb - troubleshooting, 86 
Analog Inputs, 86 
Analog Outputs, 88, 90 
Audio Config Details, 142 
Audio Configuration in Cscape, 141 
Audio Files, 142 
Audio Playback Configuration, 141 
AutoLoad, 169 
AutoLoad Menu, 169 
AutoRun, 171 
AutoRun Menu, 171 
Backup / Restore, 165 
Backup OCS Data, 165 
Battery 

Backup, 179 
Battery backed RAM, 48, 157 
Beeper Acknowledgement, 132 
CAN Comm 

Cscape Programming, 110 
I/O Expansion (Network I/O), 110 
Ladder-Controlled, 110 
Overview, 109 
Ports, 109 

CAN Communications, 109 
CAN1 & CAN2 Connector Locations, 109 
CAN1 / CAN2 Port Pins, 110 
CE, 10 
Clear Backup Data, 167 
Clone Unit, 48, 157 
Clone Unit Confirm Screen, 158 
Clone Unit Files, 159 
Clone Unit Menu after Cloning, 161 
CLONE.DAT, 159 
COM, 34, 36, 39, 52, 106, 110, 181, 182 
COM port, 181 
Communicating via MJ1 Serial Port, 70 
Communication Configuration Dialog, 68 

Communication options, 111, 117 
Communications Port, 66, 67, 182 
Compliance 

CE, 10 
Configuration of a Removable Media, 153 
Configuring Video Properties, 147 
Count, 99, 101 
Csape Program 

Via Serial Port, 108 
Cscape, 14, 36, 37, 53, 63, 64, 69, 80, 83, 84, 85, 

86, 87, 88, 89, 106, 108, 110, 131, 151, 152, 
181, 182, 183 
Alternative Connection Method Screenshot, 67 
Analog In Configuration, 76 
Analog Out Configuration, 79 
Configuration Procedures, 72 
Digital In / HSC Configuration, 74 
Digital Out / PWM Configuration, 75 
Establishing Communications, 64 
Overview, 63 
Status Bar, 63 

CSCAPE CONFIGURATION, 63 
Cscape Connection Wizard Screenshots, 66 
Cscape LAN Config, 116 

Register, 116 
Cscape Target & Local Numbers, 181 
CscapeStatus Bar, 63 
Data Mapping 

Update Type, 124 
Data Mapping Configuration, 124 
datasheet, 4, 85, 88 
Default Gateway, 114 
Device Configuration, 122 
Device List, 122 
Device List and Device Configuration, 122 
Device Manager, 182 
Devices to Connect to XL15+, 13 
Digital Inputs, 85 
Dimensions, 21 
Displaying and entering data, 126 
Downloadable Communication Protocols 

Overview, 117 
Duty Cycle, 104 
Duty Cycle Examples, 104, 105 
Edit-Value Mode, 128 
Electrical Installation, 25 
Ethernet, 52, 64 
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Ethernet Communication, 111 
Ethernet Configuration 

IP Parameters, 116 
Ethernet Module 

Default Gateway, 114 
IP Address, 114 
Net Mask, 114 
Status Register, 114 
Version Register, 115 

Ethernet Module Configuration, 112, 113 
Ethernet Module Protocol Configuration, 116 
Ethernet Module Protocols & Features, 111 
Ethernet Module Protocols and Features, 111 
Ethernet Module Specifications, 112 
Ethernet Status Word Register Format, 114 
Ethernet System Requirements, 111 
Example Jumper Diagram, 81 
Fail - Safe System, 45 
Fail Safe System Overview, 163 
Fail Safe System Settings, 164 
Features, 14 
Filename Special Symbols, 155 
Firmware Updates, 176, 178 
Flow Chart for AutoLoad, 170 
Flow Chart for Automatic Restore, 168 
Force and Switch Coils in Ladder Programming, 

131 
Frequency, 74, 90, 101 
Front Panel and USB Programming Connector, 64 
fusing, 83, 84 
General I/O 

Overview, 80 
GENERAL I/O, 80 
Glossary, High Speed I/O, 89 
Ground Specification, 25 
Grounding 

Locations of Information, 10 
Grounding Definition, 25 
Hardware Configuration Dialog, 112 
High Speed 

Frequency, 90 
High Speed / PWM 

Overview, 89 
High Speed Counting, 89 
HIGH SPEED I/O, 88 
HSC, 74, 88, 89, 90, 93, 96, 99, 101 
HSC Output Functions Register Map, 103 
I/O Cover Removal, 80 
IP Address, 114 
IP Parameters 

Non-Volatile RAM, 116 
LAN1 Configuration Dialog, 71 
LIMITED WARRANTY, 3 
Load Clone, 49, 161 
Load Clone Confirm Screen, 162 
Maintenance, 176 
Make Clone, 157 
Manual Index, 12 
Mechanical installation, 16 
microSD Cards, 150 

Installing / Removing, 150 
microSD System, 150 
Minimum Clearance Requirements for Panel Box 

and Doors, 23 
Modbus Communications, 172 
Modbus Master Mapping, 175 
Modbus Master Overview, 173 
Modbus Slave Overview, 172 
Model / I/O Overview, 82 
Mounting Orientation, 19 
Mounting Requirements, 16 

Panel Door Mounting, 16 
Net Mask, 114 
Network Configuration, 120 
New-Value Mode, 128 
Opening Cscape Help File, 15, 174 
Opening Video Object in Cscape, 145 
Overview 

Modbus, 172 
Overview of the XL15+, 11 
Panel Box 

Clearances, 23 
Grounding, 23 
Noise, 24 
Orientation, 23 
Temperature, 23 

Panel Box Shock and Vibration, 24 
Panel Cut-out, 20 
Panel Design Checklist, 24 
Panel Mounting of an XL15+ Series OCS, 16 
Perimeter Set Studs, 18 
Polled Read, 124 
Polled Read/Write, 124 
Polled Read/Write/Init, 125 
Primary Power Port, 27 
PROGRAMMING EXAMPLES, 3 
Protocol Config, 119 
Pulse, 91, 92 
pulse mode, 91, 92 
pulse stream, 91, 92 
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Pulse Width Modulation, 89, 99 
PWM, 14, 75, 83, 88, 89, 99, 100, 104 

Examples, 104, 105 
Frequency Formula, 101 
Registers, 103 

Quadrature, 74, 90, 93 
References / Useful documents, 15 
register mapping, 80, 83 
Register Match, 94 
registers, 52 
Registers 

%S / %SR, 52 
Definitions, 52 
I/O, 61 
Resource Limits, 62 

Relay Fusing, 84 
Relay Outputs, 84 
Removable Media, 44, 135 

Load / Save Applications, 152 
Log Data, 151 
Overview, 150 
Save Applications XL15+, 152 
View / Capture, 152 

Removable Media Manager, 151 
Removable Media Submenu, 151 
Removable Media XL6, 44 
Removable microSD Memory Card Slot, 150 
Removing the I/O Cover, 80 
Restore OCS Data, 166 
RM - Additional Configuration, 154 
RM - File Names, 155 
RM - Function Blocks in Cscape, 153 
RM - Graphic/Screen Editor, 154 
RM - Program Features, 154 
RM Status Values, 156 
RS-485 Termination, 108 
Safe Fkeys Mode, 38 
Safety Warnings, Guidelines, 9 
Scan List, 123 
Scan List Entry, 124 
Screen Brightness, 138 
Screen Saver, 138 
Seet Serial Ports, 39 
Serial Comm 

Cscape Programming, 108 
Ladder-Controlled, 108 
Overview, 106 
Ports, 106 

SERIAL COMMUNICATIONS, 106 
Set Beeper, 42 

Set Network ID, 32, 69, 70 
Set Screen, 43 
Set Time/Date, 40 
Solid-State Digital Outputs, 83 
sourcing, 83, 85 
stepper, 89, 101, 102 
stop state, 83, 84 
Sub-Menus, 28 
System Menu, 29 

Navigate / Edit, 30 
System Menu Map, 31 
System Registers used with RM, 156 
SYSTEM SETTINGS AND ADJUSTMENTS, 28 
Sytem Menu 

Overview, 28 
Table of Contents, 5 
target ID, 70 
Target ID, 69, 70 
target indicator, 69, 70, 71 
Technical Support, 2, 181, 185 

Contacts, 185 
Testing for Good Ground, 26 
Thermistor Option, 86 
totalize, 90 
Totalize, 90 
Touch (slip) Sensitivity, 132 
Touch Screen Calibration, 51 
Touch Screen Pressure, 139 
Triggered Read, 125 
Triggered Write, 125 
Troubleshooting 

Common problems, 181 
Connecting Checklist, 182 
CsCAN Checklist, 184 
CsCAN Network, 184 
Local Controller / I/O, 183 
Local I/O Checklist, 183 
Removable Media, 185 

troubleshooting / technical support, 181 
Troubleshooting Checklist  (serial port – MJ1) 

Programming, 182 
Troubleshooting Checklist (Ethernet port 

Programming), 182 
Troubleshooting Checklist (USB Port - Mini B) 

Programming, 182 
Types of Registers, 52 
Typical Output Wiring, 83 
Typical Screen Jump Object, 130 
Universal Analog Inputs, 87 
USB, 14, 64, 65, 110, 182 
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User Interface 
Ladder Based Navigation, 131 
Screen Navigation, 130 

User Interface Overview, 126 
Using Removable Media to View and Capture 

Screens, 152 
Video Object 

Playback, 147 
Stream, 147 

View Battery Status, 35 
View Diags, 34 
View I/O Slots, 36 

View Protocols, 37 
View Status, 33 
Visual Overview of Types of Devices that can be 

connected to XL15+OCS, 13 
Visual Overview of XL15+ and Topics, 11 
Where to Find Information, 12 
XL15+ I/O Cover Photograph, 80 
XL15+ I/O Cover Removed (sample I/O board, 81 
XL15+ Manual PREFACE, 2 
XL15+ OCS Dimensions, 21 
XL15+ OCS Mounting Orientation, 19 

 
 
 


